Preface

Basics of Fault Tolerance

Fault-tolerant Solutions in PCS 7

Advantages of fault-tolerant components

Component Replacement and Plant Changes

Failure, Switchover and Return of Fault-tolerant Components

Diagnostics
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**CAUTION**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**
indicates that an unintended result or situation can occur if the relevant information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1. Preface................................................................................................................................................. 7
2. Basics of Fault Tolerance.................................................................................................................... 13
   2.1 Rationale for using fault-tolerant process control systems............................................................. 13
   2.2 System-wide availability analyses.................................................................................................... 15
   2.3 PCS 7 redundancy concept.............................................................................................................. 16
   2.4 Overview of the PCS 7 redundancy features.................................................................................. 19
   2.5 Features for the configuration phase.............................................................................................. 20
   2.6 Features for the commissioning and operation phases.................................................................... 20
   2.7 Features for servicing and system expansions................................................................................ 22
   2.8 Definition of availability.................................................................................................................. 23
   2.9 Definition of the standby modes...................................................................................................... 23
   2.10 Redundancy nodes.......................................................................................................................... 24
3. Fault-tolerant Solutions in PCS 7........................................................................................................ 27
   3.1 Solutions for the I/O....................................................................................................................... 27
       3.1.1 Redundant I/O........................................................................................................................ 28
       3.1.2 Switched I/O.......................................................................................................................... 30
       3.1.3 Components in the distributed I/O......................................................................................... 32
       3.1.3.1 Redundant interface modules in distributed I/O................................................................. 32
       3.1.3.2 Redundant I/O modules..................................................................................................... 33
       3.1.3.3 Redundant actuators and sensors....................................................................................... 34
       3.1.4 Redundant, fault-tolerant terminal bus based on the INTEL TEAM mode................................ 49
       3.1.5 Redundant, fault-tolerant terminal bus based on the Parallel Redundancy Protocol (PRP)........ 50
       3.1.6 Redundant, fault-tolerant terminal bus based on the INTEL TEAM mode.............................. 52
       3.1.7 Redundant PROFIBUS DP.................................................................................................... 62
   3.2 Solutions for automation systems.................................................................................................... 35
       3.2.1 S7-400H hardware components............................................................................................. 36
       3.2.2 How the SIMATIC S7-400H AS operates............................................................................. 39
   3.3 Solutions for communication......................................................................................................... 39
       3.3.1 Network components.............................................................................................................. 41
       3.3.2 Media Redundancy Protocol.................................................................................................. 45
       3.3.3 Solutions for the terminal bus................................................................................................ 46
       3.3.3.1 Connecting PC stations to the terminal bus....................................................................... 46
       3.3.3.2 Fault-tolerant terminal bus................................................................................................. 47
       3.3.3.3 Redundant, fault-tolerant terminal bus............................................................................... 49
       3.3.3.4 Redundant, fault-tolerant terminal bus based on the Parallel Redundancy Protocol (PRP).... 50
       3.3.3.5 Redundant, fault-tolerant terminal bus based on the INTEL TEAM mode.......................... 52
   3.4 Solutions for the plant bus.............................................................................................................. 56
       3.4.1 Connecting PC stations to the plant bus.................................................................................. 56
       3.4.2 Fault-tolerant plant bus.......................................................................................................... 57
       3.4.3 Redundant, fault-tolerant plant bus....................................................................................... 59
   3.5 Solutions for the fieldbus............................................................................................................... 62
       3.5.1 Redundant PROFIBUS DP.................................................................................................... 62
       3.5.2 Fault-tolerant fieldbus based on PROFINET......................................................................... 64
### Table of contents

- 3.3.5.3 Gateway between redundant and non-redundant PROFIBUS DP ................................................................. 65
- 3.3.5.4 Connection of PROFIBUS PA to PROFIBUS DP .................................................................................. 66
- 3.3.5.5 Fault-tolerant PROFIBUS PA ........................................................................................................ 68
- 3.3.5.6 Connecting the FOUNDATION Fieldbus to PROFIBUS DP ...................................................................... 72
- 3.3.5.7 Fault-tolerant FOUNDATION Fieldbus .......................................................................................... 74
- 3.4 Solutions for integrating a PCS 7 plant in a domain ...................................................................................... 77
- 3.5 Solutions for OS servers .......................................................................................................................... 77
- 3.6 Solutions for OS clients ............................................................................................................................ 81
- 3.6.1 Additional OS clients .......................................................................................................................... 81
- 3.6.2 Permanent operability ........................................................................................................................ 81
- 3.7 Solutions for SIMATIC BATCH ................................................................................................................. 82
- 3.8 Solutions for Route Control server ........................................................................................................... 85
- 3.9 Solutions for engineering station ............................................................................................................ 87
- 3.10 Time synchronization ............................................................................................................................. 88

### 4 Advantages of fault-tolerant components .................................................................................................... 89

- 4.1 Creating and expanding a project with pre-configured stations .......................................................................... 89
- 4.2 SIMATIC H Station ........................................................................................................................................ 89
  - 4.2.1 Overview of configuration tasks ........................................................................................................ 89
  - 4.2.2 How to add a SIMATIC H station to your project ............................................................................. 90
  - 4.2.3 How to insert synchronization modules into the H CPU ................................................................... 91
  - 4.2.4 How to configure redundant communication processors .................................................................. 93
  - 4.2.5 How to set the failure reaction of the input/output modules on the CPU ........................................ 95
- 4.3 Communication connections ...................................................................................................................... 96
  - 4.3.1 Overview of configuration tasks ........................................................................................................ 96
  - 4.3.2 Configuring the connection to the terminal bus ................................................................................ 97
  - 4.3.2.1 How to configure the redundant terminal bus on the basis of the Parallel Redundancy Protocol 97
  - 4.3.2.2 How to configure the redundant terminal bus on the basis of the INTEL TEAM mode .......... 97
  - 4.3.2.3 How to connect singular components to the redundant terminal bus on the basis of the Parallel Redundancy Protocol .................................................................................. 100
- 4.3.3 How to configure a fault-tolerant plant bus ........................................................................................ 100
- 4.3.4 How to configure a redundant PROFIBUS DP ...................................................................................... 102
- 4.3.5 How to configure a fault-tolerant fieldbus on the basis of PROFINET .................................................. 105
- 4.3.6 How to configure the redundant PROFIBUS PA .................................................................................. 107
- 4.4 Distributed I/O .......................................................................................................................................... 109
  - 4.4.1 Overview of configuration tasks ........................................................................................................ 109
  - 4.4.2 How to configure the redundant interface for the I/O device ................................................................ 110
  - 4.4.3 How to configure redundant I/O modules ........................................................................................ 112
  - 4.4.4 How to configure the redundancy for HART field devices ............................................................. 116
  - 4.4.5 How to configure the Y Link .............................................................................................................. 119
  - 4.4.6 Configuring DP/PA Link .................................................................................................................... 122
  - 4.4.7 Configuring FF Link ........................................................................................................................ 124
  - 4.4.8 Configuration of redundant signals .................................................................................................. 126
- 4.5 Operator stations ....................................................................................................................................... 127
  - 4.5.1 Overview of configuration tasks ........................................................................................................ 127
  - 4.5.2 How to configure an OS server and its redundant OS partner server ............................................. 127
  - 4.5.3 How to configure a central archive server and its redundant archive partner server .................. 130
Table of contents

4.5.4 How to set the redundancy of the central archive server...........................................133
4.5.5 How to set the project paths of the destination OS and standby OS..........................134
4.5.6 How to configure a redundant connection between an OS and AS.........................135
4.5.7 How to configure redundancy for OS servers on the engineering station..................138
4.5.8 How to set the redundancy connection for OS servers.............................................141
4.5.9 How to assign an S7 program to an OS.....................................................................142
4.5.10 How to configure an OS client................................................................................144
4.5.11 How to configure an OS client for permanent operability......................................145
4.5.12 How to download a SIMATIC PCS 7 project to the target systems...........................148
4.5.13 Evaluating the "@RM_MASTER" Redundancy Variables with Scripts......................149

4.6 SIMATIC BATCH Stations..........................................................................................149
4.6.1 Overview of configuration tasks................................................................................149
4.6.2 How to configure a BATCH server and its redundant BATCH partner server.............150
4.6.3 How to configure a BATCH client.............................................................................152
4.6.4 How to set the redundancy monitoring of BATCH servers......................................153
4.6.5 How to configure the redundancy connection for BATCH servers on the engineering station.154
4.6.6 How to set the redundancy connection for BATCH servers.....................................155
4.6.7 How to download the target systems for SIMATIC BATCH......................................156

4.7 SIMATIC Route Control stations................................................................................157
4.7.1 Overview of configuration tasks................................................................................157
4.7.2 How to configure a Route Control server and its redundant Route Control partner server...157
4.7.3 How to configure a Route Control client...................................................................160
4.7.4 How to configure a redundant connection between a Route Control server and AS.....162
4.7.5 How to set the redundancy connection for Route Control servers.............................165
4.7.6 How to set the redundancy of the Route Control servers.........................................166
4.7.7 How to download the target systems for Route Control............................................166

5 Component Replacement and Plant Changes................................................................167
5.1 Failure and replacement of bus components...............................................................167
5.1.1 Replacement of SIMATIC components in runtime....................................................167
5.1.2 Replacement of bus components in runtime.............................................................168
5.1.3 Replacement of operator stations in runtime..............................................................169
5.1.4 Replacement of BATCH stations in runtime..............................................................170
5.1.5 Replacement of Route Control stations in runtime....................................................171
5.2 Plant changes in runtime.........................................................................................172

6 Failure, Switchover and Return of Fault-tolerant Components....................................175
6.1 I/O............................................................................................................................175
6.1.1 Failure of redundant interface modules....................................................................175
6.1.2 Failure of redundant I/O modules...........................................................................175
6.2 Automation system.....................................................................................................177
6.2.1 Failure of the master CPU......................................................................................177
6.2.2 Failure of a fiber-optic cable....................................................................................178
6.3 Communication.........................................................................................................180
6.3.1 Failure of redundant bus components.....................................................................180
6.4 OS server..................................................................................................................181
6.4.1 Failure, failover and restarting of redundant OS servers.........................................181
6.5 BATCH Server..........................................................................................................186
6.5.1 Reaction of BATCH servers to failure...................................................................186
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.6</td>
<td>Route Control server</td>
<td>187</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Reaction of Route Control servers to failure</td>
<td>187</td>
</tr>
<tr>
<td>6.7</td>
<td>OS clients</td>
<td>188</td>
</tr>
<tr>
<td>6.7.1</td>
<td>Failover reactions of OS clients with permanent operability</td>
<td>188</td>
</tr>
<tr>
<td>6.8</td>
<td>BATCH clients</td>
<td>190</td>
</tr>
<tr>
<td>6.8.1</td>
<td>Failover reactions of BATCH clients</td>
<td>190</td>
</tr>
<tr>
<td>6.9</td>
<td>Route Control clients</td>
<td>190</td>
</tr>
<tr>
<td>6.9.1</td>
<td>Failover reaction of Route Control clients</td>
<td>190</td>
</tr>
<tr>
<td>6.10</td>
<td>Guidelines for updating a redundant OS in runtime</td>
<td>191</td>
</tr>
<tr>
<td>6.10.1</td>
<td>Introduction</td>
<td>191</td>
</tr>
<tr>
<td>6.10.2</td>
<td>Overview of the required tasks</td>
<td>193</td>
</tr>
<tr>
<td>6.10.3</td>
<td>Phase 1: Updating Server_2</td>
<td>196</td>
</tr>
<tr>
<td>6.10.4</td>
<td>Phase 2: Updating OS clients interconnected with Server_2</td>
<td>199</td>
</tr>
<tr>
<td>6.10.5</td>
<td>Phase 3: Downloading the connections, gateways and changes to the AS</td>
<td>201</td>
</tr>
<tr>
<td>6.10.6</td>
<td>Phase 4: Updating the OS clients interconnected with Server_1</td>
<td>202</td>
</tr>
<tr>
<td>6.10.7</td>
<td>Phase 5: Updating Server_2</td>
<td>204</td>
</tr>
<tr>
<td>6.11</td>
<td>Guide to updating a redundant BATCH server in runtime</td>
<td>207</td>
</tr>
<tr>
<td>6.11.1</td>
<td>Software update (migration)</td>
<td>207</td>
</tr>
<tr>
<td>6.12</td>
<td>Guide to updating a redundant Route Control server in runtime</td>
<td>207</td>
</tr>
<tr>
<td>6.12.1</td>
<td>Updating a redundant Route Control server in runtime</td>
<td>207</td>
</tr>
<tr>
<td>7</td>
<td>Diagnostics</td>
<td>209</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>211</td>
</tr>
</tbody>
</table>
Preface

Purpose of this documentation

This documentation informs you about the following aspects of configuring fault-tolerant systems with the SIMATIC PCS 7 Process Control System:

- The basic solution concepts
- The functional mechanisms
- The most important configurations

It presents the availability solutions on all automation levels (management, process, field).

You will find references to other product manuals containing specific information for working with individual components.

Options for accessing PCS 7 documentation

Note

PCS 7 Readme

The information given in the PCS 7 Readme on the Internet takes precedence over all the PCS 7 manuals. Please read this PCS 7 Readme carefully; it contains important information and amendments on PCS 7.

- The PCS 7 Readme on the Process Control System; SIMATIC PCS 7 DVD contains important information regarding PCS 7 and takes precedence over the PCS 7 documentation supplied.
- After installation of PCS 7, you can find documents such as Process Control System PCS 7; PCS 7 Readme and What's New in PCS 7? via the submenu SIMATIC > Product Information > <Language>.

As of PCS 7 V8.0, you receive basic PCS 7 system documentation with the Process Control System; SIMATIC PCS 7 DVD.

The PCS 7 Internet site http:\\www.siemens.com/pcs7-documentation (http:\\www.siemens.com/pcs7-documentation) provides convenient access to the complete PCS 7 documentation. You can find the following for the latest PCS 7 versions:
In the section "Hardware manuals for SIMATIC PCS 7 ..."
- The manuals for components approved for a PCS 7 version

In the section "Software manuals for SIMATIC PCS 7 ..."
- The complete system documentation
- The separate setup program for PCS 7 documentation and the PCS 7 help system for download. After the installation of the setup program, you will find the documentation at the following locations on the Engineering Station:
  - As online help (CHM file) for the SIMATIC Manager application
  - As a PDF file in the Windows Start menu with the SIMATIC documentation
- The complete documentation for PCS 7 as a Manual Collection

Validity of the documentation

This documentation is valid for the software package Process Control System; SIMATIC PCS 7, V8.0 or higher.

Required basic knowledge

General knowledge in the area of automation engineering and basic knowledge of PCS 7 is required to understand this documentation. It is also assumed that the reader knows how to use computers or other equipment similar to PCs (such as programming devices) with the Windows operating system.

The configuration manuals and the Getting Started documentation for PCS 7 will provide you with basic information regarding the use of PCS 7.

Position in the information landscape

The following documentation provides more information about fault-tolerant process control systems and the handling of the individual components. This documentation is part of the PCS 7 software.

<table>
<thead>
<tr>
<th>Manual</th>
<th>Content</th>
</tr>
</thead>
</table>
| Getting Started Process Control System PCS 7; Part 1 - Getting Started | • Creating projects  
• Working with the CFC Editor  
• Working with the Import/Export Wizard  
• Working with the SFC Editor  
• Compiling, downloading and testing  
• Working with the operator station |
| Configuration manual Process Control System PCS 7; Engineering System | • Basics of PCS 7  
• Creating projects  
• Configuring hardware  
• Configuring networks |
<table>
<thead>
<tr>
<th>Manual</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration manual Process Control System PCS 7; Operator Station</td>
<td>- Configuring SIMATIC connections</td>
</tr>
<tr>
<td></td>
<td>- Interconnecting faceplates</td>
</tr>
<tr>
<td></td>
<td>- Configuring operator stations</td>
</tr>
<tr>
<td></td>
<td>- Compiling the OS</td>
</tr>
<tr>
<td></td>
<td>- Installation guidelines</td>
</tr>
<tr>
<td>Process Control System PCS 7; Maintenance Station function manual</td>
<td>- Activation of the maintenance functions</td>
</tr>
<tr>
<td></td>
<td>- Configuration of redundancy</td>
</tr>
<tr>
<td></td>
<td>- Adding the OPC server</td>
</tr>
<tr>
<td>Configuration manual WinCC</td>
<td>- Getting Started</td>
</tr>
<tr>
<td></td>
<td>- Operating principle of WinCC redundancy</td>
</tr>
<tr>
<td></td>
<td>- User archives</td>
</tr>
<tr>
<td></td>
<td>- Creating the &quot;Project_Redundancy_Server&quot; example project</td>
</tr>
<tr>
<td></td>
<td>- Description of the WinCC projects</td>
</tr>
<tr>
<td></td>
<td>- Server project</td>
</tr>
<tr>
<td>Manual WinCC Hardware Options, Part 3 Redundancy</td>
<td>- Structure of a redundant WinCC system</td>
</tr>
<tr>
<td></td>
<td>- Operating principle of WinCC redundancy</td>
</tr>
<tr>
<td></td>
<td>- Configuring the OS server pair</td>
</tr>
<tr>
<td></td>
<td>- Guide for setting up a redundant system</td>
</tr>
<tr>
<td></td>
<td>- Entering the servers in Windows</td>
</tr>
<tr>
<td>Manual Process Control System PCS 7; SIMATIC BATCH</td>
<td>- Structure of a redundant BATCH system</td>
</tr>
<tr>
<td></td>
<td>- Configuring the BATCH server pair</td>
</tr>
<tr>
<td></td>
<td>- Installation guidelines</td>
</tr>
<tr>
<td>Manual Process Control System PCS 7; SIMATIC Route Control</td>
<td>- Setting up a redundant Route Control system</td>
</tr>
<tr>
<td></td>
<td>- Configuring the Route Control server pair</td>
</tr>
<tr>
<td></td>
<td>- Installation guidelines</td>
</tr>
<tr>
<td>Manuals for PCS 7 Software Update</td>
<td>- Updating a PCS 7 Project with and without use of new functions</td>
</tr>
<tr>
<td></td>
<td>- Upgrading a redundant system during online operation</td>
</tr>
<tr>
<td>Manual Automation System S7-400H, Fault-tolerant Systems</td>
<td>- Redundant SIMATIC automation systems</td>
</tr>
<tr>
<td></td>
<td>- Increasing availability</td>
</tr>
<tr>
<td></td>
<td>- System and operating modes of the S7-400H</td>
</tr>
<tr>
<td></td>
<td>- Linking and updating</td>
</tr>
<tr>
<td>Manual Modifying the System in Runtime via CiR</td>
<td>- Modifying standard systems in runtime</td>
</tr>
<tr>
<td>Manual Distributed I/O Device ET 200M</td>
<td>- Configuration options</td>
</tr>
<tr>
<td></td>
<td>- Mounting</td>
</tr>
<tr>
<td></td>
<td>- Wiring</td>
</tr>
<tr>
<td></td>
<td>- Commissioning and diagnostics</td>
</tr>
<tr>
<td>Manual Distributed I/O Device ET 200iSP</td>
<td>- Configuration options</td>
</tr>
<tr>
<td></td>
<td>- Mounting</td>
</tr>
<tr>
<td></td>
<td>- Wiring</td>
</tr>
<tr>
<td></td>
<td>- Commissioning and diagnostics</td>
</tr>
</tbody>
</table>
### Manual

<table>
<thead>
<tr>
<th>Manual</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-200</td>
<td>Configuration options, Mounting, Wiring, Commissioning and diagnostics</td>
</tr>
<tr>
<td>Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400</td>
<td>Configuration options, Mounting, Wiring, Commissioning and diagnostics</td>
</tr>
<tr>
<td>Manual SIMATIC NET; Manual Industrial Twisted Pair and Fiber-Optic Networks</td>
<td>Networks with Industrial Ethernet and Fast Ethernet, Network configuration, Passive components for electrical and optical networks, Active components and topologies</td>
</tr>
<tr>
<td>Manual SIMATIC Diagnostic Repeater for PROFIBUS-DP</td>
<td>Configuration options, Mounting, Wiring, Commissioning and diagnostics</td>
</tr>
<tr>
<td>Manual SIMATIC DP/PA Coupler, DP/PA Link and Y Link</td>
<td>Fundamentals of PROFIBUS PA, DP/PA Coupler, DP/PA Link, DP/PA Link in redundant operation with the S7-400H</td>
</tr>
<tr>
<td>Documentation PCS 7 - Released Modules</td>
<td>Components released for redundancy in PCS 7</td>
</tr>
</tbody>
</table>

### Guide

This manual is organized into the following topics:

- Basics of fault-tolerance in PCS 7
- Description of fault-tolerant solutions in PCS 7
- Description of configurations for various redundant components in PCS 7
- Failure scenarios and diagnostic options
- Options for quantitative analysis of fault-tolerant process control systems
- Glossary with important terms for understanding this documentation
- Index of important keywords

### Conventions

In this documentation, the names of elements in the software interface are specified in the language of this documentation. If you have installed a multi-language package for the operating system, some of the designations will be displayed in the base language of the operating system after a language switch and will, therefore, differ from the designations used in the documentation.
Changes compared to the previous version

Below, you will find an overview of the most important changes in the documentation compared to the previous version:

- Using the redundant, fault-tolerant terminal bus
  For additional information, refer to the section "Solutions for the terminal bus (Page 46)."

- Using the Process Historian and Information Server for central archiving
  For additional information on this topic, refer to the SIMATIC HMI; SIMATIC Process Historian documentation.

- Using a fault-tolerant fieldbus based on PROFINET
  For additional information, refer to the section "Fault-tolerant fieldbus based on PROFINET (Page 64)."

- Using the redundant FOUNDATION Fieldbus
  You can find information about this in the "Fault-tolerant FOUNDATION Fieldbus (Page 74)" section
2.1 Rationale for using fault-tolerant process control systems

Advantages of fault-tolerant components

Process control systems are responsible for controlling, monitoring and documenting production and manufacturing processes. Due to the increasing degree of automation and the demand for improved efficiency, the availability of these systems is playing an increasingly important role.

Failure of the control system or any of its components can lead to costly downtime in production and manufacturing. The expense involved in restarting a continuous process also has to be taken into consideration along with the actual production losses resulting from a failure. In addition, the loss of an entire batch may occur due to lost quality data. If the process is intended to operate without supervisory or service personnel, a process control system must be configured fault-tolerant for all of the components.

You can minimize the risk of a production failure and other detrimental effects by using fault-tolerant components in a process control system. A redundant design ensures increased availability of a control system. This means that all components involved in the process have a backup in continuous operation that simultaneously participates in the control tasks. When a fault occurs or one of the control system components fails, the correctly operating redundant component takes over the continuing control task. The ultimate goal is to increase the fault tolerance and fail-safe performance in process control systems.

The following applies to you as the plant operator:

The higher the cost of a production stoppage, the more you need a fault-tolerant system. The higher initial investment usually associated with a fault-tolerant system is soon offset by the savings resulting from decreased production downtimes.

Fault-tolerant PCS 7 process control system

The following components of the PCS 7 process control system allow you to implement fault-tolerance at all automation levels in the form and to the degree you require:

- Operator stations, maintenance station, central archive server, BATCH stations, Route Control stations (management level)
- Bus system
- Automation systems (process level)
- Distributed I/O (field level)

The following figure shows an example of a fault-tolerant process control system with PCS 7 components.
2.1 Rationale for using fault-tolerant process control systems

Legend for the above illustration:

**Note**
The following short designations are commonly used in this documentation.
### 2.2 System-wide availability analyses

#### Introduction

Availability must be analyzed globally for the system as a whole. Based on the degree of availability needed, each system level, each system and each component within a level should be evaluated. It is important to know the importance of each of these for the availability requirements as well as the ways and means that the required availability will be achieved.

#### Avoiding repair time

In many industrial processes, it is not enough to simply correct the failure of a component and then continue the process. The repair has to be made without interruption to the continuing production process. The repair time can be considerably reduced by keeping replacement parts in stock on site. The use of fault-tolerant components in the process control system enables you to correct the cause of the system or component failure in runtime. The function of the component is retained if no fault occurs in the remaining active (redundant) components during the time a failed counterpart component is being repaired. That is, the plant continues operation without disruption.

---

**Table: Short designation and Meaning**

<table>
<thead>
<tr>
<th>Short designation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering Station</td>
<td>Engineering station, PC</td>
</tr>
<tr>
<td>OS server</td>
<td>Operator station, PC project data station in the project form &quot;WinCC Server&quot;</td>
</tr>
<tr>
<td>OS client</td>
<td>Operator station, PC visualization station in the project form &quot;WinCC Client&quot;</td>
</tr>
<tr>
<td>BATCH server</td>
<td>BATCH station, PC recipe and batch data station</td>
</tr>
<tr>
<td>BATCH client</td>
<td>BATCH station, PC recipe creation and batch visualization station</td>
</tr>
<tr>
<td>Route Control server</td>
<td>Route Control station, PC Route Control data station</td>
</tr>
<tr>
<td>Route Control client</td>
<td>Route Control station, PC Route Control visualization station</td>
</tr>
<tr>
<td>Plant bus, terminal bus</td>
<td>Bus systems for communication over Industrial Ethernet (electrical or optical)</td>
</tr>
<tr>
<td>S7-400H</td>
<td>SIMATIC S7 fault-tolerant automation system, or H system for short</td>
</tr>
<tr>
<td>PS</td>
<td>Power supply</td>
</tr>
<tr>
<td>CPU</td>
<td>Central processing unit</td>
</tr>
<tr>
<td>CP</td>
<td>Communications processor</td>
</tr>
<tr>
<td>IM</td>
<td>Interface module</td>
</tr>
<tr>
<td>SM</td>
<td>Signal module / I/O module in analog or digital form</td>
</tr>
<tr>
<td>ET 200M</td>
<td>Distributed I/O device</td>
</tr>
<tr>
<td>Fieldbus</td>
<td>Fieldbus for distributed I/O</td>
</tr>
<tr>
<td>Sensor</td>
<td>Transmitters, sensors</td>
</tr>
</tbody>
</table>
Avoiding impermissible signal edge transitions

A reserve system with connected backup I/O may not cause an impermissible signal edge transition when a change occurs in the operating state (power on or off) or operating mode (master or slave).

2.3 PCS 7 redundancy concept

Advantages of the PCS 7 redundancy concept

Fault-tolerant process control systems can be realized with SIMATIC PCS 7 at minimal cost in all phases of a system lifecycle:

- Configuration
- Commissioning/operation
- Servicing
- Expansion

PCS 7 offers the following essential advantages:

- It provides you with system-wide scalable solutions based on the PCS 7 modular design. Advantage: The availability can be matched to your requirements. Your process control system can be upgraded with the SIMATIC PCS 7 components that are actually needed.

- Hardware upgrades for fault tolerance do not depend on the software configuration. Advantage: If the user program has been configured with PCS 7, it does not have to be adapted following a hardware upgrade. You only need to download the new hardware configuration into the CPU.

- Fault-tolerant automation system S7-400H with CPU (types: see documentation Process Control System PCS 7; Released Modules), whose module racks can be set up in separate locations. Advantage: Protection for the spatially separated CPUs resulting in increased availability in case of fire or explosion, for example.

- The use of redundant components in the process control system means isolated errors are tolerated. Advantage: The entire system does not fail when a single component in the process control system fails. The redundant component takes over its tasks therefore allowing the process to continue.

- Every failure of a redundant component is indicated on the OS clients in the form of a process control message. Advantage: You immediately receive crucial information about the status of your redundant component. Specific components that have failed can be quickly replaced to restore the redundancy.

- Software updates on redundant OS servers can be performed without loss of process operability or loss of data.
Overview of the PCS 7 redundancy concept

PCS 7 offers you a redundancy concept that reaches all levels of process automation.

Note
The numbering of the components in the illustration relates to the descriptions provided below.
### Illustration of fault tolerance using redundancy nodes

Redundancy nodes can be used to provide an overview of the fault tolerance of a process control system. As an introductory example, the following illustration presents the process control system shown above as a block diagram with the individual redundancy nodes.
2.4 Overview of the PCS 7 redundancy features

Introduction

The easiest way to increase availability is to keep replacement parts in stock on site and to have fast service at your disposal to replace defective components.

In this documentation, we provide you with PCS 7 software and hardware solutions that go well beyond fast service and replacement part warehousing. It focuses on "automated fault-tolerant process control systems".

System-wide, scalable solutions in PCS 7 available

Plants are divided into the following layers in PCS 7:

- Field layer
- Process layer
- Management level

The components of PCS 7 enable you to implement fault-tolerant solutions at all automation system levels in the form and to the degree you desire. In PCS 7, individual components (such as signal modules), complex systems (such as operator control and monitoring systems) and complete plants can be configured in such a way that one sub-component can automatically take on the function of another sub-component if it fails.

You decide which components in the plant require increased availability.

The following table lists the fault-tolerant components for the three layers.

<table>
<thead>
<tr>
<th>Process layer</th>
<th>Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management level</td>
<td>OS clients, maintenance clients, BATCH clients, Route Control clients OS servers, maintenance servers, central archive servers, BATCH servers, Route Control servers Terminal bus (Industrial Ethernet)</td>
</tr>
<tr>
<td>Field layer</td>
<td>Fieldbus PROFIBUS DP, PROFIBUS PA, Distributed I/O device ET 200M, ET 200iSP S7-300 distributed I/O modules PROFIBUS DP, PROFIBUS PA and HART devices</td>
</tr>
</tbody>
</table>
Basics of increased availability

Increased availability in PCS 7 is based on the following principles:

- Duplication of a component
  Example:
  Use of duplicate signal modules

- Duplication of a component and a software component that performs an automatic failover from active and passive components when a fault occurs.
  Example of redundant components:
  A signal is acquired with two signal modules and the redundancy software. The failure of one module remains non-critical for operation of the plant.

- Technical solutions for configuring components that prevent the failure of a sub-component.
  Example:
  Configuration of a network in a ring structure with a component as redundancy manager. If part of the ring is disrupted (by a defective cable, for example), the operation of the network is maintained.

2.5 Features for the configuration phase

Features for the configuration phase

In the configuration phase, PCS 7 provides you with support with the following features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault prevention through simplified configuration of the various components</td>
<td>You do not need additional training to configure the redundant components. Configuration can be performed in a similar way as for standard systems.</td>
</tr>
<tr>
<td>Simple integration of redundant I/O</td>
<td>No special knowledge is needed about redundant I/O modules.</td>
</tr>
<tr>
<td>The communication links between the system components are configured transparent to the application.</td>
<td>With the HW Config or NetPro graphical user interface, the configuration of the communication links is performed transparent to the application.</td>
</tr>
</tbody>
</table>

2.6 Features for the commissioning and operation phases

Features for the commissioning and operation phases

The following table lists the features PCS 7 offers for the commissioning and operation phases.

The redundant components allows the continuation of the process of a component fails. Operator control and monitoring of the process remains unaffected. In addition, the archiving
of process data is not interrupted during the commissioning phase. Defective components can be replaced in runtime.

### NOTICE

If a component fails in a redundant control system, the fault tolerance is lost. This means that another failure could potentially result in the failure of the entire system, although such occurrences are rare (e.g., if both bus lines are severed in the case of a redundant bus system). You can find additional information on this in the section "Redundancy nodes (Page 24)".

<table>
<thead>
<tr>
<th>Feature</th>
<th>Meaning</th>
<th>Possible error / possible reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toleration of an isolated error</td>
<td>An isolated error is tolerated since the fault-tolerant redundant component continues the process.</td>
<td>Fault or failure of servers and clients Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hard disk failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Operating system failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Connection failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hard disk capacity for archiving exhausted</td>
</tr>
<tr>
<td>Error or failure of the automation system</td>
<td></td>
<td>Error or failure of the communication Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Failure of power supply</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Failure of a CPU</td>
</tr>
<tr>
<td>Error or failure of central or distributed I/O modules</td>
<td>Error or failure of central or distributed I/O modules Example:</td>
<td>Error or failure of central or distributed I/O modules Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Component failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Short circuit</td>
</tr>
<tr>
<td>Error in distributed I/O devices</td>
<td>Fault in distributed I/O devices Example:</td>
<td>Failure of the power supply (PS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Failure of an interface (IM)</td>
</tr>
<tr>
<td>Ensure uninterrupted operation through redundant components.</td>
<td>The system can continue process control without operator intervention.</td>
<td>Failure of an individual component in a fault-tolerant process control system. Upgrade and expansion of the system.</td>
</tr>
<tr>
<td>Ability of process to continue to be controlled and monitored even when a server switchover occurs.</td>
<td>If an OS server fails, the system switches over to the configured redundant partner server. All OS clients are automatically switched over to the now activate OS partner server. The process can continue to be controlled and monitored through the OS clients even during the failover period.</td>
<td>Failure of the OS server Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Operating system failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Hard disk defect</td>
</tr>
<tr>
<td>Display of the master / standby identification of the OS server.</td>
<td>Information about the master / standby identification of the OS server can be requested and visualized using the OS clients.</td>
<td>The master / standby identification changes if the active OS server (master) fails.</td>
</tr>
</tbody>
</table>

Basics of Fault Tolerance

2.6 Features for the commissioning and operation phases
### 2.7 Features for servicing and system expansions

#### Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Meaning</th>
<th>Possible error / possible reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>No loss of data; gap-free data archiving.</td>
<td>The project data are saved according to the interval configured.</td>
<td>Failure of the OS server, for example, due to a hard disk defect.</td>
</tr>
<tr>
<td>Permanent operability of the control process by configuring a preferred server for each OS client.</td>
<td>The failure of some OS clients can be tolerated if the remaining clients continue to be connected to the process.</td>
<td>One or more client operator stations fail, for example, due to a hardware or software error. Duration of the failover of the OS clients to the redundant OS server</td>
</tr>
<tr>
<td>Replacement of faulty components and reconnection to the system in runtime.</td>
<td>The failed components can be replaced without influencing the ongoing process and subsequently reconnected. A redundancy update is then performed.</td>
<td>OS client failure: e.g., operating system OS server failure: e.g., network adapter Plant bus failure: e.g., wire break Central rack failure: e.g., PS, CPU, synchronization line, CP, SM Fieldbus failure: e.g., defective PROFIBUS bus connector Failure of the distributed I/O device: e.g., PS, IM, SM</td>
</tr>
<tr>
<td>Update of faulty component with current system status after being reintegrated into the system.</td>
<td>Redundancy synchronization is performed for all fault-tolerant components, for example, a CPU or a server after return to operation.</td>
<td>Switching on a redundant component after a redundancy fault. Example: Startup of the module after a CPU is replaced with subsequent data synchronization on the CPU conducting the process.</td>
</tr>
<tr>
<td>System upgrades and expansions in runtime</td>
<td>Redundantly designed components can be upgraded, expanded or replaced in runtime.</td>
<td>Copying BIOS versions to redundant PC stations Software updates for redundant PC stations without utilization of new functions</td>
</tr>
<tr>
<td>Displays and documentation</td>
<td>Documentation of availability, for example, testing based on the mean time between failure (MTBF) residual time with optional printout.</td>
<td>Displays and documentation of a potential component failure in advance.</td>
</tr>
</tbody>
</table>

#### Features for servicing and system expansions

PCS 7 offers the following features for servicing and system expansions:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset management with the maintenance station</td>
<td>The maintenance station provides comprehensive information for servicing and diagnostics of PCS 7 plants.</td>
</tr>
<tr>
<td>Integrated diagnostics of components (for example, LEDs) for fast, local error detection.</td>
<td>Diagnostics of components without an additional programming device (PG).</td>
</tr>
<tr>
<td>Faster service from SIEMENS Customer Support.</td>
<td>The service is on site within 2 to 48 hours to maintain the availability guarantee.</td>
</tr>
<tr>
<td>Repairs and component expansions (upgrades, conversions and updates) in runtime.</td>
<td>Repair and component expansions can be made in a fault-tolerant system. System components are installed redundantly so that repairs and expansions can be made in runtime.</td>
</tr>
</tbody>
</table>
2.8 Definition of availability

Definitions

Availability is usually defined as follows:

Quotient of MTBF and (MTBF + MTTR)
or in short form
actual operating condition / nominal operating condition.

Whereby:

- MTBF = mean time between two successive error events, repair time excluded
- MTTR = mean time to repair

Increasing the basic availability

Based on this definition, the basic availability of a standard component or a standard system can be increased by the following:

- Reduction of error frequency
- Decreasing the period necessary for repairs
  A variety of measures can reduce the repair time:
  - Proximity to customer service
  - Replacement parts warehousing
  - Repairs in runtime or repairs without downtime

With "repairs during ongoing operation", no repair time is needed in the system to correct unscheduled operation disruptions.

2.9 Definition of the standby modes

Introduction

The availability of a system can be increased by additional components in the system (standby components). The operating mode of these components distinguishes them from the components that are active in process mode.
Standby operating mode

<table>
<thead>
<tr>
<th>Operating mode</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hot standby</td>
<td>Hot standby means the parallel redundant processing of signals in redundant components. This allows a bumpless failover of the entire system to the standby components.</td>
</tr>
<tr>
<td>Warm standby</td>
<td>Warm standby means the fast continuation of the aborted function by standby components at a program continuation point.</td>
</tr>
<tr>
<td>Cold standby</td>
<td>Cold standby means that there is a component of the system available that can be activated if a fault occurs. Following a restart, the newly activated component takes over the function of the previously failed component.</td>
</tr>
</tbody>
</table>

2.10 Redundancy nodes

Functionality

Redundancy nodes provided protection from failure of systems with redundant components. A redundancy node is independent when the failure of one component within the node does not affect the reliability in other nodes or in the entire system.

The availability of a complete system is illustrated in block diagrams. In a redundant system, a component in the redundancy node can fail without affecting the operation of the complete system. In the chain of redundancy nodes, the weakest link determines the availability of the entire system.

The block diagrams below present examples to illustrated this point.

Redundancy nodes without fault

The following is a block diagram showing individual redundancy nodes operating without a fault.
Availability of a redundancy node despite faults

If a component in a redundancy node fails, the overall system continues to operate.

Total failure of a redundancy node

The following figure shows a complete system that has ceased to operate due to a failure of the "Field bus (PROFIBUS DP)" redundancy node.
3.1 Solutions for the I/O

Introduction

In this section you will learn about the I/O systems and components that contribute to increasing the availability of your system. This means using the distributed I/O in PCS 7.

Distributed I/O

Distributed I/O refers to modules (input/output modules and function modules) that are used in a modular, distributed I/O device such as the ET 200M or ET 200iSP.

Distributed I/O devices are often spatially separated from the central rack and located in direct proximity to the field devices themselves. This minimizes the requirements for wiring and ensuring the electromagnetic compatibility. Communication connections between the CPU of the automation system and the distributed I/O can be established with the following network types:

- PROFIBUS DP
- PROFINET

In addition to the I/O devices, distributed I/O includes field devices such as actuators, weighing systems, motor protection control equipment and all other field devices that can be integrated in PCS 7 via the bus system.

HART devices are connected and addressed via the corresponding modules in the (ET 200M / ET 200iSP) distributed I/O. HART devices are actuators and sensors that can be configured per HART protocol (HART: Highway Addressable Remote Transducer).

Distributed I/O also includes bus converters such as DP/PA-Link and Y-Link. The DP/PA-Link enables the connection of a lower-level bus system such as PROFIBUS PA to a redundant PROFIBUS DP.

An AS interface can be connected using AS-Interface master modules (CPs) that are used in the distributed I/O device. This enables the connection of simple sensors and actuators to PCS 7 with AS-Interface. PCS 7 integrates other I/O levels in a project in this way.
Increasing availability

The availability of the I/O can be increased through the following configuration options:

- **Redundant I/O (distributed I/O)**
  The entire signal path up to the sensor/actuator is configured redundantly. Additional information on this topic is available in section "Redundant I/O (Page 28)".

- **Switched I/O (distributed I/O)**
  The communication path to the I/O (station) is redundant. There is only one input/output module (SM) for processing a process signal. Additional information on this topic is available in section "Switched I/O (Page 30)"

Modules for the distributed I/O

**Note**

Information on which modules are released for the distributed I/O in PCS 7 can be found in the documentation *PCS 7 - Released modules*. You will find this documentation on the Internet at: [http://www.siemens.com/pcs7-documentation](http://www.siemens.com/pcs7-documentation).

### 3.1.1 Redundant I/O

**Redundant I/O**

Redundant I/O describes the situation when the I/O modules (SM) for processing a process signal are doubly available and can be addressed by both CPUs. The CPU signal or process signal will continue to be processed by a functioning module even when its partner fails. The entire signal path up to the sensor/actuator is configured redundantly.

**Note**

With PCS 7, you can determine if errors in redundantly acquired signals will have an effect of a module or channel. You can find information about this in the following sections:

- Section "Redundant input/output modules (Page 33)"
- Section "Failure of redundant input/output modules (Page 175)"

**Configuration**

In PCS 7, you can configure redundant I/O with selected S7-300 I/O modules of ET 200M.
The ET 200M distributed I/O device is connected as redundant DP slave to a fault-tolerant automation system operating as the DP master via PROFIBUS DP. A redundant configuration is achieved by installing an additional ET 200M and an additional PROFIBUS DP connection.

**Note**

Use only active bus modules for the ET 200M in a fault-tolerant system with PCS 7. Active bus modules enable you to plug and pull modules in runtime.

The following figure illustrates this configuration with ET 200M. Signals from redundant sensors can be registered.

![Diagram](image)

**Availability**

The block diagram shows an example configuration with ET 200M without a fault.

If a fault occurs in a maximum of one signal path per redundancy node (e.g. bus line (bus = PROFIBUS DP) in the first redundancy node and an input module (SM) in the second redundancy node), the overall system remains operable. The connected device continues to supply data to the central device, which remains available. If any other component in the redundancy chain fails, however, the complete system will fail.
Installation rules

The configuration always has to be symmetrical when using redundant I/O. Follow these installation rules:

- Both subsystems of the S7 400H must be configured identically. The same modules are located at the same slots.
  Example: CPU and CPs are located in both subsystems at the same slot.
- The communication paths and interfaces must be configured the same way in both subsystems.
  Example: The PROFIBUS cables in both subsystems are connected to the same PROFIBUS DP interface of the CPU 41x-4H.
- Redundant modules are always the same (order number, firmware version)

Configuration rules

- A DP slave must have the same PROFIBUS address in the mutually redundant DP master systems.

Additional information

- Section "Redundant interface modules in distributed I/O (Page 32)"
- Section "Redundant I/O modules (Page 33)"
- Manual Automation System S7-400H; Fault-tolerant Systems

3.1.2 Switched I/O

Switched I/O describes the situation when there is only one I/O module (SM) for processing a process signal. The communication path to the I/O (station) is redundant. In the event that a communication path fails, the distributed I/O (station) switches to the functioning communication path. The non-redundant I/O modules of the distributed I/O can be addressed via the redundant interface module (DP slave) of both central modules (CPU) of a fault-tolerant system.
**Configuration**

A switched I/O can be set up in PCS 7 with the following distributed I/O devices:

- **ET 200M**
  For this setup, you require an ET 200M with active backplane bus modules and a redundant IM 153-2 interface module.

- **ET 200iSP**
  For this setup, you require an ET 200iSP and a redundant IM 152-1 interface module.

Each subsystem of the S7-400H is connected to one of the two PROFIBUS DP interfaces of the interface module via a DP master interface.

The following figure illustrates this configuration for the ET 200M.

**Availability**

The block diagram shows the availability of the configuration illustrated above. When both systems are operating without fault, the block diagram appears as follows:

The following figure shows how one component may fail without this affecting the operation of the complete system.
The system remains available even when one component in part of a line of the redundancy node fails. There is only one I/O module and therefore no corresponding redundancy node. It is the weakest link in the complete system's chain.

Installation rules

The configuration always has to be symmetrical when using switched I/O. Follow these installation rules:

- CPU 41x-xH and additional DP masters must be located in the same slots in each subsystem (for example, in slot 4 of both subsystems).
- The PROFIBUS cables in both subsystems must be connected to the same interface (for example, to the PROFIBUS DP interfaces of the two CPU 41x-xH).

Configuration rules

- A DP slave must have the same PROFIBUS address in the mutually redundant DP master systems.

Additional information

- Section "Redundant interface modules (Page 32)"
- Manual Automation System S7-400H; Fault-tolerant Systems

3.1.3 Components in the distributed I/O

3.1.3.1 Redundant interface modules in distributed I/O

Redundant interface modules

By using two interface modules in one distributed I/O device, the following can be implemented:

- Setup of a switched distributed I/O
- Setup of a redundant distributed I/O

If the active interface module or the communication path fails via this interface module, the passive interface module takes over the relevant functions without interruption. The active interface is indicated by an illuminated "ACT" LED on the respective interface module.

Configuration:
The configuration is provided as an example in the section "Redundant I/O (Page 28)".

- ET 200M with redundant IM 153-2
  Two IM 153-2 interface modules are mounted on the active bus module in the distributed I/O device for redundant operation.

- ET 200iSP with redundant IM 152-1
  Two IM 152-1 interface modules are mounted on the active TM-IM/IM terminal module in the distributed I/O device for redundant operation.

Note
The signal modules of the ET 200iSP cannot be used redundantly.

Additional information
- Section "How to configure the redundant interface module for the I/O device (Page 110)"
- Section "Failure of redundant interface modules (Page 175)"
- Manual SIMATIC, Distributed I/O Device ET 200M
- Manual SIMATIC, Distributed I/O Device ET 200iSP
- Manual Automation System S7-400H; Fault-tolerant Systems

3.1.3.2 Redundant I/O modules

Configuring redundant input/output modules
Redundant I/O modules enable you to increase the availability in the I/O area.
The following configurations are possible with redundant I/O modules:

- Redundant input/output modules in redundant distributed I/O
  An example of this configuration is shown in the section "Redundant I/O (Page 28)"

- Redundant input/output modules in single-channel switched distributed I/O
  An example of this configuration is shown in the section "Switched I/O (Page 30)"

Note
Refer to the interconnection examples for redundant I/O (redundant input/output modules) in the manual Automation System S7-400H; Fault-tolerant Systems.

Redundant operation of S7-300 I/O modules
The following requirements must be met to operate redundant S7-300 I/O modules in the automation system:

- PCS 7 as of V6.0
- H-CPU as of firmware version V3.1
- Suitable S7-300 I/O modules (documentation: PCS 7 - Released Modules)
Required software and configuration

You select and configure the redundant modules in HW Config.

- In order for both subsystems of the H system to be able to address redundant input/output modules, S7 driver blocks from the "Redundant I/O" library and PCS 7 driver blocks from the PCS 7 Library as of PCS 7 V6.0 are required in addition to the necessary hardware.
- Modules with the same order number and version number can be paired in redundant configurations.

You interconnect the signals in the CFC chart. Additional information on this is available in the section "Configuration of redundant signals (Page 126)".

When the user program is compiled, the required driver blocks are placed, interconnected and configured automatically.

Reaction to a channel fault

You can define the passivation characteristics, for example how redundant input/output modules react to a channel fault (such as broken wire, short-circuit on the signal line). The reaction to a channel fault depends on the following aspects:

- Module employed
- Configuration
- Version of the PCS 7 library
  - As of PCS 7 V7.1, the potential passivation reaction is automatically detected based on the configured modules. The passivation reaction is set channel-by-channel.
  - Only the module-based passivation reaction can be selected with the Redlib V3.x library.
  - You can set the channel-based passivation reaction with the Redlib library as of V4.

You will find information on the passivation reaction for individual modules in the documentation PCS 7 - Released Modules.

Additional information

- Section "How to configure redundant I/O modules (Page 112)"
- Section "Failure of redundant I/O modules (Page 175)"
- Section "How to set the failure reaction of the input/output modules on the CPU (Page 95)"
- Manual Automation System S7-400H; Fault-tolerant Systems
- Online help for STEP 7

3.1.3.3 Redundant actuators and sensors

Failure detection

Actuators and sensors on the field level can be configured redundantly for PCS 7. Depending on the I/O module to which the redundant actuators or sensors are connected, failure of an actuator or sensor can be detected and reported to the process control system as an error. If
an actuator/sensor fails, the automation system continues to operate with the intact actuator/sensor. This ensures that the current status of the process values can be read in or output at any time.

**Note**
Refer to the product description of the I/O module you are using to see whether it can detect and report failures of connected actuators and sensors.

---

**Additional information**

- Manual *Automation System S7-400H; Fault-tolerant Systems*

---

### 3.2 Solutions for automation systems

**Introduction**

This chapter presents solutions that can be used to increase the availability of an automation system.

**S7-400H fault-tolerant programmable controller**

Only a fault-tolerant automation system can ensure an extremely short process safety time, for example, a switchover time in the milliseconds range. PCS 7 enables you to configure your process control system with redundancy using the S7-400H fault-tolerant programmable controller.

**Functionality**

The S7-400H programmable controller and all the other components in the PCS 7 environment are tuned to one another.

With this solution, a second backup CPU, which is event-synchronized to the master CPU, performs the same processing tasks of the user program as the master. If the active master CPU fails, the standby CPU continues processing the user program without delay. This type of standby is referred to as "Hot standby".

There are always two CPUs and two power supplies in an S7-400H. The communications processors and I/O modules are expansion modules.
3.2.1 S7-400H hardware components

Hardware components

The following hardware components are available for the configuration of the fault-tolerant automation system.

<table>
<thead>
<tr>
<th>Hardware components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mounting rack UR2-H</td>
</tr>
<tr>
<td>Mounting rack UR2</td>
</tr>
<tr>
<td>Mounting rack UR1</td>
</tr>
<tr>
<td>Central processing unit CPU 412-3H ...-5H PN/DP</td>
</tr>
<tr>
<td>Central processing unit CPU 414-4H ... 5H PN/DP</td>
</tr>
<tr>
<td>Central processing unit CPU 416-5H PN/DP</td>
</tr>
<tr>
<td>Central processing unit CPU 417-4H... 5H PN/DP</td>
</tr>
<tr>
<td>Synchronization modules</td>
</tr>
<tr>
<td>Synchronization cable (up to 10 km)</td>
</tr>
<tr>
<td>Communications processor CP 443-5 Extended</td>
</tr>
<tr>
<td>Communications processor CP 443-1</td>
</tr>
</tbody>
</table>

Setup

[Diagram showing rack layout and synchronization lines]
Mounting racks

The following three racks are available for installing the S7-400H. Normally, the UR2-H rack is used.

<table>
<thead>
<tr>
<th>Module type</th>
<th>Size</th>
<th>Special feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>UR2-H</td>
<td>2 x 9 slots</td>
<td>Installation of two separate subsystems each with nine modules. The two subsystems are electrically isolated (not mechanically). It is not possible to replace a rack in runtime.</td>
</tr>
<tr>
<td>UR1</td>
<td>1 x 18 slots</td>
<td>Two racks are required for an S7-400H. You can replace a rack in runtime.</td>
</tr>
<tr>
<td>UR2</td>
<td>1 x 9 slots</td>
<td>Two racks are required for an S7-400H. You can replace a rack in runtime.</td>
</tr>
</tbody>
</table>

Central processing units

There are two CPUs in an H-system. The two CPUs are connected to one another using synchronization modules and fiber-optic cables.

Power supply

A separate power supply module from the standard S7-400 series is needed for each subsystem of the S7-400H. Two power supply modules can be used in each subsystem to increase the availability of the fault-tolerant system. In this case, use the following power supply modules that can be used for redundancy.

Power supply modules for 24 VDC as well as for 120/230 VAC nominal input voltages with output currents of 10 and 20 A.

Synchronization modules

Synchronization modules are used to link the two central processing units. They are installed in the central processing units and interconnected with fiber-optic cable. Two synchronization modules are installed in each CPU.

Set the rack number for the H CPU as of firmware version V4.X directly on the CPU. The synchronization modules can be replaced in runtime.

The same rack number must be set at all synchronization modules up to firmware V3.x.

Fiber-optic cables for synchronization

The fiber-optic cables are connected to the synchronization modules and form the physical connection (redundancy link) between the two automation stations. The synchronization cables must not be cross-connected.

In addition to the standard lengths of 1 m, 2 m, and 10 m, custom-made synchronization cables are available in lengths up to 10 km.
Transmission medium

The suitable physical transmission medium depends on the range, resistance to interference and the transmission rate.

- Industrial Ethernet using fiber-optic cables or triaxial or twisted-pair copper lines can be used for communication between the automation system and the OS servers.
- PROFIBUS DP with electrical or optical components is used for communication from the automation system to the distributed I/O devices.

The transmission media and communication processors can be configured redundantly. If the active communication component (CP, bus) fails, the communication automatically continues through the redundant connection.

Only Industrial Ethernet with ISO protocol can be used as the plant bus for a fault-tolerant system. The communication modules must also support the ISO protocol.

Equipping the rack

The hardware setup in the automation system and the configuration in HW Config must match:

- Rack (9 or 18 slots for redundant and, in some cases, remote configuration)
- Power supply modules (in some cases redundant configuration)
- H CPU with sync modules in slots "IF1" and "IF2"
- Communications processors (CP 443-1, CP 443-5 Extended)

Configuration

A pre-existing network can be used for fault-tolerant communication between non-redundant SIMATIC stations and (redundant) SIMATIC H stations. You set the parameters of the fault-tolerant S7 connections in NetPro.

The required communication blocks for data transmission (measured values, binary values, interlocks) are available in the PCS 7 Library. The communication blocks differ in their transmission mechanism which, for example, may be secured or unsecured.

Additional information

- Section " How to add a SIMATIC H station to your project (Page 90) "
- Section " How to insert synchronization modules into the H CPU (Page 91) "
- Section " How to configure redundant communication processors (Page 93) "
- Section " Time synchronization (Page 88) "
- Manual Automation System S7-400H; Fault-tolerant Systems
3.2.2 How the SIMATIC S7-400H AS operates

Active redundancy

The automation system consists of two redundantly configured subsystems, which are synchronized through fiber-optic cables.

The two subsystems form a fault-tolerant automation system that operates with a dual-channel design according to the principle of active redundancy. Active redundancy, often referred to as functional redundancy, means that all redundant components are in continual operation and simultaneously involved in the acquisition of process data. The control task is the responsibility of the redundancy partner that is active at any given time. The user programs loaded in both CPUs are fully identical and are run synchronously by both CPUs.

If the active CPU fails, the automation system automatically switches to the redundant CPU (see section "S7-400H hardware components (Page 36)" and Documentation Process Control System, SIMATIC PCS 7, Released Modules). The failover has no effect on the ongoing process because it is bumpless.

Additional information
- Section "Failure of the master CPU (Page 177)"
- Section "Failure of a fiber-optic cable (Page 178)"
- Manual Automation System S7-400H; Fault-tolerant Systems

3.3 Solutions for communication

Introduction

In this section, you will learn about the redundancy concepts for the various levels of the process control system.

Requirements for communication systems

The availability of a process control system is not only determined by the automation system, the environment also plays a considerable role. This includes not only the operator control and monitoring components but also a high-performance communication system that connects the management level to the process level and the process level to the field level.

Distributed control systems are also needed in the manufacturing and processing automation. Complex control tasks are broken down into smaller, simpler steps with distributed form. The demand for communication between distributed systems increases.

High-performance, comprehensive communication system is needed to fulfill this demand. The communication connections between the systems involved should be redundant.

Local networks (LAN) form the basis of the communication system. The following are options that can be implemented based on the specific system requirements:
The communication connections are grouped in three areas:

- Terminal bus
- Plant bus
- Fieldbus

In PCS 7, we recommend that the bus systems are set up in a ring structure. The ring structure makes the bus "fault-tolerant", since it can compensate for the failure of a bus line.

**Redundant communication connections**

Redundant communication connections can be formed on all levels of the process control system.

When a communication error occurs, communication automatically switches over from the active connection to the backup connection. Both connections use the same media and protocols. The failover has no effect on the user program running in the CPU.

**Overview of the redundant and fault-tolerant bus systems**

In PCS 7 systems, you can configure fully redundant bus systems with redundant components for the following bus systems:

- Redundant, fault-tolerant terminal bus (Page 49)
- Redundant, fault-tolerant plant bus (Page 59)
- Redundant PROFIBUS DP (Page 62)
Bus systems set up as a ring are fault-tolerant. In ring structures, the signal path remains intact even if there is a disconnection on the transmission cable at any point in the ring (for example due to a wire break). The availability is ensured by ring redundancy.

This fault-tolerance is used in the following bus systems:
- Fault-tolerant terminal bus (Page 47)
- Fault-tolerant plant bus (Page 57)
- Fault-tolerant PROFIBUS PA (Page 68)
- Fault-tolerant PROFINET bus (Page 64)

The following sections describe the basics of these communications solutions.

### 3.3.1 Network components

**Introduction**

Local networks (LAN) form the basis of the communication system. The following are options that can be implemented based on the specific system requirements:
- Electrical
- Optical
- Optical/electrical (mixed operation)

**Overview of the network components**

You can set up bus systems with the following link and switch modules of SIMATIC NET.

**Note**

OSM and OLM mixed operation is not permitted.
### Network component

<table>
<thead>
<tr>
<th>Network component</th>
<th>Bus system</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch (from the SCALANCE series)</td>
<td>Terminal bus</td>
<td>Type-specific use in network setup</td>
</tr>
<tr>
<td></td>
<td>Plant bus</td>
<td>Selected SCALANCE X components enable the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transmission rates up to 1 Gbps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Media converter (electrical/optical bidirectional)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Function as redundancy manager (configuration of ring redundancy)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Function as standby manager (redundant linking of networks)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Depending on the type, either optical or electrical connections are used.</td>
</tr>
<tr>
<td>SCALANCE X204 RNA</td>
<td>Terminal bus</td>
<td>Connecting a singular infrastructure component to the redundant terminal bus. For example:</td>
</tr>
<tr>
<td></td>
<td>Plant bus</td>
<td>• SICLOCK TC400</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Domain controller</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• File server</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 ports for the infrastructure components</td>
</tr>
<tr>
<td>ESM (Electrical Switch Module)</td>
<td>Terminal bus</td>
<td>Setup of electrical bus systems (suitable as redundancy manager)</td>
</tr>
<tr>
<td></td>
<td>Plant bus</td>
<td>The connection to the ESMs is electrical.</td>
</tr>
<tr>
<td>OSM (Optical Switch Module)</td>
<td>Terminal bus</td>
<td>Setup of optical bus systems An optical ring must be configured with at least two optical switch modules.</td>
</tr>
<tr>
<td></td>
<td>Plant bus</td>
<td>(suitable as redundancy manager)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The connection to the OSMs is electrical or optical.</td>
</tr>
<tr>
<td>Switch (from the SCALANCE series)</td>
<td>Fieldbus</td>
<td>• Fieldbus as fault-tolerant PROFINET ring</td>
</tr>
<tr>
<td>OLM (Optical Link Module)</td>
<td>Fieldbus</td>
<td>Setup of optical transmission paths</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configuration variants:</td>
</tr>
<tr>
<td></td>
<td>PROFIBUS DP</td>
<td>• DP master (electrical) &gt; OLM &gt; FO &gt; OLM &gt; interface module (electrical connection)</td>
</tr>
<tr>
<td></td>
<td>PROFIBUS DP</td>
<td>• DP master (electrical) &gt; OLM &gt; FO &gt; interface module (optical connection)</td>
</tr>
<tr>
<td>Network component</td>
<td>Bus system</td>
<td>Application</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AFD (Automatic Field Distributor)</td>
<td>Fieldbus</td>
<td>Connection of field devices via ring redundancy</td>
</tr>
<tr>
<td></td>
<td>• PROFIBUS PA</td>
<td>• Maximum of 31 fieldbus components on one bus</td>
</tr>
<tr>
<td></td>
<td>• FOUNDATION Fieldbus</td>
<td>• Maximum of 8 AFD/ADFiS on a redundant fieldbus coupler</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Maximum of 4 field devices per AFD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Maximum of 6 field devices per AFDiS</td>
</tr>
<tr>
<td>AFDiS</td>
<td>Fieldbus</td>
<td>Connection of field devices via coupler redundancy</td>
</tr>
<tr>
<td></td>
<td>• PROFIBUS PA</td>
<td>• 1 AFS on a redundant fieldbus coupler</td>
</tr>
<tr>
<td></td>
<td>• FOUNDATION Fieldbus</td>
<td>• Maximum of 31 fieldbus components on the AFS</td>
</tr>
</tbody>
</table>

**Redundancy manager**

Certain network components in the SIMATIC NET product range support the redundancy manager function.

This function enables the configuration of ring redundancy. Network components operating as the redundancy manager can ensure that the bus connections remain undisturbed if there is a fault on a bus line (such as a cable break).

**Example of a ring structure with SCALANCE X400 and X200**

The SCALANCE X414-3E as the redundancy manager has a gray background in the figure.

**Standby manager**

Switches and data links (network cable) connect the redundant networks. Redundant coupling of networks is only possible if two devices (switches) within a network segment support the standby manager function. Certain network components from the SIMATIC NET product range support this function.

Within a network segment, both devices are configured for the standby manager function. The two devices exchange data frames via the bus line and thereby synchronize their operating status. One network component becomes the standby manager (master) and the other standby manager (slave).

When operation is error-free, the data link running between the redundant networks is active for the standby manager (master). If this data link fails (e.g., due to a defective device or cable break), the standby manager (slave) activates its data link while the fault remains pending.

**Example of a ring structure with SCALANCE X**
3.3 Solutions for communication

**SCALANCE X switches for setting up redundant networks**

You can find additional information on SCALANCE X switches approved for PCS 7 in the *Process Control System PCS 7; Released Modules* documentation. The switches must have the necessary functions available to set up the relevant redundant network:

- Redundancy manager
- Standby manager
- Parallel Redundancy Protokoll

**PC stations on networks**

The PC stations are connected to the networks via communication modules and network cables.

The communication modules occupy a slot in the PC or programming device (PG). A variety of communication modules can be used, depending on the requirements. You can find information on this in the following sections:

- Section "Connecting PC stations to the terminal bus (Page 46)"
- Section "Connecting PC stations to the plant bus (Page 56)"

**Additional information**

- Documentation *Process Control System PCS 7; PCS 7 Readme*
- Documentation *Process Control System PCS 7; Released modules*
- Manual *SIMATIC Net Twisted Pair and Fiber-Optic Networks*
- Manual *SIMATIC NET; Industrial Ethernet OSM/ESM*
- Manual *SIMATIC Net PROFIBUS Networks*
- Manual *SIMATIC; Communication with SIMATIC*
- Operating Instructions *SIMATIC NET; Industrial Ethernet Switches SCALANCE X-200*
- Operating Instructions *SIMATIC NET; Industrial Ethernet Switches SCALANCE X-300*
- Operating Instructions *SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400*
- Configuration Manual *SIMATIC NET; Industrial Ethernet Switches; SCALANCE X-300; SCALANCE X-400*
3.3.2 Media Redundancy Protocol

Use of media redundancy protocol

**Note**

HSR (High Speed Redundancy) and MRP (Media Redundancy Protocol)

The X200 IRT switches cannot serve as redundancy manager and standby manager at the same time.

Standby managers can only be operated with the media redundancy protocol, High Speed Redundancy (HSR). Standby redundancy and media redundancy protocol do not work together.

<table>
<thead>
<tr>
<th></th>
<th>HSR</th>
<th>MRP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separate terminal</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>and plant bus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Common terminal</td>
<td>X</td>
<td>-</td>
</tr>
<tr>
<td>and plant bus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROFINET - fieldbus</td>
<td>-</td>
<td>The following Industrial Ethernet switches support MRP:</td>
</tr>
<tr>
<td>ring</td>
<td></td>
<td>● SCALANCE X-200 from firmware version V4.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● SCALANCE X-200 IRT from firmware version V4.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● SCALANCE X-300 from firmware version V3.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● SCALANCE X-400 from firmware version V3.0</td>
</tr>
</tbody>
</table>

**HSR**

HSR is used for the redundant connection to the terminal and plant bus.

Ring redundancy and redundant connection of rings are possible by means of configuration of the following functions:

- Redundancy manager
- Standby manager

**MRP**

All devices must support MRP to permit the redundant connection in a fieldbus ring based on PROFINET.

**Additional information**

Further information regarding HSR and MRP may be found in the documentation for the Industrial Ethernet Switches.
3.3.3 Solutions for the terminal bus

3.3.3.1 Connecting PC stations to the terminal bus

You can connect the following PC stations to industrial Ethernet via communication modules (network adapters or communications processors):

- Operator stations
- BATCH stations
- Route Control stations
- Engineering stations

The communication modules occupy a slot in the PC or programming device (PG). Depending on the requirement.

Communication modules for connection to the terminal bus

- Standard communication modules (for example, Intel® Gigabit CT Desktop Adapter)
- Variants for the redundant connection of the PC station to a terminal bus:
  - Parallel Redundancy Protocol
  - INTEL TEAM mode

Check, using the product documentation, whether the communication modules are suitable for the implementation of the concept in question for the terminal bus.

Components

The following network adapters are approved in PCS 7.

- PCIe network adapters:
  - Intel® PRO/1000 PT Server Adapter
  - Intel® Gigabit CT Desktop Adapter (Intel® PRO/1000 PT Desktop Adapter is permitted)
- integrated network adapter (from bundle PC with Windows 7/Server 2008 R2)
  - INTEL ... (LM-Adapter)
  - INTEL ... (L-Adapter)
- PCI network adapters (for Windows XP/2003 operating systems only)
  - Intel PRO/1000 MT Server-Adapter
  - Intel PRO/1000 GT Desktop-Adapter

Additional information

- Documentation *Process Control System PCS 7; Released modules*
- Documentation *Process Control System PCS 7; PCS 7 Readme*
3.3.3.2 Fault-tolerant terminal bus

The terminal bus connects the servers (OS servers, BATCH servers, Route Control servers) with the clients of the process control system (OS clients, BATCH clients, Route Control clients).

The fault-tolerant terminal bus can be set up in a ring structure with network components of SIMATIC NET. The network components enable unrestricted operation of the terminal bus. For example, a broken cable in the connection between the modules is tolerated and communication remains uninterrupted.

If the terminal bus experiences problems, no process data are sent from the servers to the clients.

Fault-tolerant communication solutions

The following solutions are available to guard against failure of the terminal bus:

- Ring structure in an electrical network. The connection to the switches is electrical.
- Ring structure in an optical network with switches and FO cables. The connection to the switches is electrical or optical.
- Ring structure in a combined network with optical and electrical switches and FO cables. The connection to the switches is electrical.
- Ring structures as optical, electrical and combined networks with transfer rates up to 1 Gbps based on the modular switches

Configuration

In the following figure, the terminal bus is shown as a ring with switches as an example. The OS servers are connected to the switches in a distributed pattern in order to take optimal advantage of the switch functionality. The probability of OS server failure due to the failure of a switch and the bus load are thereby reduced.

The log data of the control process is secured and continuously available if you use two OS clients each equipped with a line printer for printing the message sequence reports.

Note

If a switch fails, the connection to the associated nodes will also fail. Therefore, redundant servers must not be connected to the same switch.
### Availability

If there is a fault in a ring line, the communication between clients and servers via the switches remains unaffected. However, if one of the switches fails, the link between the connected OS servers and the OS clients is interrupted. To increase the fault-tolerance even more, however, the redundant ring described in the following section can be used.

### Additional information

- Manual *SIMATIC Net Twisted Pair and Fiber-Optic Networks*
- Operating Instructions *SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400*
- Operating Instructions *SIMATIC NET; Industrial Ethernet Switches SCALANCE X-300*
3.3.3.3 Redundant, fault-tolerant terminal bus

Functionality

The terminal bus connects the servers (OS servers, BATCH servers, Route Control servers) etc. with the clients of the process control system (OS clients, BATCH clients, Route Control clients).

The following solutions for a redundant, fault-tolerant terminal bus are offered as of PCS 7 V8.0:

- Redundant, fault-tolerant terminal bus based on the Parallel Redundancy Protocol (PRP) (Page 50)
  Separate double ring with PRP; solution in accordance with IEC 62439-3)
- Redundant, fault-tolerant terminal bus based on the INTEL TEAM mode (Page 52)
  Coupled double ring based on redundant coupling of network segments - formed by two identical coupled terminal bus rings

Redundant components

The following components are configured redundantly:

- Electrical or optical network with Ethernet switches
- Switches, fiber optic cables and electrical connections
- Ring structures based on switches from the SCALANCE series.

You can find additional information on the switches used with PCS 7 in the section "Network components (Page 41)".

Additional information

- Section "How to configure the redundant terminal bus on the basis of the Parallel Redundancy Protocol (Page 97)"
- Section "How to configure the redundant terminal bus on the basis of the INTEL TEAM mode (Page 97)"
- Documentation PCS 7 Released Modules
- Manual SIMATIC Net Twisted Pair and Fiber-Optic Networks
- Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400
- Configuration manual SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400
- Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-200
- Operating instructions SIMATIC NET; Industrial Ethernet; "SCALANCE X204RNA, SCALANCE X204RNA EEC"
3.3 Solutions for communication

- Operating instructions SIMATIC NET; PG/PC - Industrial Ethernet; SOFTNET-IE RNA
- Readme for SOFTNET IE RNA

3.3.3.4 Redundant, fault-tolerant terminal bus based on the Parallel Redundancy Protocol (PRP)

The section below describes the basic structure of a redundant fault-tolerant terminal bus using the SIMATIC NET SOFTNET-IE RNA software. This software is based on the Parallel Redundancy Protocol (PRP) as specified in IEC 62439-3. Each PC station is connected to 2 separate redundant networks with one network adapter each. The communications processes on the redundantly connected PC stations are organized by the SIMATIC NET SOFTNET-IE RNA software.

Install SIMATIC NET SOFTNET-IE RNA on every redundantly connected PC station. Information on this topic can be found in the SIMATIC NET; PG/PC - Industrial Ethernet; SOFTNET-IE RNA operating instructions.

The following diagram illustrates a sample configuration based on the SIMATIC NET SOFTNET-IE RNA software:

Quantity structure for the operator station

You can find information about this in the Process Control System PCS 7; Licenses and quantity structures documentation.
Redundant, fault-tolerant terminal bus with SIMATIC NET SOFTNET-IE RNA

All protocols among the redundantly connected components are automatically duplicated, sent and distributed in the mutually redundant networks. The receiver uses the first incoming frame with the same information from the redundant networks.

**Advantages:**
- Easy administration
- A fault on one bus has no effect on the redundant bus

**Components**

SCALANCE series switches are used to connect the components. Recommended switches that support the Parallel Redundancy Protocol may be found in the Process Control System PCS 7; Released modules documentation.

**Availability - redundant fault-tolerant terminal bus**

The entire transmission route can be configured redundantly. A transmission route remains operational for communication on the terminal bus if any of the network components fails.

**Connecting non-redundant networks and components**

An integrated solution of network components and protection devices can be implemented for a substation or process application using PRP-compatible SCALANCE X products. Connect components having only one network connection to the redundant, fault-tolerant terminal bus.
using the SCALANCE X204RNA. Select this connection for infrastructure components, for example:

- Master system clock (from SICLOCK TC400)
- Domain controllers (DCs), DNS, WINS, DHCP, WSUS
- WLAN access point
- File server

Requirements

- Per SCALANCE X204RNA, a maximum of two non-redundant networks and components with only one network connection
- Two separate, redundant terminal bus networks
- Maximum distance to network node (component/switch) = 10 m

Additional information

- Operating instructions SIMATIC NET; PG/PC - Industrial Ethernet; SOFTNET-IE RNA
- Readme file for the "SIMATIC NET SOFTNET-IE RNA" software
- Section "How to configure the redundant terminal bus on the basis of the Parallel Redundancy Protocol (Page 97)"
- Operating Instructions SIMATIC NET; Industrial Ethernet; "SCALANCE X204RNA, SCALANCE X204RNA EEC"
- You can find information on the available operating systems in the PCS 7 Readme file.

3.3.3.5 Redundant, fault-tolerant terminal bus based on the INTEL TEAM mode

The following section describes the basic structure of a redundant, fault-tolerant terminal bus using network adapters working in "INTEL Team" mode.

The following figure shows this configuration.
Redundant linking of network segments

The redundant linking of two network segments is only possible when the linking switches are capable of acting as standby manager.

Example:
- Linking with SCALANCE X414-3E
- For Gigabit Ethernet: Linking with SCALANCE X408-2

Redundant, fault-tolerant terminal bus with redundant linking of network segments (rings)

One pair of redundancy-capable network adapters is used for each PC station in each server to be connected to the terminal bus (for example, OS server, BATCH server, domain controller), (see section "Connecting PC stations to the terminal bus (Page 46)"). Team-capable network adapters are required for this configuration. They work in "INTEL Team mode" with only one logical network address. Each network adapter is connected to one of the redundant terminal bus rings (bus1/bus2). The link between the redundant network segments (rings) is implemented using two switches in each network.
Components

The following switches can be used:

- SCALANCE series of switches
  Modules for optical or electrical connection are used for the connection.

- OSM (optical signal lines)
  The connection to the OSMs is electrical or optical.

- ESM (electrical signal lines)
  The connection to the ESMs is electrical.

Configuration of the switches

For redundant linking of networks, configure one SCALANCE switch as the standby master and one as the standby slave within a network segment. A redundancy manager (RM) must be configured in each network segment to enable ring redundancy. Switches and data links (network cable) connect the redundant networks. The switches configured in this way exchange data frames with one another and synchronize their operating status (standby master/standby slave).

You will find details of how to configure switches in the documentation for *Industrial Ethernet Switches SCALANCE X* under the following topics:

- Configuration using Web-Based Management and Command Line Interface
- Configuration and diagnostics via SNMP

Availability - redundant terminal bus

The entire transmission route can be configured redundantly. A transmission route remains operational via a terminal bus if any of the network components fails.

In process mode, one switch automatically takes over the standby master function for linking the networks. In error-free status, the data link to the other network is active only for the active standby master. If this data link fails (for example, due to a defective cable), the standby slave activates its data link.
Additional information

- Section "How to configure the redundant terminal bus on the basis of the INTEL TEAM mode (Page 97)"
- Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400
3.3.4 Solutions for the plant bus

3.3.4.1 Connecting PC stations to the plant bus

Network adapters for connection to the fault-tolerant plant bus

<table>
<thead>
<tr>
<th>Application</th>
<th>Network adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection of up to 8 communication partners (automation systems or servers)</td>
<td>PCIe network adapter Intel® Gigabit CT Desktop Adapter (Intel® PRO/1000 PT Desktop Adapter is permitted)</td>
</tr>
<tr>
<td>No connection of fault-tolerant automation systems</td>
<td>PCI network adapter (for Windows XP/2003 operating systems only): Intel® PRO/1000 GT Desktop Adapter</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application</th>
<th>Network adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection of up to 64 communication partners (including redundant systems) per operator station</td>
<td>CP 1623 with software S7-1623</td>
</tr>
<tr>
<td>Connecting fault-tolerant automation systems</td>
<td>CP 1613 A2 with software S7-1613</td>
</tr>
<tr>
<td></td>
<td>CP 1613 A1 (only approved for the Windows XP or Windows Server 2003/2003 R2 operating systems)</td>
</tr>
</tbody>
</table>

Network adapter for connection to the redundant, fault-tolerant plant bus

Communication modules with their own processor are required for connection to the redundant, fault-tolerant plant bus.

<table>
<thead>
<tr>
<th>Application</th>
<th>Network adapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection of up to 64 communication partners (including redundant systems) per operator station</td>
<td>2x CP 1623 with software S7-1623</td>
</tr>
<tr>
<td>Connecting fault-tolerant automation systems</td>
<td>2x CP 1613 A2 with S7-1613 software</td>
</tr>
<tr>
<td></td>
<td>2x CP 1613 A1 (only approved for the Windows XP or Windows Server 2003/2003 R2 operating systems)</td>
</tr>
</tbody>
</table>

License key for AS communication

Depending on the network adapters used, you need a license key for PC stations with communication to the AS:

<table>
<thead>
<tr>
<th>Network adapter</th>
<th>License key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Ethernet network adapter (not required for SIMATIC NET CP)</td>
<td>BCE</td>
</tr>
<tr>
<td>When using SIMATIC NET CP (e.g. CP 1623)</td>
<td>Industrial Ethernet</td>
</tr>
<tr>
<td>When using SIMATIC NET CP (e.g. CP 1623) with fault-tolerant connections.</td>
<td>S7-REDCONNECT</td>
</tr>
</tbody>
</table>
Connecting fault-tolerant automation systems (S7-400H/FH)

CP 16x3 communications processors and the licensed S7-REDCONNECT software are required for redundant communication with S7-400H/FH.

Additional information

- Documentation Process Control System PCS 7; Released modules
- Documentation Process Control System PCS 7; PCS 7 Readme

3.3.4.2 Fault-tolerant plant bus

The plant bus connects automation systems with servers (OS server, Route Control server). The connection to a fault-tolerant plant bus is implemented with Ethernet communications processors (CPs) that are installed in each subsystem of the automation system and in the servers.

Fault-tolerant plant bus can be set up in a ring structure with network components of SIMATIC NET. The network components ensure unrestricted operation of the plant bus. For example, a broken cable in the connection between the modules is tolerated and communication remains uninterrupted.

If the plant bus is disrupted, no process data are transferred between the servers and the automation systems or between the automation systems themselves.

Fault-tolerant communication solutions

The following communication solutions are offered to prevent a possible failure:

- Ring structure in an electrical network.
  The connection to the switches is electrical.
- Ring structure in an optical network with switches and FO cable.
  The connection to the switches is electrical or optical.
- Ring structure in a combined network with optical and electrical switches and a FO cable.
  The connection to the switches is electrical.
- Ring structures as optical, electrical and combined networks with transmission rates up to 1 Gbps based on modular SCALANCE X switches

The following switches can be used:

- Switches of the SCALANCE series
  Modules optical or electrical connection are used for the connection
- OSM (optical signal cables)
  The connection to the OSMs is electrical or optical.
- ESM (electrical signal cables)
  The connection to the ESM is electrical.

Configuration - ring structure

The following figure represents a fault-tolerant plant bus in a ring structure with switches.
The following automation systems can be used:

- AS 41xH

![Diagram of automation system]

### Availability - ring structure

In this system, one CP 443-1 may fail in each subsystem of the AS without this affecting the complete system.

The plant bus indicated by the asterisk ( * ) is set up with switches so that it is fault tolerant and will tolerate a break on the bus cable at any point. One of the two switches to which the OS servers are connected may fail without this affecting the complete system. If one switch fails, the redundant OS partner server can continue to communicate using the operational switch. The same scenario applies to the switches that each have a CP of a subsystem of the H system connected.

To guard against the failure of all switches, however, the redundant double ring described in the following section can be used.
Additional information

- Section "How to configure a fault-tolerant plant bus (Page 100)"
- Manual SIMATIC Net Twisted Pair and Fiber-Optic Networks
- Manual SIMATIC NET Industrial Ethernet OSM/ESM Network Management
- Manual SIMATIC; Communication with SIMATIC
- Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400

3.3.4.3 Redundant, fault-tolerant plant bus

Functionality

The plant bus connects automation systems with servers (OS server, Route Control server). The connection to a redundant, fault-tolerant plant bus is implemented with Ethernet communications processors (CPs) that are installed in each subsystem of the automation system and in the servers.

A redundant, fault-tolerant plant bus is set up using two identical, separate plant bus rings (double ring). The network components ensure unrestricted operation of the plant bus. If a plant bus fails, communication remains possible over the second plant bus.
Redundant communication solutions

The following communication solutions are offered to prevent a possible failure:

- Redundant electrical or optical network with switches set up as Industrial Ethernet
- Combined redundant network with switches, FO cables and electrical connection
- Ring structures can be set up based on modular switches from the SCALANCE series. (Can be implemented as optical, electrical and combined networks)

The following switches can be used:

- Switches of the SCALANCE series
  Modules optical or electrical connection are used for the connection
- OSM (optical signal cables)
The connection to the OSMs is electrical or optical.
- ESM (electrical signal cables)
The connection to the ESM is electrical.

You can find additional information on the switches used with PCS 7 in the "Network components (Page 41)" section.

Configuration - redundant, fault-tolerant plant bus

The figure below shows the basic structure of the redundant, fault-tolerant plant bus.

- Bus1 shows the functionally correct structure (shared switches for AS and OS).
- Bus2 shows the typical structure in PCS 7 plants (separate switches for AS and OS).

Note

Check the redundancy behavior of the individual components during commissioning.
Availability - redundant, fault-tolerant plant bus

The block diagram for a redundant, fault-tolerant plant bus with two CPs each in both OS servers and additional switches appears as follows:

In this system, one CP 16x3 can fail in each OS server or one CP 443-1 in each subsystem of the AS without this affecting the complete system. There are two plant buses (busses), each set up with redundant switches. This guards against the failure of the bus and all components involved (switches).

Additional information

- Section "Connecting PC stations to the plant bus (Page 56)"
- Section "Media Redundancy Protocol (Page 45)"
- Section "How to configure a fault-tolerant plant bus (Page 100)"
- Documentation PCS 7 Released Modules
- Manual SIMATIC Net Twisted Pair and Fiber-Optic Networks
- Operating Instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400
- Manual SIMATIC NET Industrial Ethernet OSM/ESM Network Management
- Manual SIMATIC Communication with SIMATIC
3.3.5 Solutions for the fieldbus

3.3.5.1 Redundant PROFIBUS DP

Functionality

The field bus is used for data exchange between the automation system (AS) and the distributed I/O. PROFIBUS DP (distributed peripheral)—the field bus standard for manufacturing and process automation—is used. PROFIBUS DP includes the specifications for the following elements:

- Physical bus characteristics
- Access method
- User protocol
- User interface

PROFIBUS DP is suitable for fast, cyclic data exchange with field devices. It is used to connect distributed I/O, for example, ET 200M, with very fast response times.

It is often advantageous to connect several DP master systems to an automation system in order to increase the number of I/O components that can be connected. This also enables segments to be formed, allowing individual production areas to operate independent of one another.

Fault-tolerant communication solutions

The following fault-tolerant communication solutions are offered for PROFIBUS DP:

- Redundant PROFIBUS DP as an electrical network
- Redundant PROFIBUS DP with OLMs (optical network)

Configuration

The S7-400H fault-tolerant automation system features a DP master interface on each CPU for connecting to PROFIBUS DP. The redundant PROFIBUS DP connects the redundant DP master to the redundant interface modules of the distributed I/O.

The following figure shows an example for connecting redundant distributed I/O based on ET 200M to a redundant PROFIBUS DP.
Availability

If the active PROFIBUS DP fails, sensors and H system can communicate with each other over the redundant bus connection. The configuration shown in the following figure provides increased availability due to the redundant interfacing of the distributed I/O.

Additional information

- Section "How to configure redundant PROFIBUS DP (Page 102)"
- Manual SIMATIC Net PROFIBUS Networks
- Manual SIMATIC; Communication with SIMATIC
3.3.5.2 Fault-tolerant fieldbus based on PROFINET

Functionality

The fieldbus is used for data communication between the automation system (AS) and the distributed I/O. PROFINET is a standard for manufacturing and process automation. The PROFINET-based fieldbus comprises the specifications for the following elements:

- Physical bus characteristics
- Access method
- User protocol
- User interface

PROFINET is suitable for fast, cyclic data communication with field devices. It is used to connect distributed I/O with very fast response times.

Fault-tolerant communication solutions

The following fault-tolerant communication solutions are offered for the PROFINET-based fieldbus:

- Electrically designed network
- Optically designed network

Configurations

The S7-400H fault-tolerant automation system features a PROFINET interface on each CPU 4xx--5H PN/DP for connecting to PROFINET. The fault-tolerant PROFINET connects the CPU with the distributed I/O.

The following figure shows the connection of I/O based on PROFINET.
Note
Fault-tolerant PROFINET
It is absolutely necessary to operate the fieldbus ring with MRP (media redundancy protocol) when using rings with PROFINET.

Availability
If the communication connection via a CPU fails, the stations of the distributed I/O can communicate with the H system over the fault-tolerant bus line. The configuration shown in the following figure provides increased availability due to the interfacing of the distributed I/O.

NOTICE
Changes to PROFINET modules only take effect when you load your hardware configuration with the updated STEP 7 version to the CPU, which is in "STOP" mode.

Additional information
- Section "How to configure a fault-tolerant fieldbus on the basis of PROFINET (Page 105)"
- Manual SIMATIC NET; PROFINET Networks
- Manual SIMATIC; Communication with SIMATIC
- Manual SIMATIC STEP 7; Modifying the System during Operation via CiR

3.3.5.3 Gateway between redundant and non-redundant PROFIBUS DP

Y Link
The Y Link consists of two IM 153-2 interface modules and a Y coupler that are interconnected through the corresponding bus modules (BM IM/IM and BM Y coupler).
### Configuration

![Diagram showing configuration of S7-400H with Y Link and PROFIBUS DP connections]

### Functionality

The Y Link creates a gateway from the redundant DP master system of an S7-400H to a non-redundant DP master system. This enables devices with only one PROFIBUS DP interface to be connected to a redundant DP master system as switched I/O.

The new generation of the Y Link no longer requires a repeater and is capable of forwarding diagnostics requests from the corresponding function modules or I/O modules to the CPU.

DPV1 slaves can be connected downstream from the Y Link in addition to the standard PROFIBUS DP slaves.

### Additional information

- Section "How to configure the Y Link (Page 119)"
- Manual DP/PA Link and Y Link Bus Couplings

### 3.3.5.4 Connection of PROFIBUS PA to PROFIBUS DP

#### DP/PA Link

The DP/PA Link allows a connection between PROFIBUS DP and PROFIBUS PA. DP/PA link includes the following modules, which are interconnected via the backplane bus:

- Interface module IM 153-2
- one or more FDC 157 DP/PA couplers
Functionality

The DP/PA Coupler is a transceiver that interconnects PROFIBUS DP and PROFIBUS PA and decouples the various transmission rates. It is a slave on the PROFIBUS DP and a master on the PROFIBUS PA. Seen from the automation system, the DP/PA Link is a modular slave. The individual modules of this slave are the field devices that are connected to the lower-level PROFIBUS PA lines.

The PA devices connected to the PROFIBUS PA are assembled at a PROFIBUS address by DP/PA Link.

The DP/PA link can be connected directly to the PROFIBUS DP interface of programmable controllers (S7 400) for the coupling between PROFIBUS DP and PROFIBUS PA.

Versions

You can connect a PROFIBUS PA to the PROFIBUS DP. The following variants can be realized:

- Connection to a singular PROFIBUS DP
  - Connection via DP/PA Link (1 x interface module, 1 x DP/PA coupler)
  - Connection via DP/PA coupler (45.45 Kbps on PROFIBUS DP)
  - Connecting a redundant PROFIBUS PA:
    You can find additional information on this in the section "Fault-tolerant PROFIBUS PA (Page 68)".

- Connection to a redundant PROFIBUS DP
  - Connection of a singular PROFIBUS PA via DP/PA Link with redundant interconnection (2 x interface module and 1 x DP/PA coupler)
  - Connecting a redundant PROFIBUS PA:
    You can find additional information on this in the section "Fault-tolerant PROFIBUS PA (Page 68)".
Physical bus characteristics

- The application protocols for PROFIBUS DP and PROFIBUS PA are defined according to IEC 61158-2 and are identical for these two fieldbus variants.
  - You can set the transmission speed on the PROFIBUS DP. The maximum transmission speed with the Y-link is 12 Mbps.
  - The transmission speed on the PROFIBUS PA is 31.25 Kbps.
- If the DP/PA coupler is connected directly on PROFIBUS DP, the transfer rate is set to 45.45 Kbps. The DP/PA coupler can be operated with SIMATIC S7 automation systems and all DP masters that support the transmission rate of 45.45 Kbps.
- Depending on the power consumption of the PA devices, up to 31 PA devices can be connected to the PROFIBUS PA.

Use in hazardous areas

- The intrinsically safe PROFIBUS DP is specified for the type of protection EEx(ib).
- The following components can be used in operating environments of the Ex zone:
  - DP/PA link in Ex version, up to Ex Zone 2
  - DP/PA link or FDC 157-0 DP/PA coupler in a housing that meets at least degree of protection IP54; up to Ex Zone 2
  - DP/PA coupler Ex [i] cannot be used for redundant configuration (coupler redundancy, ring); up to Ex Zone 1
- If you use a SIMATIC AFDIS as a field barrier between the DP/PA link or DP/PA coupler and the field devices, you can connect the field devices in hazardous areas of Zone 0 or Zone 1. The outputs of the SIMATIC AFDIS fulfill the requirements for types of protection EEx(ia) and EEx(ib).
- The number of devices is limited by the current.

Additional information

- Section "Configuring DP/PA Link (Page 122)"
- Section "Fault-tolerant PROFIBUS PA (Page 68)"
- Section "How to configure the redundant PROFIBUS PA (Page 107)"
- Manual DP/PA Link and Y Link Bus Couplings

3.3.5.5 Fault-tolerant PROFIBUS PA

Functionality

PROFIBUS PA allows the connection of PA devices. A redundant PROFIBUS PA is connected to FDC 157-0 redundant DP/PA couplers. If the communication path of the PROFIBUS PA fails, the communication path is preserved as far as the spur line to the field devices.
Fault-tolerant communication solutions

The following communication solutions are offered to prevent a possible failure:

- Ring redundancy with the AFD (Active Field Distributor)
- Coupler redundancy with the AFS (Active Field Splitter)

The DP/PA coupler can be used stand-alone or in the DP/PA-Link.

---

**Note**

**Mixed configurations**

You can connect only one redundant DP/PA coupler pair per DP/PA-Link. In mixed configurations, you can operate up to 3 additional non-redundant DP/PA couplers. The coupler pair (FDC 157-0 DP/PA coupler) should be installed for redundant operation in the last two slots of the ET 200 station.

---

Connecting the fault-tolerant PROFIBUS PA to PROFIBUS DP

You can connect a fault-tolerant PROFIBUS PA to the PROFIBUS DP. The following variants can be realized:

- Connection to a redundant PROFIBUS DP
  - Connection of a fault-tolerant PROFIBUS PA via redundant DP/PA-Link (2 x interface module and 2 x DP/PA coupler)
- Connection to a singular PROFIBUS DP
  - Connection of a fault-tolerant PROFIBUS PA via DP/PA-Link with redundant coupler pair (1 x interface module and 2 x DP/PA coupler)
  - Connection of a fault-tolerant PROFIBUS PA with redundant FDC 157 coupler pair (2 x DP/PA coupler directly on the PROFIBUS DP)

We recommend the following configuration limits in PCS 7 when connecting PA devices using AFD or AFS:

- For the purpose of increasing availability when using ring redundancy (fault-tolerant connection), connect a maximum of 4 field devices (one field device per spur line) to an active field distributor AFD (maximum of 8 AFD to a redundant DP/PA coupler). You can connect a total of 31 field devices.
- Connect an active field splitter (AFS) to a redundant coupler in the case of coupler redundancy. Connect the field devices via AFD (max. 8 AFD). For the purpose of increasing availability, connect a maximum of 4 field devices per AFD.
- You can connect a maximum of 31 field devices per PROFIBUS PA.
- The maximum power consumption of 1 A must not be exceeded. This figure includes all components connected to the PROFIBUS PA.
Examples for connections of field devices via AFD and AFS are shown in the following figures.

Figure 3-1  Connection to a redundant PROFIBUS DP
Transmission rate

You have two interfacing options for the gateway between PROFIBUS DP and PROFIBUS PA. These result in different transmission rates on PROFIBUS DP.

- If you connect the DP/PA couplers via a DP/PA-Link, a transmission rate of up to 12 Mbps is possible on the PROFIBUS DP.
- If you connect the DP/PA couplers directly, the transmission rate on PROFIBUS DP is 45.45 Kbps.
- The transmission speed on the PROFIBUS PA is 31.25 Kbps.

Availability - redundant interfacing

In a redundant system, we recommend that you implement the connection to the PROFIBUS DP redundantly (redundant IM 153-2).

If a PA bus cable, an IM 153-2 or a DP/PA coupler fails, the communication connection to the field devices is retained. The AFD or AFS automatically switches the connection to the available signal path.
Additional information

- Section "Connection of PROFIBUS PA to PROFIBUS DP (Page 66)"
- Section "How to configure redundant PROFIBUS PA (Page 107)"
- Operating Instructions SIMATIC; DP/PA Coupler, DP/PA Link and Y Link Bus Couplers

3.3.5.6 Connecting the FOUNDATION Fieldbus to PROFIBUS DP

FF Link

FF Link enables connection between PROFIBUS DP and FOUNDATION Fieldbus. FF Link includes the following modules, which are interconnected via the backplane bus:

- Interface module IM 153-2 FF
- Coupler module FDC 157

Configuration
Functionality

FF Link connects PROFIBUS DP and FOUNDATION Fieldbus with one another and decouples various transmission rates. It is a slave on the PROFIBUS DP and master on the FOUNDATION Fieldbus. From the point of view of the automation system, the FF Link is a modular slave. The individual modules of this slave are the field devices that are connected to the lower-level FF segment.

The FF devices connected to the FF segment are assembled at one PROFIBUS address by the FF Link.

The FF Link can be connected directly to the PROFIBUS DP interface of data record gateway capable PLCs for the coupling between PROFIBUS DP and FOUNDATION Fieldbus.

Versions

You can connect one FF segment to the PROFIBUS DP for each FF Link. The following variants can be realized:

- Connection to a singular PROFIBUS DP
  - Connection via FF Link (1 x IM 153-2 FF, 1 x FDC 157)
  - Connection of a redundant FF segment:
    Additional information on this topic can be found in the "Configuring FF Link (Page 124)" section.

- Connection to a redundant PROFIBUS DP
  - Connection of a singular FOUNDATION Fieldbus via FF Link to a redundant interface (2 x IM 153-2 FF und 1 x FDC 157)
  - Connection of a redundant FF segment:
    For additional information, refer to the section titled "Fault-tolerant FOUNDATION Fieldbus (Page 74)".

Physical bus characteristics

- The application protocols for PROFIBUS DP and FOUNDATION Fieldbus are determined according to IEC 61158-2.
  - You can set the transmission speed on the PROFIBUS DP. The maximum transmission rate is 12 Mbps.
  - The transmission speed on the FOUNDATION Fieldbus is 31.25 Kbps. The transmission method is determined by IEC 61158-2.
- Depending on the power consumption of the FF devices, up to 31 FF devices can be connected to the FOUNDATION Fieldbus.

Use in hazardous areas

- The intrinsically safe PROFIBUS DP is specified for the type of protection EEx(ib).
- When the FF Link is built into an enclosure conforming to at least an IP 54 degree of protection, the FF Link can be installed in operating environments up to Ex Zone 2.
If you use a SIMATIC AFDiS as a field barrier between the FF Link and the field devices, you can connect the field devices in hazardous areas of zones 0 or 1. The outputs of the SIMATIC AFDiS fulfill the requirements for types of protection EEx(ia) and EEx(ib).

The number of devices is limited by the current.

Additional information

- Documentation SIMATIC; Process Control System PCS 7; PCS 7 Readme
- Documentation SIMATIC; PCS 7 process control system; PCS 7 in-Practice; FOUNDATION Fieldbus
- Operating instructions SIMATIC; Bus links; FF Link bus link

3.3.5.7 Fault-tolerant FOUNDATION Fieldbus

Functionality

PCS 7 enables the connection of field devices to the FOUNDATION Fieldbus H1 (referred to only as FOUNDATION Fieldbus or FF from this point). A fault-tolerant FOUNDATION Fieldbus is connected to the redundantly configured FF Link. If the transmission path fails, the communication path of the FOUNDATION Fieldbus is preserved as far as the spur line to the field devices.

Fault-tolerant communication solutions

The following communication solutions are offered to prevent a possible failure:

- Ring redundancy with the AFD (Active Field Distributor)
- Coupler redundancy with the AFS (Active Field Splitter)

Connection of the fault-tolerant FOUNDATION Fieldbus to PROFIBUS DP

You can connect a fault-tolerant FOUNDATION Fieldbus to the PROFIBUS DP. The following variants can be realized:

- Connection to a redundant PROFIBUS DP
  - Connecting a fault-tolerant FOUNDATION Fieldbus via redundant FF Link (2x IM 153-2 FF, 2 x FDC 157)
- Connection to a singular PROFIBUS DP
  - Connecting a fault-tolerant FOUNDATION Fieldbus via FF Link with redundant coupler pair (1x IM 153-2 FF, 2 x FDC 157)
  - Connecting a fault-tolerant FOUNDATION Fieldbus with redundant FDC 157 coupler pair (2 x FDC 157 directly on the PROFIBUS DP)

We recommend the following configuration limits in PCS 7 when connecting FF devices using AFD or AFS:
● You can connect one FF segment to the FF Link.

● For the purpose of increasing availability when using ring redundancy (fault-tolerant connection), connect a maximum of 4 field devices (one field device per spur line) to an active field distributor AFD (maximum of FDC 157 8 AFD to a redundant coupler).

● Connect an active field splitter (AFS) to a redundant coupler in the case of coupler redundancy. Connect the field devices via AFD (max. 8 AFD). For the purpose of increasing availability, connect a maximum of 4 field devices per AFD.

● You can connect a maximum of 31 field devices per FF segment.

● The maximum power consumption of 1 A must not be exceeded. This figure includes all components connected to the FF segment.

**Configuration**

Examples for connections of field devices via AFD and AFS are shown in the following figures.

Figure 3-3 Connection to a redundant PROFIBUS DP
3.3 Solutions for communication

Transmission rate

You have two interconnection options for the gateway between PROFIBUS DP and FOUNDATION Fieldbus. These result in different transmission rates on PROFIBUS DP.

- If you connect via an FF Link, a transmission rate of up to 12 Mbps is possible on PROFIBUS DP.
- If you connect the FDC 157 coupler directly, the transmission rate on PROFIBUS DP is 45.45 Kbps.
- The transmission speed on the FOUNDATION Fieldbus is 31.25 Kbps.

Availability - fault-tolerant interfacing

In a redundant system, we recommend that you implement the interface to PROFIBUS DP redundantly (redundant IM 153-2 FF).

If an FF line, (IM 153-2 FF) interface module or (FDC 157) coupler fails, the communication connection to the field devices is maintained. The AFD or AFS automatically switches the connection to the available signal path.
3.4 Solutions for integrating a PCS 7 plant in a domain

For additional information, please refer to the following documents:

- Function manual *Process Control System PCS 7; Time Synchronization*

3.5 Solutions for OS servers

**Redundant OS servers**

PCS 7 enables you to configure two OS servers redundantly for fault-tolerant operation. This ensures that you can monitor and control your process at all times. The solution represents the entry level into fault-tolerant process control systems.
**Configuration**

The figure below shows an example of a configuration with redundant OS server and redundant central archive server.

![Configuration Diagram]

**Functionality**

Redundant OS servers monitor each other in runtime. If one OS partner server fails, the event is detected in time.

If one of the two OS server fails, the OS partner server takes over the process. The interface between OS clients and the automation system remains available.

The OS clients are automatically switched to the redundant OS partner server. This means that the OS clients always remain available for the control and monitoring of the process. During the failure period, the redundant OS partner server continues to archive all messages and process data in the WinCC project. Once the failed OS server comes back online, the contents of all the message, process value and user archives are automatically copied to the returning OS server. This copy process is referred to as redundancy synchronization. Redundancy synchronization fills the gaps in the various archives that result from failures.

During the failure period, the internal master/standby identification changes from the failed OS server to its OS partner server. The master identification remains with the OS partner server even when the failed OS server comes back online.

**Configuring the archives**

Tag logging and alarm logging have to be configured functionally identical for redundant OS servers. Functionally identical configuration means the same archives, whereby extensions in the form of additional measuring points and archives are permitted.

OS partner servers (OS_Stby) are configured in the SIMATIC Manager. Using the menu command **PLC > Download** synchronizes the functionality.

**Redundant external archive server**

If an external archive server of a server pair fails, the data is automatically synchronized on the return of the failed external archive server.

PCS 7 provides the following options for centralized collection of archive information for the process control system:
- Process Historian
  You can set up two Process Historians with redundancy functionality for fault-tolerant operation. The associated information server can be configured in such a way that it connects to the active Process Historian to execute tasks.

- Central archive server
  You can set up two central archive servers with redundancy functionality for fault-tolerant operation.
  This server does not require a connection to the plant bus.

Redundant maintenance station

PCS 7 allows you to configure two maintenance servers with redundancy functionality for fault-tolerant operation.

Setting up a redundant OS server

The following configuration shows the basic operating principle of redundant OS servers.

Note

You need to connect the redundant PC stations through a redundancy connection. This connection offers security against problematic behavior during communication between the OS servers.
Redundancy connection

You need the following components to make the redundancy connection, depending on the distance to be bridged:

<table>
<thead>
<tr>
<th>Maximum distance</th>
<th>Required components</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 m</td>
<td>Null modem cable</td>
<td>Serial connection</td>
</tr>
</tbody>
</table>
| 100 m            | ● Crossover network cable  
                  | ● Per server: A free network connection (see section "Network components (Page 41)") | Ethernet connection |
| 1000 m           | Fiber-optic cable  
                  | Per server: 
                  | ● A free network connection (see section "Network components (Page 41)")  
                  | ● 1 Ethernet cable  
                  | ● 1 media converter (e.g., SCALANCE X101-1) | Ethernet connection |

Availability

The availability of the complete system is ensured even if one of the two OS servers fails because the two OS servers form an independent redundancy node.

Note

The buses marked with * (terminal bus and plant bus) can be configured redundantly with optical or electronic switch modules.

Delaying the transfer of archives

If a redundant partner is not available or is deactivated, the transfer of the archives of the redundant partner will be delayed. The transfer of archives is started or continued only when the partner becomes available again and synchronization of the archives is completed.

Since the storage capacity of the ring buffer for Tag Logging and Alarm Logging is limited, there is a risk of data loss if the redundant partner is out of action for a longer period of time.

Additional information

- Section "Network components (Page 41)"
- Section "How to configure an OS server and its redundant OS partner server (Page 127)"
3.6 Solutions for OS clients

3.6.1 Additional OS clients

Additional OS clients

OS clients are PC stations that are used for control and monitoring of an automation process. They are connected to the OS servers through the terminal bus. The OS servers form the process connection to the automation system.

An OS client has its own WinCC project and visualizes the process data generated on an OS server.

If an OS client fails, this does not disrupt the overall process because the automation program in the CPU continues to control the process and the OS servers continue to process and archive the process data. However, the visualization of the process is lost and you can only influence the process through the OS servers. You should therefore protect against such failure by integrating additional OS clients.

By specifying a preferred server, you can distribute multiple OS clients between the redundant OS servers. The automation process can therefore be operated continuously, even during a failover from the active OS to its OS partner server.

Additional information

- Section "How to configure an OS client (Page 144)"
- Online help for WinCC

3.6.2 Permanent operability

Permanent operability

"Permanent operability" in a redundant environment is the unrestricted ability to influence the system at any time even when confronted with the failure of one of the redundant OS servers. It is the most important safety characteristic for plants with critical operations.

This function is important in all systems in which the ability to handle failure of an OS server in a redundant configuration is not enough and in which continuous control of a process must be maintained. In the event of an OS server failure, all OS clients connected to the failed server will temporarily lose their connection to the process while they switch over. In order to ensure...
that the OS clients can control and monitor the automation process continuously, the OS clients are distributed between the redundant OS servers with specification of a preferred OS server. The failure of some OS clients can therefore be tolerated because the other clients remain connected to the process.

Preferred server

A "preferred server" is an OS server in the redundant OS server pair that the OS client connects to preferentially. A preferred server can be defined separately for each OS client in order to ensure permanent operability. The distribution of the OS clients between the OS servers distributes the loads and increases the performance of the system as a whole.

Operating principle

If the active OS server fails, the process values on all of the connected OS clients are no longer updated and there is no operator control on these OS clients during the failover. Other OS clients that are connected in parallel to the redundant OS partner server are not affected by this. The plant operator can therefore change to these OS clients if needed.

Generally, the following applies: The OS clients always connect to the specified preferred server if it is available. If it is not available, the OS clients automatically connect to its redundant OS partner server. If you do not specify a preferred server for an OS client, it will connect to the OS server that has the master identification.

When the failed OS server comes online again, the OS client automatically reconnects to its preferred server. The master identification of the OS server does not change even when the failed OS server comes back online.

Additional information

- Section "How to configure an OS client for permanent operability (Page 145)"
- Online help for WinCC

3.7 Solutions for SIMATIC BATCH

Redundant BATCH servers

SIMATIC BATCH enables you to configure two BATCH servers redundantly for fault-tolerant operation. This ensures that you can monitor and control your batch process at all times.

Functionality

Redundant BATCH servers monitor each other in runtime to detect the failure of a BATCH server as early as possible.

If one of the two BATCH servers fails, the process can be controlled over the second BATCH server after the failover.
- The interface for message processing between the active BATCH server and the OS server remains available.
- The BATCH clients automatically fail over to the functioning (active) BATCH server. After the failover, it is possible to control and monitor the process from all BATCH clients.

In SIMATIC BATCH, the consistency of the databases is achieved by data replication. In this solution, each of the BATCH servers of a server pair has its own database in which the batch data stored. The two databases are continuously synchronized.

### Setting up a redundant BATCH server

The following configuration shows the basic operating principle of redundant BATCH servers. The BATCH servers are also connected to the plant bus if SIMATIC BATCH is operated "AS-based".

![Diagram of redundant BATCH server pair]

### Redundancy connection

You need the following components to make the redundancy connection, depending on the distance to be bridged:

<table>
<thead>
<tr>
<th>Maximum distance</th>
<th>Required components</th>
<th>Connection</th>
</tr>
</thead>
</table>
| 100 m            | Crossover network cable  
Per server: A free network connection (see section "Network components (Page 41)"
| Ethernet connection|
| 1000 m           | Fiber-optic cable  
Per server:  
A free network connection (see section "Network components (Page 41)"
1 Ethernet cable  
1 media converter (e.g., SCALANCE X101-1)
| Ethernet connection|
Note
When a redundant server pair is used as an OS server and BATCH server, the redundancy connection must be configured via the Ethernet connection.
Serial linking of the BATCH server pair is not possible in PCS 7.

Availability
The following two block diagrams of fully operational systems illustrates the availability of the BATCH clients and BATCH servers. All BATCH components form an independent redundancy node since they are redundant. This ensures the independence of the subsystem.

Note
Only the BATCH components and the terminal bus are shown in the block diagrams. The terminal bus marked with * can be configured redundantly with switch modules.

The communication between BATCH clients and BATCH servers is performed over the terminal bus.
The BATCH servers also communicate with OS servers over the terminal bus. The OS servers are connected to the automation system over the plant bus.

**Note**

SIMATIC BATCH in "AS-based" operating mode

The BATCH servers are also connected to the plant bus if SIMATIC BATCH is operated "AS-based". The redundant interface is implemented as on OS servers. You will find additional information on this topic in section "Solutions for OS servers (Page 77)".

**Additional information**

- PC station identified as faulty; see section "Solutions for OS servers (Page 77)"
- Section "How to configure a BATCH server and its redundant BATCH partner server (Page 150)"
- Section "How to configure a BATCH client (Page 152)"
- Manual and online help for SIMATIC BATCH

### 3.8 Solutions for Route Control server

**Redundant Route Control servers**

SIMATIC Route Control allows you to implement two Route Control servers with redundancy functionality for fault-tolerant operation. This ensures that you can monitor and control your route control at all times.

**Functionality**

The Route Control software automatically takes over the monitoring of the redundancy. The redundant Route Control servers monitor each other in runtime.

If the active Route Control servers fails, the process can be controlled via the second Route Control server following failover.

The Route Control clients automatically fail over to the functioning (active) Route Control server.

When the failed Route Control server resumes normal service, it retrieves the current process image from the automation system.

During the failure, the functioning Route Control server automatically receives the internal Master ID. If the active master server failed, the master ID is passed from the failed Route Control server to its Route Control partner server.

When the failed Route Control server becomes available again, it is given the standby ID. The master ID remains with the Route Control partner server.
Configuration of a redundant Route Control server

The following configuration shows the basic operating principle of redundant Route Control servers.

Redundancy connection

You need the following components to make the redundancy connection, depending on the distance to be bridged:

<table>
<thead>
<tr>
<th>Maximum distance</th>
<th>Required components</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 m</td>
<td>Null modem cable</td>
<td>Serial connection</td>
</tr>
<tr>
<td>100 m</td>
<td>• Crossover network cable</td>
<td>Ethernet connection</td>
</tr>
</tbody>
</table>
|                  | • Per server: A free network connection (see section "Network components (Page 41)"
| 1000 m           | Fiber-optic cable                                                                    | Ethernet connection|
|                  | Per server:                                                                         |                  |
|                  | • A free network connection (see section "Network components (Page 41)"
|                  | • 1 Ethernet cable                                                                  |                  |
|                  | • 1 media converter (e.g., SCALANCE X101-1)                                          |                  |

Availability

The availability of the complete system is also ensured even if one of the two Route Control servers fails because the two Route Control servers form an independent redundancy node.
Note
The buses marked with * (terminal bus and plant bus) can be configured redundantly with optical or electronic switch modules.

Additional information
- PC station identified as faulty; see section "Solutions for OS servers (Page 77)"
- Section "How to configure a Route Control server and its redundant Route Control partner server (Page 157)"
- Manual Process Control System PCS 7; SIMATIC Route Control

3.9 Solutions for engineering station

Engineering station
The engineering station (ES) serves as a central configuration station.
There are no redundant engineering stations in PCS 7.
The ES is generally used to make changes in the configuration data of project components such as AS, OS and BATCH and to then download the changes to the target systems. This makes PCS 7 configuration centralized and transparent.

Configuration
In order to use an ES as an OS client, you need to configure a PC station in the PCS 7 project for the ES. This PC station is configured and downloaded the same way as an operator station with regard to hardware (Station Configuration Editor), networks and connections (NetPro).
The ES is displayed in NetPro.
If you specify permanently configured connections under "Named Connections", the following rules apply:
- When configuring the connections for the ES, you must configure a connection for every AS. This will ensure that a connection can be established to every AS regardless of which WinCC project is loaded.
- For connections from the individual PC stations (OS servers and ES) to the automation systems, the following rules apply:
  - All connections within an AS must have the same name.
  - Two connections must be configured for each OS server and the ES: one in AS 1 and one in AS 2.
  - The connections to AS 1 and the connections to AS 2 must always have the same name.
3.10 Time synchronization

Introduction

Time synchronization in a PCS 7 plant is of utmost importance for synchronizing, tracing, documenting and archiving all time-critical processes. Time synchronization is particularly important for the redundancy functions in PCS 7 such as the redundancy synchronization between OS servers or BATCH servers.

Time synchronization is active after one component has assumed the time master function in a PCS 7 system. All other time-dependent components receive the time from this time master.

Planning and setting up time synchronization in PCS 7

The information necessary for planning and setting up time synchronization within a Windows network is available in the following documentation:

Function Manual Process Control System PCS 7; PCS 7 Time Synchronization

Setting the time synchronization of SIMATIC H stations

When a SIMATIC H station is connected to the redundant fault-tolerant plant bus each with two CP443-1 per CPU, the settings for time synchronization should be made according to the table below.

Set the time synchronization of CP 443-1 by selecting the "Time synchronization" tab in the object properties dialog of the CP.

<table>
<thead>
<tr>
<th>Bus</th>
<th>CPU 1/rack 1</th>
<th>CPU 2/rack 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant bus1</td>
<td>CP 1/1</td>
<td>Time synchronization enabled</td>
</tr>
<tr>
<td>Plant bus2</td>
<td>CP 1/2</td>
<td>Time synchronization disabled</td>
</tr>
</tbody>
</table>
Advantages of fault-tolerant components

4.1 Creating and expanding a project with pre-configured stations

PCS 7 wizards "New Project" and "Extend Project"

You can create fault-tolerant stations for the AS and PC stations using the PCS 7 "New Project" and "Expand Project" wizards in the SIMATIC Manager. For redundant PC stations, you configure a redundant multiple station system using the PCS 7 wizard.

- **PCS 7 "New Project" Wizard**
  Use the PCS 7 "New Project" wizard to create a new PCS 7 project as a multiproject. You are guided through the individual configuration steps of the PCS 7 wizard. While working through the wizard, you specify the CPU, select the number of levels in the plant hierarchy and the AS objects to be created (CFC/SFC charts) and OS objects (PCS 7 OS, SIMATIC BATCH, SIMATIC Route Control). Technological names such as plant, unit and function are specified and you can adapt these later to the requirements of your plant.

- **PCS 7-'Expand Project' wizard (pre-configured stations)**
  Using this wizard, you can expand a project with pre-configured stations, such as an AS or a PC station for OS, BATCH or Route Control. The AS is set up using the configuration bundles which you can find in the PCS 7 catalog and know from the PCS 7 "New Project" wizard. If you use such bundles in your plant, all required objects are created when you insert pre-configured stations.

Additional information

- Configuration manual Process Control System PCS 7; Engineering System

4.2 SIMATIC H Station

4.2.1 Overview of configuration tasks

Overview of configuration tasks

You configure the redundancy functionality of the SIMATIC fault-tolerant station (H station) by performing the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Inserting a SIMATIC H station in a project (Page 90)</td>
</tr>
<tr>
<td>2</td>
<td>Inserting synchronization modules in the H_CPU (Page 91)</td>
</tr>
</tbody>
</table>
### 4.2 SIMATIC H Station

#### 4.2.2 How to add a SIMATIC H station to your project

**Introduction**

The SIMATIC H station is contained in the hardware catalog of HW Config as a stand-alone station type. This station type is required if you want to configure two central racks each with an H CPU, thereby configuring your process control system with redundancy.

**Procedure**

1. Open your PCS 7 project in the component view of SIMATIC Manager.
2. Select the menu command `View > Component View`.
3. Select the project.
4. Select the menu command `Insert > Station > SIMATIC H Station`.

**Result**

The configuration in the SIMATIC Manager appears as follows:

![Configuration in SIMATIC Manager](image)
Additional information

- Manual *Automation System S7-400H; Fault-tolerant Systems*

4.2.3 How to insert synchronization modules into the H CPU

Requirements

- The PCS 7 project is open in SIMATIC Manager.
- HW Config is open.
- The rack has been inserted according to the configuration in HW Config.
- Each rack has been fitted with an H CPU in HW Config.

Procedure

1. In HW Config, select the menu command **View > Catalog**.
2. In the hardware catalog, double-click the H CPU you are using. Within the active tree view, double-click on the version of the H CPU you have selected. The H sync module is located below the version folder, e.g., V4.0.
3. Select the H Sync Module and drag it onto slots "IF1" and "IF2" of each H CPU.
The following figure shows an example of the configured subsystems of the fault-tolerant station in HW Config:

Additional information

- Documentation Process Control System PCS 7; PCS 7 - Released Modules
- Manual Automation System S7-400H; Fault-tolerant Systems
4.2.4 How to configure redundant communication processors

Introduction
Configure at least one CP 443-1 for each H CPU on a plant bus. You can also make a redundant interconnection.

Requirements
- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- HW Config is open.
- The racks for the SIMATIC H station are inserted in HW Config, for example, 2 UR2-H racks.
- In HW Config, each rack has been fitted with an H CPU and the required synchronization modules.

Procedure
1. In the hardware catalog, double-click the "SIMATIC 400" folder. Then double-click the "CP-400" folder and finally the "Industrial Ethernet" folder.
2. Select the CP you are using and drag it to a free slot on the rack.

Note
Using a communication processor that supports multiple communication protocols
Configure the ISO interface for the "Fault-tolerant S7 connection" in the "Parameters" tab of the "Properties - Ethernet Interface CP 443-1" dialog box.
Advantages of fault-tolerant components

4.2 SIMATIC H Station

Result

The following figure shows an example of configuration in HW Config. Connection to a fault-tolerant plant bus is possible.
4.2.5 How to set the failure reaction of the input/output modules on the CPU

Introduction

Only perform the following procedure when the libraries "Redundant IO (V3.0)" or "Redundant IO (V4.0)" are used.

As of PCS 7 V7.1, the characteristics of the redundant input/output modules are set for channel-based reaction to channel faults. The function in the AS depends on the employed PCS 7 library and the modules.

Depending on the configured module, the code is automatically generated for the automation system based on the optimal capabilities of the module.

Passivation reaction of the modules

You will find information on which modules are released for which passivation reaction in the documentation *PCS 7 - Released Modules*.

<table>
<thead>
<tr>
<th>Passivation reaction</th>
<th>Reaction of the module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module-based</td>
<td>The module is passivated if a fault occurs.</td>
</tr>
<tr>
<td>Group-based</td>
<td>If a fault occurs in a channel, the group of channels is passivated in a module in which a least one fault has occurred.</td>
</tr>
<tr>
<td>Channel-based</td>
<td>Only the channels on which the fault occurred are passivated.</td>
</tr>
</tbody>
</table>

Requirements

- The PCS 7 project is open in SIMATIC Manager.
- An H-CPU is configured in HW Config.
- S7 driver blocks from the "Redundant IO (V3.0)" or "Redundant IO (V4.0)" library

Procedure

1. In the component view, select the SIMATIC H station.
2. Double-click the "Hardware" object in the detail window. HW Config opens.
3. Select the CPU you are using on slot 3.
4. Select the menu command **Edit > Object Properties**. The "Properties - CPU ..." dialog box opens.
5. Select the "H Parameters" tab.
6. Please make a note of which data blocks in the "Data block no." input box are defined as standard transmitters so that you do not use them in your configuration.

7. Select the required setting for the passivation behavior from the "Passivation behavior" list in the "Redundant I/O" area.
   - Module-based when the "Redundant IO (V3.0)" library is used
   - Channel-based when the "Redundant IO (V4.0)" library is used

Additional information

- Function manual *Process Control System PCS 7; software update without utilization of new functions*
- Documentation *Process Control System PCS 7; PCS 7 - Released Modules*

---

### 4.3 Communication connections

#### 4.3.1 Overview of configuration tasks

**Introduction**

After you have inserted all of the components (AS, OS and ES) in your project, you can use NetPro to configure the network connections between the SIMATIC components. When the configuration of the connections and network is complete, the configuration needs to be compiled, saved and downloaded to the CPU of the automation system.

**Downloading connection configurations**

Connection configurations can be downloaded to the CPU in RUN mode. To do this, select the connection to be downloaded in NetPro and transfer it to the CPU by selecting the menu command **Target systems > Download > Selected Connections**. Process interfacing for operation stations is not possible until the connections are made known to the AS.

You need to change the MAC addresses after failure of network adapters. You adapt the addresses in the properties dialog box of the individual operator stations in NetPro. The configuration has to be compiled and downloaded in NetPro each time it is changed.

**Overview**

This section describes the configuration steps for the following topics:

- Configuring a redundant, fault-tolerant terminal bus (Page 97)
- Configuring a fault-tolerant plant bus (Page 100)
- Configuring a redundant PROFIBUS DP (Page 102)
- Configuring a redundant PROFIBUS PA (Page 107)
4.3.2 Configuring the connection to the terminal bus

4.3.2.1 How to configure the redundant terminal bus on the basis of the Parallel Redundancy Protocol

Introduction
The NetPro and HW Config programs do not support configuration of the terminal bus. The "SIMATIC NET SOFTNET-IE RNA" software is used in PCS 7 for the connection of a PC station to separate redundant networks.

Conditions and rights required
You require the following to be able to install and operate SOFTNET-IE RNA on your PC:
- 2 free Ethernet network adapters
- 2 separate Ethernet networks
- Administrator rights for installation
- Exactly one software license for SOFTNET-IE RNA per PC.

Installation and configuration
Information about the installation process can be found in the SIMATIC NET; PG/PC - Industrial Ethernet; SOFTNET-IE RNA operating instructions.

Additional information
- Readme file for the "SIMATIC NET SOFTNET-IE RNA" software
- You can find additional information on the individual SIMATIC NET products and their configuration on the Internet (http://www.siemens.com/automation/service&support).

4.3.2.2 How to configure the redundant terminal bus on the basis of the INTEL TEAM mode

Introduction
The NetPro and HW Config programs do not support configuration of the terminal bus. The PC stations are connected to the redundant terminal bus over network adapters capable of redundancy.

The section below describes how you install and configure the drivers for network adapters of these PC stations.
Requirements

Each PC station (for example, OS server, OS client, domain controller) connected to the terminal bus as a redundant component has to meet the following requirements:

- Redundant connection of the PC station to the terminal bus:
  Two network adapters working in INTEL Team mode on a PC.

- The driver for the network adapters required for the operating system (32/64 bit) must be installed. You can find the driver on the "Software_Support_and_Tools" DVD in the folder Drivers > Network > INTEL.

Network adapters for the redundant terminal bus

<table>
<thead>
<tr>
<th>PC type</th>
<th>Network adapter 1</th>
<th>Network adapter 2</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIMATIC IPC</td>
<td>Onboard (LM-Adapter)</td>
<td>Onboard (L-Adapter)</td>
<td>Only on Windows 7/Server 2008 R2</td>
</tr>
<tr>
<td>• SIMATIC IPC 547D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• SIMATIC IPC 647C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• SIMATIC IPC 847C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SIMATIC IPC 427C (Microbox)</td>
<td>Onboard (LM-Adapter)</td>
<td>Onboard (L-Adapter)</td>
<td>Only for PCS 7 OS Client</td>
</tr>
<tr>
<td>Suitable PC</td>
<td>Intel PRO/1000 PT Server-Adapter (EXP19400PT)</td>
<td>Intel Gigabit CT Desktop-Adapter (EXP19301CT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel PRO/1000 PT Server-Adapter (EXP19400PT)</td>
<td>Intel PRO/1000 PT Desktop-Adapter (EXP19300PT)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel PRO/1000 MT Server-Adapter</td>
<td>Intel PRO/1000 GT Desktop-Adapter</td>
<td>Only on Windows XP/Server 2003</td>
</tr>
</tbody>
</table>

Procedure – installing and configuring drivers

1. Unzip the compressed driver file (Zip).

2. Install the device driver using the autostart file with standard settings.

3. Open the Device Manager > Network adapters.

4. If no onboard network adapters are being used for connecting to the terminal bus, select the internal network adapter of the PC station and deactivate the internal network adapter via the shortcut menu.

5. Select the adapter "Network Adapter 1" (see table; INTEL server adapter or LM adapter for the INTEL onboard network adapters) and select the menu command Settings from the shortcut menu.

6. In the "Teaming" tab, select the "Team this adapter with other Adapters" check box. Click "New Team". The "New Team Wizard" dialog box opens.

7. Enter a name for the team (for example, "TerminalBusTeam #0"). Click "Next".
8. In the "Select the adapters to include in this team" list, select the network adapters through which the computer should be connected to the redundant terminal bus.
   - "Network adapter 1" (see table)
   - "Network adapter 2" (see table; INTEL Desktop Adapter or L adapter for the INTEL onboard network adapters)

9. Click "Next".

10. In the "Select a team type" list, select "SFT (Switch fault tolerance)". Click "Next".

11. Click "Finish".

   The "New Team Wizard" dialog box closes.

   The team ("TerminalBusTeam #0" in the example) is entered in the "Settings" dialog box of the network adapter.

12. The "Properties of team: <team name>" dialog box opens ("TerminalBusTeam #0" in the example).

13. Select the "Settings" tab and click "Modify Team...".

14. In the "Adapters" tab, select network adapter 1 on the preferred terminal bus.

   Click "Set Primary".

15. Select the "network adapter 2" on the redundant terminal bus. Click "Set Secondary".

16. Click "OK" to confirm the Team dialog boxes.

17. The Team dialog boxes close.

   The two network adapters are entered as a team in the Device Manager (Example: Team: Intel (R) Pro/1000 ...).

18. Open the dialog window "Network connections" ("Change adapter settings") via the control panel.

19. If the entry "File" is missing in the menu bar, select the menu command Organize > Layout > Menu bar.

20. Activate the detailed view of the list.

   Recommendation: Allocate names to the network adapters (File > Rename)
   Example:
   - 1. <Team name> <Team> ("TerminalBusTeam #0" in the example)
   - 2. <Team name> <Master> ("TerminalBusTeam #0 (Master)" in the example)
   - 3. <Team name> <Standby> ("TerminalBusTeam #0 (Standby)" in the example)

21. Check the order of network adapters under "Advanced> "Advanced Settings ...". In the "Adapters and Connections" tab, the team must be at the top of the list under "Connections":
   - 1. <Team name>" (in the example, "TerminalBusTeam #0")
   - 2. <Team name> <Master ... Adapter> (INTEL server adapter or LM adapter for INTEL onboard network adapters)
   - 3. <Teamname> <Standby ... Adapter> (INTEL desktop adapter or L adapter for INTEL onboard network adapters)

22. Click "OK" to close the dialog box.
4.3.2.3 How to connect singular components to the redundant terminal bus on the basis of the Parallel Redundancy Protocol

Introduction

You can connect the following non-redundant objects to a redundant network with the SCALANCE X204RNA:
- Non-redundant networks
- Components that have just one network connection, for example

You will find additional information on this topic in section "Redundant, fault-tolerant terminal bus based on the Parallel Redundancy Protocol (PRP) (Page 50)".

Procedure

1. Connect the networks for the redundant terminal bus (referred to as LAN A and LAN B below) to the following ports of the SCALANCE X204RNA:
   - PRP A (LAN A)
   - PRP B (LAN B)
2. Connect the non-redundant objects to the following ports:
   - P1
   - P2
3. Configure the SCALANCE X204RNA.

Messages

- SCALANCE X204RNA has signaling contacts.

Additional information about configuration

- Operating instructions SIMATIC NET; SCALANCE X204RNA, SCALANCE X204RNA EEC

4.3.3 How to configure a fault-tolerant plant bus

Introduction

You configure the communication connections for the plant bus with NetPro. Industrial Ethernet is used for the plant bus.

Fault-tolerant plant bus

You can set up a fault-tolerant plant bus with a ring structure.
The components of the process control system are connected to the plant bus using switch modules.

The degree of availability you require determines whether or not you should use additional CPs in the OS servers and in each subsystem of the automation system.

This section describes the procedure for a fault-tolerant plant bus (ring) with switch modules without additional CPs.

Additional information is available in the section "Fault-tolerant plant bus (Page 57)".

**Redundant, fault-tolerant plant bus**

To configure a redundant, fault-tolerant plant bus, two CPs each have to be physically present in the OS servers that will be connected redundantly and in each H subsystem and they must be configured in NetPro. Two networks must also be configured in NetPro.

The procedure is identical to the procedure for the fault-tolerant plant bus. This procedure must be performed for one CP per bus and subsystem (H system or PC station on the plant bus).

Additional information is available in the section "Redundant, fault-tolerant plant bus (Page 59)".

**Requirements**

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- In HW Config, one 443-1 type CP has been configured in each H subsystem.
- Two SIMATIC PC stations each with one CP 1613 have been configured in HW Config.

**Procedure**

1. Open NetPro in SIMATIC Manager with the menu command **Options > Configure Network**.
2. Select the menu command **Insert > Network Objects** to open the hardware catalog.
3. In the hardware catalog, click the plus sign to open the submenu containing the subnets.
4. Double-click the "Industrial Ethernet" subnet to insert it into the network view.

**Note**

To drag subnets into the NetPro project window, click the network, hold down the left mouse button and drag it to the desired location. If you cannot place the object where you want it, you may need to move other objects to make the necessary space.

5. In the left subsystem of the SIMATIC H station, select the interface icon for the CP 443-1 and drag a connection to the Industrial Ethernet subnets. Repeat the procedure for the CP of the right subsystem.
6. Follow the same procedure for the CPs in both OS servers.
7. Save your configuration.
Advantages of fault-tolerant components

4.3 Communication connections

Result

The following figure shows the resulting configuration:

![Diagram of resulting configuration]

Additional information

- Online help for *STEP 7*

4.3.4 How to configure a redundant PROFIBUS DP

Introduction

The following section describes how to create and connect a redundant PROFIBUS DP.

Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- HW Config is open.
• The UR2-H rack has been inserted twice in HW Config.
• In HW Config, each mounting rack has been fitted with an H CPU in slot 3 and the required synchronization modules.

Procedure

Note
Steps 1 through 4 are necessary only when a CP 443-5 Extended is used for the connection to the redundant PROFIBUS.

1. In HW Config, select the menu command Insert > Hardware Components.
2. In the hardware catalog, double-click the "SIMATIC 400" folder. Then double-click the "CP-400" folder and finally the "PROFIBUS" folder.
3. Select the version of the CP 443-5 Extended you are using and drag it to a free slot on the module rack. The "Properties - PROFIBUS Interface CP 443-5 Ext ..." dialog box opens.
4. Click "OK".
5. Select the slot on the rack for which you want to specify a redundant PROFIBUS DP interface:
   – Slot X2 to use the PROFIBUS DP interfaces of the CPU
   – Slot of the CP 443-5 Extended to use the PROFIBUS DP interfaces of the CP 443-5 Extended

Note
When inserting the DP master system for the redundant PROFIBUS DP interface, the entry "Redundant subnet ..." is displayed below the "Subnet" list.

7. Click "New". The "New Subnet" dialog box opens.
8. Make any necessary system-specific settings in the "New Subnet ..." dialog box (for example, bus name, transmission rates, etc.).
9. Click "OK". The new DP master system is entered in the "Subnet" list.
10. Click "OK".
11. Repeat steps 1 to 10 for the redundant rack.
Advantages of fault-tolerant components

4.3 Communication connections

Result

The figure below shows the result of the configuration process in HW Config. Here, a distributed I/O has already been assigned to the DP master systems for the purpose of illustrating the redundancy principle:
Additional information

- Online help on *STEP 7*

### 4.3.5 How to configure a fault-tolerant fieldbus on the basis of PROFINET

**Introduction**

The following section describes how to create and connect a fault-tolerant fieldbus on the basis of PROFINET.

- Configure the components in the HW config.
- In the Topology Editor, configure the connections between the components in accordance with the cable sequence in the system.

**Requirements**

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- HW Config is open.
- The redundant backplane is inserted in HW Config.
- In HW Config, each rack has been fitted with an 4xx-xH PN/DP H CPU and the required synchronization modules.
- The PROFINET IO systems are added to the H-CPU. This can be done using Insert on the H-CPU.

**Configure in HW Config**

1. In the hardware catalog, open the PROFINET IO > I/O > ET 200M folder.
2. Select the version of the interface module (IM 153-4 ...) you are using and drag this to the PROFINET IO system.
4.3 Communication connections

Result

The figure below illustrates the result of the configuration in HW Config. The distributed I/O is connected to the PROFINET IO system. The physical setup is subsequently configured with the Topology Editor.

Connect the components with the Topology Editor

1. Select the PROFINET IO System of the first CPU of this automation system.

2. Select the menu command Edit > PROFINET IO > Topology. The "Topology Editor" dialog box opens.
3. Select the "Graphic View" tab.
   **Note:**
   You can move the objects displayed. You can select the section displayed via the thumbnail view. Position the objects in accordance with the cable sequence in the system.

4. Using drag-and-drop, connect the connections of the CPU and the interface modules (green rectangle) in accordance with the cable sequence in the system. You can make additional system-specific settings in the "Table View" tab. For additional information, refer to the Online Help of the dialog box.

**Additional information**

- Online help on **STEP 7**

### 4.3.6 How to configure the redundant PROFIBUS PA

**Introduction**

The following is a description of how to configure a redundant PROFIBUS PA that is connected to a redundant PROFIBUS DP.

You can find configuration variants in the section "Fault-tolerant PROFIBUS PA (Page 68)".
Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- Two DP master systems are configured for the SIMATIC H station in HW Config and these are used as connection paths for the redundant interface.
- For commissioning: The PROFINET addresses are set with the DIL switches on the FDC 157-0 DP/PA couplers.
- You can install a maximum of 5 FDC 157-0 DP/PA couplers, one coupler pair of which is used at the end of the configuration in redundant mode.

Hardware setting on the DP/PA coupler

**Note**

The redundancy mode set on the DP/PA coupler (DIL switch bit 7) must match the configured redundancy mode:

- OFF: coupler redundancy (default setting)
- ON: ring redundancy (line redundancy)

If there is a discrepancy between the set redundancy mode and the configured redundancy mode, a diagnostic message is generated.

Procedure

1. In the component view, select the SIMATIC H station and double-click the “Hardware” object in the detail window.
   HW Config opens.
2. If the hardware catalog is not visible, select the menu command **View > Catalog**.
   The hardware catalog opens.
3. In the current PCS 7 profile, double-click "PROFINET DP" and then "DP/PA Link".
4. Select the FDC 157-0 DP/PA coupler and drag it onto one of the two PROFIBUS DP lines.
5. Select shortcut menu command **Object Properties**.
   The "Properties - DP Slave" dialog box opens.
6. Click "PROFINET".
7. Enter the PROFIBUS address (PROFINET DP) in the "Properties - PROFIBUS Interface FDC 157-0" dialog box and click "OK".
   The "Properties - PROFINET" dialog box opens.
8. Open the "Network Settings" tab.
9. Select the "User-defined" item in the "Profile" list.
10. Click "Bus parameters...".
11. Ensure the value 3 is set for the "Retry Limit" parameter.
12. Click "OK" in the dialog boxes that were opened for this procedure.
13. Repeat steps 1 to 13 for the second DP/PA coupler for coupler redundancy.
Result

The following figure shows the resulting configuration in HW Config:

Additional information

- Manual SIMATIC DP/PA Link and Y Link Bus Couplings

4.4 Distributed I/O

4.4.1 Overview of configuration tasks

Introduction

The following sections describe configuring redundancy of the individual components of the distributed I/O.

Overview

This section describes the configuration steps for the following topics:

- Configuring the redundant interface for the I/O device (Page 110)
- Configuring redundant input/output modules (Page 112)
- Configuring the DP/PA Link (Page 122)
- Configuring the Y Link (Page 119)
- Configuration of redundant signals (Page 126)
4.4.2 How to configure the redundant interface for the I/O device

Introduction

Once you have integrated the interface module (IM 153-2 for ET 200M, IM 152-1 for ET 200iSP) as hardware in the distributed I/O device, the component is made known to the system in SIMATIC Manager with HW Config or NetPro.

Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- A redundant DP master system is configured for the SIMATIC H station in HW Config.

Procedure

1. In the component view, select the SIMATIC H station and double-click the "Hardware" object in the detail window. HW Config opens.
2. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.
3. Double-click on "PROFIBUS DP" in the current PCS 7 profile.
4. Double-click the I/O device you want to connect:
   - ET 200M
   - ET 200iSP
5. Select the interface module:
   - For ET 200M: IM 153-2 in the hardware catalog.
   - For ET 200iSP: IM 152-1 whose hardware catalog description is "..., can be used redundantly in the H system".
6. Drag the interface module to one of the two PROFIBUS DP lines. The connection to the redundant line is established automatically.
7. Enter the PROFIBUS address in the "Properties - PROFIBUS Interface IM..." dialog box and click "OK".
Result

The following figure shows an example configuration in HW Config:

![HW Config configuration example]

Additional information

- Function manual *Process Control System PCS 7; High-Precision Time Stamping*
- Manual *DP/PA Link and Y Link Bus Couplings*
4.4.3 How to configure redundant I/O modules

Introduction

You configure the redundant I/O modules using HW Config.

Note

Redundant operation is possible only with certain S7-300 I/O modules of the ET 200M. For additional information, please refer to the following documents:

- Documentation PCS 7 - Released Modules
- Manual Automation System S7-400H; Fault-tolerant Systems

Note

Only I/O modules with the same order number and the same product version in analog or digital form can be used.

Assigning redundant modules

Redundant modules can be assigned to each other for the ET 200M as follows:

- The modules are located in two different ET 200M stations on the same redundant PROFIBUS DP (see sample configuration).
- The modules are located in two different ET 200M stations on different redundant PROFIBUS DPs.
- The modules are located in the same ET 200M station.
Example configuration

The figure below shows the setup for redundant input modules in a switched distributed configuration.

Method of operation in the example configuration

"Signal Module 1" is configured redundantly to "Redundant Signal Module 1". As a result, Signals E1.1 and E10.1 are redundant to one another.

If a fault is detected in "Signal module 1", the user program continues to work with the address I1.1, but the signal comes from the address I10.1. The user program does not detect an error, because the signal status is still correct. The event generates a diagnostic message that provides information about the passivated signals.

As of PCS 7 V7.1, the passivation reaction of the redundant I/O modules are set for channel-based reaction to channel faults. Additional information about passivation reaction is available in the section "How to set the CPU for the reaction of the input/output modules to channel faults (Page 95)".

Requirements

- The PCS 7 project involving an H CPU must have been created and opened in SIMATIC Manager.
- A redundant DP master system is configured for the SIMATIC H station in HW Config.
- The interface modules for ET 200M (IM 153-2) on the redundant PROFIBUS DP are configured in HW Config.
Advantages of fault-tolerant components

4.4 Distributed I/O

Procedure

1. In the component view, select the SIMATIC H station and double-click the "Hardware" object in the detail window.
   HW Config opens.
2. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.
3. Select the IM 153-2 (ET 200M) in which you want to configure the redundant module. The module overview is displayed in the lower window pane.
4. In the hardware catalog, select a signal module that supports redundancy. Drag the signal module to a free slot in the IM 153-2 (lower window pane).
5. Repeat steps 3 and 4 for the second signal module.
   The modules for which redundancy is to be configured are inserted.
6. Select the first IM 153-2 again.
7. Double-click on the inserted signal module in the module overview. The "Properties ..." dialog box for this module opens.
8. Open the "Addresses" tab.
9. Select the process image partition in the "Process image" drop-down list.
10. Select the "Redundancy" tab.
11. Select the entry "2 modules" in the "Redundancy" drop-down list.
12. Click "Find". 
The "Find Redundant Module" dialog box opens.

13. In the "Subsystem" list, select the DP master system in which the redundant signal module is configured. 
   All the available PROFIBUS addresses in this DP master system are displayed in the "PROFIBUS address" box.

14. From the "PROFIBUS address" box, select the IM 153-2 in which the redundant signal module is configured. 
   The signal modules in this IM 153-2 capable of redundancy and for which no redundancy has yet been configured are displayed in the "Redundant module" list.

15. Select the signal module you want to use as a redundant signal module in the "Redundant module" list.

16. Click "OK" to close the dialog box.

17. In the "Additional parameters" area, make any additional settings required for input modules.

18. Click "OK".
4.4 Distributed I/O

Additional information
- Online help on STEP 7
- Documentation Process Control System PCS 7; PCS 7 - Released Modules
- Manual Automation System S7-400H; Fault-tolerant Systems

4.4.4 How to configure the redundancy for HART field devices

HART field devices can be configured with redundant modules. HART field devices can only be redundant, if they are configured separately, for example, by a 1 of 2 selection.
Procedure

1. Configure redundant modules for HART field devices in HW Config as described in section "How to configure redundant I/O modules (Page 112)." In the example, the module has been configured for slot 6:
   - ET 200M station with PROFIBUS address 4: Module 6
   - ET 200M station with PROFIBUS address 6: Module 6

   ![Figure 4-1 Redundant module selected.]

2. Place the "HART field device" in the detail view of the redundant module. In the example, module 6 on ET 200M station with PROFIBUS address 4.
3. Place the "HART field device" in the detail view of the redundant module. In the example, module 6 on ET 200M station with PROFIBUS address 6.

4. Select the menu command Station > Save. The settings are saved.

5. Double-click the added HART field device in one of the ET 200M stations. SIMATIC PDM will open.

6. Make the necessary settings for the HART field device.

Retrospect implementation of the module redundancy for HART devices

There are no mechanisms set aside to implement a module redundancy for HART devices in PCS 7.
Additional information

Operating Manual Process Control System PCS 7; SIMATIC PDM

4.4.5 How to configure the Y Link

Introduction

The Y Link consists of two IM 153-2 interface modules and a Y coupler. The Y Link creates a gateway from a redundant DP master system to a non-redundant DP master system.

The following describes how to install and configure the Y Link.

Configuration examples are available in the section "Gateway between redundant and non-redundant PROFIBUS DP (Page 65)".

Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- A redundant DP master system is configured for the SIMATIC H station in HW Config.

Procedure

1. In the component view, select the SIMATIC H station and double-click the "Hardware" object in the detail window.
   HW Config opens.
2. If the hardware catalog is not visible, select the menu command View > Catalog.
   The hardware catalog opens.
3. In the current PCS 7 profile, double-click "PROFIBUS DP" and then "DP/PA Link".
4. Select the IM 153-2 interface module whose hardware catalog description is "Y Link".
5. Drag the IM 153-2 interface module to one of the two PROFIBUS DP lines.
6. Enter the PROFIBUS address in the "Properties - PROFIBUS Interface IM 153-2" dialog box and click "OK".
7. Click on "Interface module for PROFIBUS DP" in the "Define Master System" dialog box and click "OK".
Result

The following figure shows an example configuration in HW Config:
Advantages of fault-tolerant components

4.4 Distributed I/O
4.4.6 Configuring DP/PA Link

Functionality

When connecting a redundant PROFIBUS DP, the DP/PA Link consists of two IM 153-2 interface modules and one or more DP/PA couplers. The DP/PA coupler is used to build a gateway between a redundant PROFIBUS DP subnet and a non-redundant PROFIBUS PA subnet. When configuring in HW Config in SIMATIC Manager, you can only select the IM 153-2 interface modules and not the DP/PA coupler.

The DP/PA coupler is transparent in regard to addressing and communication. It does not have its own bus address or diagnostic address; it simply forwards message frames. The field devices connected to the PROFIBUS PA are addressed directly from the automation device.

The DP/PA coupler can be reconfigured in runtime but it cannot be replaced.

Note

You can find a list of PA slaves that can be connected in the manual SIMATIC Bus Couplers; DP/PA Link and Y Link. Note that PCS 7 driver blocks are not available for all of the devices listed. Contact the PCS 7 Support Center to check if such a driver block is available for the device you have selected.

Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- A redundant DP master system is configured for the SIMATIC H station in HW Config.

Example configuration

The following figure shows how the DP/PA Link is used.
Procedure

Configure the DP/PA Link as described in the section "How to configure the Y Link (Page 119)".

The DP/PA Coupler does not appear in the hardware catalog for the configuration of the bus system.

When configuring in HW Config, you only need to set the transmission speed for the selected PROFIBUS DP network in the "Network Settings" tab of the "Properties PROFIBUS dialog box.

Result

The following figure shows the configuration in HW Config with the "PCS7_V70" library as an example:
Additional information

- Manual SIMATIC DP/PA Link and Y Link Bus Couplings

4.4.7 Configuring FF Link

Functionality

The FF Link consists of two IM 153-2 FF interface modules and one or more FDC157-0 couplers for a connection to a redundant PROFIBUS DP. The FDC157-0 coupler is used to build a gateway between a redundant PROFIBUS DP subnet and a non-redundant FF segment. During configuration in HW Config, you can only select the FF Link in SIMATIC Manager; the FDC157-0 coupler is not displayed.

The FDC157-0 coupler is not displayed for addressing and communication. It does not have its own bus address or diagnostic address; it simply forwards message frames. The field devices connected to the FF segment are addressed directly from the PLC.

The FDC157-0 coupler can be reconfigured in runtime but it cannot be replaced.

Note

You can find a list of FF devices that can be connected in the operating instructions SIMATIC; Bus link; FF Link bus link. Please note that PCS 7 driver blocks are not available for all of the devices listed. Contact the PCS 7 Support Center to determine if a driver block is available for the device you have selected.

Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- A redundant DP master system is configured for the SIMATIC H station in HW Config.
- SIMATIC PDM V8.0 SP1 or higher
Example configuration

The following figure shows how the FF Link is used:

![Example configuration diagram]

Procedure

Configure the FF Link in the same way as the PA link. You can find information about this in the "Configuring DP/PA Link (Page 122)" section.

The FDC157-0 coupler does not appear in the hardware catalog for the configuration of the bus system.

When configuring in HW Config, you only need to set the transmission rate for the affected PROFIBUS DP network in the "Network Settings" tab of the "FOUNDATION Fieldbus Properties" dialog box.

Result

The following figure shows an example configuration in HW Config for the "PCS7_V80" library library:
4.4 Distributed I/O

Additional information

- Operating instructions SIMATIC; Bus links; FF Link bus link
- Commissioning manual SIMATIC; PCS 7 in-practice, FOUNDATION Fieldbus
- Operating manual SIMATIC; SIMATIC PDM V8.0 SP1

4.4.8 Configuration of redundant signals

You configure only one signal in CDC for redundantly acquired signals.
Basic procedure

1. Place one channel block in the CFC chart for each redundantly acquired signal.
2. For redundantly registered signals (e.g. input 1.1 and input 10.1), connect the symbol only with the lowest value address (e.g. input 1.1).
3. Compile the user program when the configuration is completed. The required driver blocks are automatically inserted, interconnected and configured during compilation of the user program.

4.5 Operator stations

4.5.1 Overview of configuration tasks

Introduction

The following sections describe how to configure redundancy for operator stations.

Overview of configuration tasks

You configure the redundancy functionality of the operator stations by performing the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configuring the PC stations for a redundant OS server pair (Page 127)</td>
</tr>
<tr>
<td>2</td>
<td>Configuring a central archive server and its redundant archive partner server (Page 130)</td>
</tr>
<tr>
<td>3</td>
<td>Setting the properties of the central archive server (Page 133)</td>
</tr>
<tr>
<td>4</td>
<td>Setting the project path for destination OS and standby OS (Page 134)</td>
</tr>
<tr>
<td>5</td>
<td>Creating a redundant connection between OS and AS (Page 135)</td>
</tr>
<tr>
<td>6</td>
<td>Configuring redundancy for OS servers on the Engineering Station (Page 138)</td>
</tr>
<tr>
<td>7</td>
<td>Setting the redundancy connection for OS servers (Page 141)</td>
</tr>
<tr>
<td>8</td>
<td>Assignment of S7 programs to the OS (Page 142)</td>
</tr>
<tr>
<td>9</td>
<td>Configuring an OS client (Page 144)</td>
</tr>
<tr>
<td>10</td>
<td>Configuring an OS client for permanent operability (Page 145)</td>
</tr>
<tr>
<td>11</td>
<td>Downloading the SIMATIC PCS 7 project to the target systems (Page 148)</td>
</tr>
</tbody>
</table>

4.5.2 How to configure an OS server and its redundant OS partner server

Introduction

The following describes the individual steps involved in installing the OS server and its redundant OS partner server.
The example below shows the redundant connection of the OS server pair to the plant bus using two CP 1623 or CP 1613 communication processors per server.

Requirements

- The PCS 7 project with a SIMATIC H station is open in SIMATIC Manager.
- Each PC is equipped with two communication processors (CP 1623 or CP 1613) which you can connect to the plant bus.
- The ISO protocol is set as the communication protocol on the plant bus.
- Each PC has a standard network adapter for connection to the terminal bus.

Procedure

**Note**
Steps 1 to 11 of this procedure have already been performed if an OS server was created in the project.

1. In the component view of SIMATIC Manager, select the project where you want to add the operator station.
2. Select the menu command **Insert > Station > SIMATIC PC Station**. A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station, select the menu command **Edit > Object Properties** and enter the desired name (in the example, OS server).
4. Enter the Windows name of the computer to be used as the OS server in the "Computer name" box.
5. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detailed view. The hardware configuration of the SIMATIC PC station opens.
6. If the hardware catalog is not visible, select the menu command **View > Catalog**. The hardware catalog opens.
7. In the hardware catalog under "SIMATIC PC Station > HMI...", select the "WinCC application" and insert it in the configuration table by means of drag-and-drop.
8. Select the communication processor (CP 1623 or CP 1613) from the "SIMATIC PC Station > CP Industrial Ethernet" folder of the hardware catalog and drag it to the PC station. The "Properties - Ethernet Interface" dialog box opens.
9. Set the required address on the bus for the CP. Select the "Set MAC address/Use ISO protocol" check box and click "OK".
10. Repeat steps 8 and 9 for the second communication processor (CP 1623 or CP 1613).
11. Select the menu command **File > Save**, exit HW Config and change to SIMATIC Manager.
12. In the component view of SIMATIC Manager, select the project where you want to insert the redundant operator station.
13. Select the menu command **Insert > Station > SIMATIC PC Station**.  
A new SIMATIC PC station is inserted in the selected project.

14. Select the SIMATIC PC station, select the menu command **Edit > Object Properties** and enter the desired name (in the example, OS partner server).

15. Enter the Windows name of the computer to be used as the OS partner server in the "Computer name" box.

16. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detail window.  
The hardware configuration of the SIMATIC PC station opens.

17. If the hardware catalog is not visible, select the menu command **View > Catalog**.  
The hardware catalog opens.

18. In the hardware catalog under "SIMATIC PC Station > HMI...", select the "WinCC application (stby)" and insert it in the configuration table by means of drag-and-drop.

19. Select the communication processor (CP 1623 or CP 1613) from the SIMATIC PC Station > CP Industrial Ethernet folder of the hardware catalog and drag it to the PC station.  
The "Properties - Ethernet Interface" dialog box opens.

20. Set the required address on the bus for the CP.  
Select the "Set MAC address/Use ISO protocol" check box and click "OK".

21. Repeat steps 19 and 20 for the second communication processor (CP 1623 or CP 1613).

22. Select the menu command **File > Save** and exit HW Config.
4.5 Operator stations

Result

Your project should now correspond to the project shown in the following figure. You can change the names of the components as you wish.

Additional information

- Configuration manual *Process Control System PCS 7: Engineering System*, section "How to Expand a Project with Pre-Configured Stations Using the PCS 7 Wizards"
- Online help on *STEP 7*
- For information pertaining to the NDIS settings for a Maintenance Station, refer to the *Process Control System PCS 7; PC Configuration and Authorization* manual.

4.5.3 How to configure a central archive server and its redundant archive partner server

Introduction

The following describes the individual steps involved in creating the archive server and its redundant archive partner server.
Requirements

- The PCS 7 project is open in SIMATIC Manager.
- Each PC has a standard network adapter for connection to the terminal bus.

Procedure

Note

Steps 1 to 10 of this procedure have already been performed if an archive server was created in the project.

1. In the component view of the SIMATIC Manager, select the project into which you want to add the redundant central archive server.
2. Select the menu command Insert > Station > SIMATIC PC Station.
   A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station.
4. Select the menu command Edit > Object Properties.
5. In the "Name:" input box, enter the desired name.
   The name "CAS Server" is entered in the example.
6. Enter the Windows name of the computer in the "Computer Name" input box.
7. Click "OK".
8. Mark the SIMATIC PC station in the component view and open HW Config by double-clicking on the "Configuration" object in the detail view.
   The hardware configuration of the SIMATIC PC station opens.
9. If the hardware catalog is not visible, select the menu command View > Catalog.
   The hardware catalog opens.
10. Select the WinCC application "WinCC CAS Appl." in the hardware catalog under "SIMATIC PC Station > HMI..." and insert it in the configuration table by means of drag-and-drop.
11. Select the menu command File > Save, exit HW Config and change to SIMATIC Manager.
12. In the component view of the SIMATIC Manager, select the project into which you want to add the redundant central archive server.
13. Select the menu command Insert > Station > SIMATIC PC Station.
    A new SIMATIC PC station is inserted in the selected project.
14. Select the SIMATIC PC station.
15. Select the menu command Edit > Object Properties.
16. In the "Name:" input box, enter the desired name.
    The name "CAS Partner Server" is entered in the example.
17. Enter the Windows name of the computer to be used as the archive partner server in the "Computer name" box.
18. Click "OK".
19. In the component view, select the SIMATIC PC station and double-click the “Configuration” object in the detail window. The hardware configuration of the SIMATIC PC station opens.

20. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.

21. Select the WinCC application WinCC CAS Appl. (stby) in the hardware catalog under "SIMATIC PC Station > HMI..." and insert it in the configuration table by means of drag-and-drop.

22. Select the menu command File > Save and exit HW Config.

Result

Your project should now correspond to the project shown in the following figure. You can change the names of the components as you wish.
Additional information

- Online help on *STEP 7*

### 4.5.4 How to set the redundancy of the central archive server

The properties of the central archive server can only be set for the archive server with the "WinCC application CAS".

#### Procedure

1. In the tree of the component view, select the "[OS]" object underneath the archive server's SIMATIC PC station.
2. Select the menu command `Edit > Object Properties`. The "Properties - OS:[Name of OS]" dialog box opens.
3. Open the "CAS – Central archive server options" tab.
4. Activate the check box of the archive for which you want to configure archiving:
   - All
   - TagLogging Fast
   - TagLogging Slow
   - AlarmLogging
   - Reports (OS reports and Batch reports from SIMATIC BATCH)
5. Make the following settings in the "Archive size" group:
   - In the "Time period for all segments" input box, enter the entire period of time during which archives are to be created.
   - In the "Max. size for all segments" input box, enter the maximum time period for all segments combined. This imposes a limit in terms of the memory requirements. These settings will depend on the maximum amount of storage space that is available for your archives.
   - In the "Time period for a single segment" input box, enter the period of time during which archive data are to be archived in a single segment.
   - In the "Max. size of a single segment" input box, enter the maximum size for a single segment. Depending on which parameter is satisfied first, the single segment is closed and a new single segment created.
6. Specify the "Time of first segment change".
7. Click "OK".
4.5.5 How to set the project paths of the destination OS and standby OS

Introduction

Note
The procedure described in this section applies to the following servers:
- OS server
- Maintenance server
- External archive server
  - Process Historian
  - Central archive server

The description for the OS server is used here.

The OS servers of an OS server pair must be made known to each other. You do this by making the following settings for the SIMATIC PC stations:
- For both OS servers: "Destination OS Computer"
- On the "master OS": OS name of the redundant OS server "Standby OS"

The destination OS computer is the Windows name of the PC in the Windows network to which the server data (configuration data) for an OS server of an OS server pair was downloaded.

Master OS and standby OS mean the OS servers that make up an OS server pair.

Requirements

- The PCS 7 project is open in SIMATIC Manager.
- Two SIMATIC PC stations have been configured in HW Config as an OS server and OS partner server.

Procedure

1. In the component view, select the OS that you want to specify as the master OS.
2. Select the menu command Edit > Object Properties.
   The "Properties - [name of the OS]" dialog box opens.
3. Select the "Destination OS and Standby OS" tab.
4. Click the "Browse" button next to the "Path to destination OS computer" box and enter the path to the MCP file of the destination OS.
The destination OS computer is the computer where the project is to run.
The mcp file is generated automatically when you create the OS.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the network path for the destination OS using UNC (Universal Naming Convention) notation: \Server name\Share name\Directory name</td>
</tr>
</tbody>
</table>

5. Select the OS that you want to use as the standby OS from the "Standby OS" list.
All of the standby operator stations that you have created in SIMATIC Manager are displayed in this drop-down box.

6. Click "OK".
You have completed all settings for the master OS.

7. In the component view, select the OS that you want to use as the standby OS.

8. Select the menu command Edit > Object Properties.
The "Properties - [name of the OS]" dialog box opens.

9. Select the "Destination OS and Master OS" tab.

10. Click the "Browse" button next to the "Path to destination OS computer" box and enter the path to the MCP file of the destination OS.
The destination OS computer is the computer where the project is to run.
The mcp file is generated automatically when you create the OS.

11. Click "OK".
You have completed all settings for the standby OS.

Additional information
- Online help for STEP 7

4.5.6 How to configure a redundant connection between an OS and AS

Introduction
To complete the configuration of the OS server and its redundant OS partner server, you need to create the fault-tolerant network connections to the AS in NetPro.

Requirements
- The PCS 7 project is open in SIMATIC Manager.
- The AS is connected to the plant bus in NetPro.
- The plant bus has been configured.
- Two SIMATIC PC stations with network adapters have been configured in HW Config as an OS server and OS partner server.
Procedure

1. Open NetPro in SIMATIC Manager with the menu command **Options > Configure Network**.

2. Select the interface symbol in the first network adapter (e.g. CP 1613) in the picture of the OS server and use the mouse to draw a connection to the plant bus. The network adapter is now connected to the plant bus.

3. If two network adapters are configured for the plant bus in the OS server, connect the second network adapter of the OS server to the (redundant) plant bus in the same way.

4. Connect the network adapters of the OS partner server to the plant bus in the same way.

5. Select the WinCC application of the OS server for which you want to configure a fault-tolerant network connection. The connection table is displayed in the lower window pane.

6. Select the first empty row in the connection table and select the menu command **Insert > New Connection**. The "New Connection" dialog box opens.

7. Select the desired connection partner in the tree.

8. Select the connection type "S7 connection fault-tolerant" in the "Connection" box.

9. Activate the "Show properties before inserting" check box. This allows you to make settings or changes to the connection.

10. If redundant CPs for the plant bus are configured in the SIMATIC H stations, activate the check box "Enable max. CP redundancy (with 4 connection paths)" in the "Redundancy" group.

11. Click "OK" to save your entries.
Result

The following figure shows the redundant network connection of the two OS servers to the SIMATIC H station in NetPro:

Additional information

- Section "Network components (Page 41)"
- Section "How to configure a fault-tolerant plant bus (Page 100)"
- Online help for STEP 7
4.5.7 How to configure redundancy for OS servers on the engineering station

Introduction
Carry out the following configuration tasks on the Engineering Station. The description for the OS server is used here.

Validity
The procedure described in this section applies to the following servers:
- OS server
- Maintenance server
- Central archive server

Requirements
- The PCS 7 project is open in SIMATIC Manager.
- You configured two SIMATIC PC stations in HW Config for operation as master and standby OS servers. Each one of the two PC stations is equipped with two communication processors (CP 1613 or CP 1623).

Procedure

Note
Settings in steps 5 and 6: The settings are adopted automatically from the configuration in SIMATIC Manager. It may be necessary to adapt settings if projects have been copied or if you configure in a different order from the one recommended for PCS 7.

1. In the component view of SIMATIC Manager, select the OS in the OS server and select the menu command Edit > Open Object. The WinCC Explorer opens.
2. Select the Editor > Redundancy > Open menu command in WinCC Explorer. The "Redundancy" application opens.
3. Select the "Activate redundancy" check box.
4. In the "General" tab, select the "Default Master" check box if you want to set the OS server as the default master.

Note
Make sure that only one of the two OS servers is the "default master" and that this option is not selected for both of the OS servers in the "Redundancy" dialog box. Problems may otherwise occur during redundancy failover of OS clients.
5. In the "Redundant Partner Server" field, enter the computer name of the redundant OS server. You can also use the "Browse" button to select an appropriate server from the network.

6. Select the following check boxes as required:
   - Synchronization of Tag Logging after the partner server comes back online
   - Synchronization of Alarm Logging after the partner server comes back online
   - Online synchronization for Alarm Logging
   - Synchronization after process connection error
   - WinCC client failover if the process connection is disrupted

7. For more information about the "General" and "User Archive" tabs refer to the Online help for WinCC.

8. Click "OK".
The "General" tab in the "Redundancy" dialog can be configured as follows:

![Redundancy dialog box](image)

- **Server:**
  - Default Master
  - Redundant Partner Server:
    - [OS(1)_STBY]

- **Optional Settings:**
  - Synchronization of Tag Logging after the partner server comes back online
  - Synchronization of Alarm Logging after the partner server comes back online
  - Online synchronization for Alarm Logging
  - Synchronization after process connection error (Tag + Alarm Logging)
  - WinCC client switch in case of a process connection error

- **Verbindung zum redundanten Partner über serielle Schnittstelle:** [COM1]

- **Verbindung zum redundanten Partner über Netzadapter (MAC Adresse):** [None]

Activated the synchronization of all specified options and the User Archives:
- **Activate Redundancy**
4.5.8 How to set the redundancy connection for OS servers

Introduction

You will now select the connection path for the redundancy connection between 2 OS servers. You can make the following settings directly on each of the mutually redundant OS servers. The description for OS servers is used here.

Changing the connection path

Note

When the redundancy connection is established via a serial interface, you need to reboot the PC station after changing the connection path.

Validity

The procedure described in this section applies to the following servers:

- OS server
- Maintenance server
- Central archive server

Requirements

- The OS server and OS partner server are connected by a redundancy cable. You can use the following as the redundancy cable:
  - Network cable on additional network adapter (free network onboard adapter possible as of PCS 7 V8.0, e.g. from Bundle PC SIMATIC IPC 647C)
  - Null modem cable on the COM port
- OS server and OS partner server are installed as redundant OS servers.
- The "WinCC Redundancy" license key is available on the OS server and OS partner server.
**Procedure**

1. Open the Windows Explorer on the OS server.
2. Select the folder "Simatic Shell" in the tree view
   - Windows Server 2003/2003 R2: My Computer > Simatic Shell
   - Windows 7/Windows Server 2008 R2: Desktop > Computer > Simatic Shell
3. Select the shortcut menu command **Redundancy Settings**.
   The "Redundancy Settings" dialog box opens.
4. Select the connection path through which the OS server pair is connected in the drop-down list.
   - For connection via RJ45 cable:
     In the "Network adapter" dropdown list, select the network adapter to which you want to attach the network cable for the redundant connection between the two PC stations of a server pair.
   - For a serial connection:
     In the "Serial port" dropdown list, select the port to which you want to attach the null-modem cable for the redundant connection between the two PC stations of a server pair: "COM1" or "COM2"

**Note**

One connection path is permitted between the two PC stations in a redundantly configured server.

5. Click "OK".

**4.5.9 How to assign an S7 program to an OS**

**Introduction**

The AS-OS assignment of a hierarchy folder in the plant view of SIMATIC Manager results in the following in the component view:

- All CFC and SFC charts inserted in the plant view are stored in the chart folder of the assigned AS.
- All pictures and reports inserted in the plant view are stored in the folder of the assigned OS.

**Requirements**

- The PCS 7 project is open in SIMATIC Manager.
- The plant view is activated.
Procedure

1. Select the hierarchy folder for which you want to make the AS-OS assignment in the plant view.
2. Select the menu command Edit > Object Properties and change to the "AS-OS Assignment" tab.
3. From the "Assigned AS" list, select the S7 program that you want to assign to the selected hierarchy folder.
4. If the lower-level objects have a different assignment and you want to have the same assignment for all lower-level objects, check the "Pass on selected assignment to Pass on all the lower-level objects" check box.

   Note
   The "Pass on selected assignment to all lower-level objects" check box is active if the lower-level objects have another assignment or no assignment.

5. From the "Assigned OS" list, select the operator station you want to assign to the selected hierarchy folder.
6. If the lower-level objects have another assignment but you prefer all lower-level objects to have the same assignment, select the "Pass on selected assignment to lower-level objects" check box.

   Note
   If you select "Area oriented" as the compilation mode, the OS assignment can only be changed for PH folders of the OS area level.

7. Click "OK".

Result

The AS/OS assignment is selected, and the lower-level objects are passed on or not passed on according to your setting.

Note
If you have divided up the projects so that there is only one OS or one AS in a project, you cannot make an AS-OS assignment.

Additional information

- Online help for the "AS-OS Assignment" tab
- Online help for PH, IEA, and PO
4.5.10 How to configure an OS client

Introduction

The following section describes how to configure two OS clients, for example, that can be interconnected with a redundant pair of OS servers.

Requirements

- The PCS 7 project is open in SIMATIC Manager.
- Each PC has a standard network adapter for connection to the terminal bus.

Procedure

1. In the component view of SIMATIC Manager, select the project in which you want to configure the OS clients.
2. Select the menu command Insert > Station > SIMATIC PC Station. A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station, select the menu command Edit > Object Properties and enter the desired name.
4. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detail window. The hardware configuration of the SIMATIC PC station opens.
5. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.
6. In the hardware catalog under "SIMATIC PC Station > HMI...", select the "WinCC application client" and insert it in the configuration table by means of drag-and-drop.
7. Select the menu command Station > Save.
8. Close the hardware catalog.
9. Repeat steps 2 to 8 for the second OS client.
Result

Your project should now correspond to the project shown in the following figure. You can change the names of the components as you wish.

Using reference clients

You can set up additional monitoring stations using reference clients. They use configured OS clients as a basis.

Refer to the configuration manual Process Control System PCS 7; Operator Station for more information.

4.5.11 How to configure an OS client for permanent operability

Introduction

A minimum of two OS clients are required for permanent operability. A preferred server is specified separately for each client, thus distributing the OS clients to the redundant OS servers. This ensures that the process is continuously available even during a failover from a faulty OS server to the redundant OS partner server.
Advantages of fault-tolerant components

4.5 Operator stations

Requirements

- The redundant OS server pair has been configured in SIMATIC Manager.
- WinCC redundancy is configured for the OS server (master).
- The OS server (master) has been compiled such that the server data have been generated.
- Two OS clients have been configured in SIMATIC Manager.
- The server data of the OS server (master) has been assigned to the client project.

Procedure

1. Open the WinCC project of the first OS client in the component view in SIMATIC Manager.
2. Open the "Server Data" editor in WinCC Explorer.
3. Select "Configure" command in the shortcut menu.
   The "Configure Server Data" dialog box opens.
4. Click the cell "No preferred server" in the "Preferred server" column.
   A drop-down box appears. The preferred servers available for selection depend on the redundancy configuration of the OS servers and are transferred to the OS client with the server data.
5. Select the preferred OS server for the OS client from the drop-down list box.
6. Close the dialog box.
7. Repeat steps 1 to 6 for the second OS client. Note that you must set the redundant OS partner server as the preferred server for the second OS client.
8. Select the first OS client and select the menu command Edit > Object Properties.
   The "Properties [name of OS]" dialog box opens.
9. Select the "Destination OS" tab.
10. Click the "Browse" button next to the "Path to target OS computer" box and enter the path to the MCP file of the OS client.
    The mcp file is generated automatically when you create the OS.
11. Repeat steps 8 to 10 for the second OS client.
Result

The "Configure server data" dialog boxes on both OS clients appear as follows:

- Dialog box on OS client 1:

- Dialog box on OS client 2:
Using reference clients

You can set up additional monitoring stations using reference clients. They use configured OS clients as a basis.

Additional information

- Online help for WinCC
- Configuration manual Process Control System PCS 7; Operator Station

4.5.12 How to download a SIMATIC PCS 7 project to the target systems

Introduction

You can download a PCS 7 project that you created in SIMATIC Manager along with the components of the project (AS, OS, BATCH server/client) to the various target systems in a single step with the menu command PLC > Compile/Download Programs.

You can also download the various components individually to the PLCs using the menu command PLC > Download.

Requirements

- All of the required SIMATIC PC stations have been configured in SIMATIC Manager.
- The master OS/standby OS assignment has been made.
- The destination paths from the ES to the individual target systems have been configured.
- The AS and all of its components (synchronization modules, CPs, etc.) have been configured.
- All network connections have been configured, saved and compiled in NetPro.
- The destination computer is already equipped with an operating system, a network connection and WinCC.
- The PCS 7 project is open in SIMATIC Manager.

Procedure

1. Select the project in the component view of SIMATIC Manager.
2. Select the menu command PLC > Compile and Download Objects.
The "Compile and Download Objects" dialog box opens.
3. Check whether all components in the project have been configured for complete compilation/downloading.
4. Click "Start".
The compile/download operation starts.
Sequence when loading redundant OS servers with "Changes-only download" function

The "Changes-only download" function of a redundant OS server is only available if both partner stations are in process mode (runtime).

For safety reasons, downloading is not performed to a redundant OS server pair at the same time:
- The OS server with the configured application "WinCC Appl. (stby)" is downloaded first.
- Once the downloading of the OS server with the configured application "WinCC Appl. (stby)" has been successfully completed, the partner station with the configured application "WinCC Appl." will be downloaded.

Additional information
- Configuration manual Process Control System PCS 7; Operator Station
- Online help for STEP 7

4.5.13 Evaluating the "@RM_MASTER" Redundancy Variables with Scripts

Recommendation

If you decide to evaluate the "@RM_MASTER" tag with scripts, you should program an operator button that can deactivate this part of the scripts. This way, you will not have to change and reload scripts each time the software is updated.

4.6 SIMATIC BATCH Stations

4.6.1 Overview of configuration tasks

Introduction

The following sections describe how to configure redundancy for SIMATIC BATCH stations.

Overview of configuration tasks

You configure the redundancy functionality of the BATCH stations by performing the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configuring the PC Stations for a redundant BATCH server pair (Page 150)</td>
</tr>
<tr>
<td>2</td>
<td>Configuring the PC station for a BATCH client (Page 152)</td>
</tr>
<tr>
<td>3</td>
<td>Setting the network adaptor for redundancy monitoring of BATCH servers (Page 153)</td>
</tr>
</tbody>
</table>
4.6.2 How to configure a BATCH server and its redundant BATCH partner server

Introduction

The following describes how to configure a redundant BATCH server.

In the following example, the BATCH server is connected to the fault-tolerant terminal bus.

Requirements

- The SIMATIC BATCH software package (BATCH Engineering) has been installed in addition to the PCS 7 software.
- The PCS 7 project is open in SIMATIC Manager.

Procedure

1. In the component view of SIMATIC Manager, select the project into which you want to insert the BATCH server.
2. Select the menu command Insert > Station > SIMATIC PC Station. A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station, select the menu command Edit > Object Properties and enter the desired name (in the example, BATCH server).
4. Enter the Windows name of the computer to be used as the BATCH server in the "Computer name" box.
5. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detailed view. The hardware configuration of the SIMATIC PC station opens.
6. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.
7. In the hardware catalog under "SIMATIC PC Station > BATCH...", select the "BATCH application" and insert it in the configuration table by means of drag-and-drop.
8. Select the menu command File > Save, exit HW Config and change to SIMATIC Manager.
9. In the component view of SIMATIC Manager, select the project into which you want to insert the redundant BATCH server.
10. Select the menu command Insert > Station > SIMATIC PC Station. A new SIMATIC PC station is inserted in the selected project.
11. Select the SIMATIC PC station, select the menu command Edit > Object Properties and enter the desired name (in the example, BATCH partner server).
12. Enter the Windows name of the computer to be used as the BATCH partner server in the "Computer name" box.

13. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detail window. The hardware configuration of the SIMATIC PC station opens.

14. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.

15. In the hardware catalog under "SIMATIC PC Station > BATCH...", select the "BATCH application (stby)" and insert it in the configuration table by means of drag-and-drop.

16. Select the menu command File > Save and exit HW Config.

Result

The following figure shows an example configuration of a SIMATIC PC station with BATCH application (stby):
Additional information

- Configuration manual *Process Control System PCS 7; Engineering System*, section "How to Expand a Project with Pre-Configured Stations Using the PCS 7 Wizards"
- Manual *Process Control System PCS 7; SIMATIC BATCH*

### 4.6.3 How to configure a BATCH client

**Introduction**

A BATCH client and a OS client are often run together on one SIMATIC PC station. You configure both client applications in HW Config in a SIMATIC PC station.

**Requirements**

- The SIMATIC BATCH software package (BATCH Engineering) has been installed in addition to the PCS 7 software.
- The PCS 7 project is open in SIMATIC Manager.

**Procedure**

1. In the component view of SIMATIC Manager, select the project into which you want to insert the BATCH client.
2. Select the menu command **Insert > Station > SIMATIC PC Station**.
   A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station, select the menu command **Edit > Object Properties** and enter the desired name.
4. Enter the name of the computer to be used as the BATCH client in the "Computer name" box.
5. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detailed view.
   The hardware configuration of the SIMATIC PC station opens.
6. If the hardware catalog is not visible, select the menu command **View > Catalog**.
   The hardware catalog opens.
7. Under "SIMATIC PC Station > BATCH..." in the hardware catalog, select the "BATCH application client" and insert it in the configuration table by means of drag-and-drop.
8. Save your current settings and close HW Config.
Result

The following figure shows the SIMATIC PC station with BATCH application client configured in HW Config:

Additional information

- Manual *Process Control System PCS 7; SIMATIC BATCH*

4.6.4 How to set the redundancy monitoring of BATCH servers

Introduction

A local Ethernet network needs to be built in PCS 7 for redundancy monitoring of redundant BATCH servers.
Requirements

- A network adapter for the local Ethernet network is available for redundancy monitoring on each BATCH server of a server pair (referred to below as the 3rd network adapter).
- All software components have been installed on the BATCH servers.

Procedure

1. Open the dialog window "Network connections" via the Control Panel.
2. Select the menu command Advanced > Advanced Settings.
3. The terminal bus must be at the top of the list for the connections. Set the 3rd network adapter in the list under the terminal bus.
4. Deactivate the options "Client for Microsoft Networks" and "File and Printer Sharing ..." in the "Network Adapters and Bindings" tab for the 3rd network adapter.
5. Click "OK".
6. In the "LAN or High-speed Internet" list of the "Network Connections" dialog box, select the 3rd network adapter and then select the menu command File > Properties.
7. Check the "Internet Protocol (TCP/IP)" box and deactivate all other elements.
8. Select "Internet Protocol (TCP/IP)".
10. Set the "local" IP address in the "General" tab.

Note

Enter different IP addresses for the master server and standby server from a private subnet range (e.g., subnet 192.168.0.0) that cannot be routed to the WAN.

11. Click "OK".

4.6.5 How to configure the redundancy connection for BATCH servers on the engineering station

Introduction

Additional tasks must be performed in the engineering and for setting up the PC stations for redundant BATCH servers:
- On the engineering station:
  Check the default engineering settings in effect
- On each BATCH server:
  Set the network adapter for redundancy monitoring
Time needed for ending process mode of a BATCH server

The time needed for ending process mode of a BATCH server depends on the size of the SIMATIC BATCH configuration. The redundancy partner reports a fault on the BATCH server after the configured time. This time is set for redundant BATCH servers so that it is slightly longer than the time the BATCH server needs to normally end process mode in this plant.

Requirements

- The SIMATIC BATCH software package (BATCH Engineering) has been installed in addition to the PCS 7 software.
- The PCS 7 project is open in SIMATIC Manager.
- The configuration of the server pair for BATCH server in HW Config is completed.
- A network adapter is set up for redundancy monitoring via an Ethernet connection on each BATCH server.

Checking the configuration settings

1. Select the project in the component view of SIMATIC Manager.
2. Select the menu command Options > SIMATIC BATCH. The "Plant Data" dialog box opens.
3. Select the project in the tree view.
4. Open the "Distribution" tab. Click "Update". Check the displayed settings.
5. Open the "OS Objects" tab. Click "Update". Check the selected message OS.
6. Open the "System Response" tab. Click "Update".
7. Check the displayed settings in the "Startup response" group. You can find additional information about this in the manual Process Control System PCS 7; SIMATIC BATCH.
8. In the "Times" group, enter the required time in the "End" input box.

Additional information

- Manual Process Control System PCS 7; SIMATIC BATCH

4.6.6 How to set the redundancy connection for BATCH servers

Introduction

You will now select the connection path for the redundancy connection between 2 BATCH servers.
You can make the following settings directly on each of the mutually redundant BATCH servers.

Note

Shared server for OS and SIMATIC BATCH
The configuration for redundancy connection has to be performed only once.

Requirements

- BATCH server and BATCH partner server are connected to an additional network adapter via a redundancy cable.
- BATCH server and BATCH partner server are installed as redundant BATCH servers.

Procedure

1. Open the Windows Explorer on the BATCH server.
2. Select the folder My Computer > Simatic Shell in the tree view.
3. In the shortcut menu, select the menu command Set Redundancy ....
   The "Redundancy Settings" dialog box opens.
4. In the drop-down list under the "Network Adapter" group, select the network adapter through which the redundancy communication to the partner server should be established.
5. Perform steps 1 to 4 for each partner server.

4.6.7 How to download the target systems for SIMATIC BATCH

Introduction

You can download a PCS 7 project that you created in SIMATIC Manager along with the components of the project (AS, OS, BATCH server/client) to the various target systems in a single step with the menu command PLC > Compile/Download Programs.

Requirements

- The PCS 7 project is open in the Component view in the SIMATIC Manager.
- The SIMATIC BATCH configuration is completed.
- The Batch plant is compiled.

Downloading via SIMATIC BATCH

1. Select the menu command Options > SIMATIC BATCH.
   The "Plant Data" dialog box opens.
2. Select the plant object in the tree view.
3. Click "Download".
   In the "Download from <plant>" dialog box, all PC stations for BATCH servers (single, redundant), DB servers and BATCH clients are displayed with information about their download status.

4. Click "Start".
The plant object is downloaded.

Additional information
- Manual *Process Control System PCS 7; SIMATIC BATCH*

### 4.7 SIMATIC Route Control stations

#### 4.7.1 Overview of configuration tasks

**Introduction**

The following sections describe how to configure redundancy for SIMATIC Route Control stations.

**Overview of configuration tasks**

You configure the redundancy functionality of the SIMATIC Route Control stations by performing the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configuring the PC stations for a redundant Route Control server pair (Page 157)</td>
</tr>
<tr>
<td>2</td>
<td>Configuring the PC station for a Route Control client (Page 160)</td>
</tr>
<tr>
<td>3</td>
<td>Creating a redundant connection between Route Control server and AS (Page 162)</td>
</tr>
<tr>
<td>4</td>
<td>Creating a Route Control server (Page 166)</td>
</tr>
<tr>
<td>5</td>
<td>Downloading the target systems for Route Control (Page 166)</td>
</tr>
</tbody>
</table>

#### 4.7.2 How to configure a Route Control server and its redundant Route Control partner server

**Introduction**

The following describes how to configure a redundant Route Control server.

In the following example, the Route Control server is connected redundantly to the plant bus via communication processors (two CP 1623 or CP 1613 per server).
Requirements

- The SIMATIC Route Control software package (Route Control Engineering) has been installed in addition to the PCS 7 software.
- The PCS 7 project is open in SIMATIC Manager.

Procedure

1. In the component view of SIMATIC Manager, select the project into which you want to insert the Route Control server.
2. Select the menu command Insert > Station > SIMATIC PC Station. A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station, select the menu command Edit > Object Properties and enter the desired name (in the example, Route Control server).
4. Enter the Windows name of the computer to be used as the Route Control server in the "Computer name" box.
5. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detailed view. The hardware configuration of the SIMATIC PC station opens.
6. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.
7. In the "SIMATIC PC Station > Route Control ..." folder of the hardware catalog, select "RC application" and insert it in the configuration table by means of drag-and-drop.
8. In the "SIMATIC PC Station > CP Industrial Ethernet" folder of the hardware catalog, select the communication processor and drag it to the PC station. The "Properties - Ethernet Interface" dialog box opens.
9. Set the required address on the bus for the CP. Select the "Set MAC address/Use ISO protocol" check box and click "OK".
10. Repeat steps 8 and 9 for the second communication processor.
11. Select the menu command File > Save, exit HW Config and change to SIMATIC Manager.
12. In the component view of SIMATIC Manager, select the project into which you want to insert the redundant Route Control server.
13. Select the menu command Insert > Station > SIMATIC PC Station. A new SIMATIC PC station is inserted in the selected project.
14. Select the SIMATIC PC station, select the menu command Edit > Object Properties and enter the desired name (in the example, Route Control partner server).
15. Enter the Windows name of the computer to be used as the Route Control partner server in the "Computer name" box.
16. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detail window. The hardware configuration of the SIMATIC PC station opens.
17. If the hardware catalog is not visible, select the menu command View > Catalog. The hardware catalog opens.
18. Under “SIMATIC PC Station > Route Control …” in the hardware catalog, select “RC application (stby)” and insert it in the configuration table by means of drag-and-drop.

19. If redundant communication processors are installed for each PC station, repeat steps 8 and 9 for the second communication processor.

20. Select the menu command File > Save and exit HW Config.

Result

The following figure shows an example configuration of a SIMATIC PC station with Route Control application (stby):
4.7.3 How to configure a Route Control client

Introduction

Below you find out how to configure a redundant Route Control client in HW Config.

Requirements

- The SIMATIC Route Control software package (Route Control Engineering) has been installed in addition to the PCS 7 software.
- The PCS 7 project is open in SIMATIC Manager.

Procedure

1. In the component view of SIMATIC Manager, select the project into which you want to insert the Route Control client.
2. Select the menu command Insert > Station > SIMATIC PC Station.
   A new SIMATIC PC station is inserted in the selected project.
3. Select the SIMATIC PC station, select the menu command Edit > Object Properties and enter the desired name.
4. Enter the name of the computer to be used as the Route Control client in the "Computer name" box.
5. In the component view, select the SIMATIC PC station and double-click the "Configuration" object in the detailed view.
   The hardware configuration of the SIMATIC PC station opens.
6. If the hardware catalog is not visible, select the menu command View > Catalog.
   The hardware catalog opens.
7. Under "SIMATIC PC Station > Route Control ..." in the hardware catalog, select "RC application client" and insert it in the configuration table by means of drag-and-drop.
8. Save your current settings and close HW Config.
Result

The following figure shows the SIMATIC PC station with Route Control application client (RC application client) configured in HW Config:

Shared client for OS and Route Control

If a Route Control client and OS client are operated together on a SIMATIC PC station, configure both client applications in HW Config in one SIMATIC PC station.
Additional information

- Manual Process Control System PCS 7; SIMATIC Route Control

4.7.4 How to configure a redundant connection between a Route Control server and AS

Introduction

The redundant connections between the Route Control server and the AS are created in NetPro using SIMATIC Route Control wizards.

Requirements

- The PCS 7 project is open in SIMATIC Manager.
- The AS is connected to the plant bus in NetPro.
- The plant bus has been configured.
- Two SIMATIC PC stations have been configured in HW Config as a Route Control server and Route Control partner server with the following network adapters.

Procedure

1. In the SIMATIC Manager, select the menu command Options > SIMATIC Route Control > Wizard.
2. In the "Introduction" dialog box of the wizard, click "Next". The "What do you want to do?" dialog box opens.
3. In the "Generate S7 connections" group, activate the check box "AS-Server connection information". Click "Next".
4. Make the settings according to the plant configuration. The RC wizard automatically creates a fault-tolerant connection when a fault-tolerant system is the connection partner.

5. When the Route Control server and SIMATIC H station are each connected to the plant bus with two CPs, the following additional tasks need to be performed:
   - Open NetPro in SIMATIC Manager with the menu command Options > Configure Network.
   - Select the Route Control application of the Route Control server for which you want to configure a fault-tolerant network connection. The connection table is displayed in the lower window pane.
   - Select the connection to the SIMATIC H station in the connection table.
   - Select the menu command Edit > Object properties. The "Properties... S7 connection" dialog box opens.
   - Select the "General" tab.
   - To use 4-way redundancy, activate the check box "Enable max. CP redundancy (with 4 connection paths)".
   - Click "OK".

**Result**

The following figure shows the redundant network connection to the SIMATIC H station for both Route Control servers in NetPro. The example plant is configured with a redundant fault-
tolerant plant bus. Each PC station and each CPU is connected to the plant bus with 2 CP each:

Additional information

- Section "How to configure a fault-tolerant plant bus (Page 100)"
- You can find information about the Route Control wizards in the manual Process Control System PCS 7; SIMATIC Route Control.
- Online help for STEP 7
4.7.5 How to set the redundancy connection for Route Control servers

Introduction
You will now select the connection path for the redundancy connection between two Route Control servers.
You can make the following settings directly on each of the mutually redundant Route Control servers.

Changing the connection path

Note
When the redundancy connection is established via a serial interface, you need to reboot the PC station after changing the connection path.

Validity
The procedure described in this section applies to Route Control servers.

Requirements
- The Route Control server and Route Control partner server are connected by a redundancy cable.
  You can use the following as the redundancy cable:
  - Null modem cable on the COM port
  - Network cable on an additional network adapter
- Route Control server and Route Control partner server are installed as redundant Route Control servers.

Procedure
1. Open the Windows Explorer on the Route Control server.
2. Select the folder My Computer > Simatic Shell in the tree view.
3. In the shortcut menu, select the menu command Set Redundancy ....
   The "Redundancy Settings" dialog box opens.
4. Select the connection path through which the Route Control server pair is connected in the drop-down list.

   - For connection via RJ45 cable:
     In the "Network adapter" dropdown list, select the network adapter to which you want to attach the network cable for the redundant connection between the two PC stations of a server pair.

   - For a serial connection:
     In the "Serial port" dropdown list, select the port to which you want to attach the null-modem cable for the redundant connection between the two PC stations of a server pair: "COM1" or "COM2"

5. Click "OK".

4.7.6 How to set the redundancy of the Route Control servers

Introduction

You only have to configure the PC stations in the SIMATIC Manager for redundant Route Control servers.
In the object properties of the PC station, the computer name must be configured or "Computer name identical to PC station name" the check box must be activated.

Additional information

- Section "How to configure a Route Control server and its redundant Route Control partner server (Page 157)"

4.7.7 How to download the target systems for Route Control

Introduction

For Route Control plants with redundant Route Control servers, you should always download the Route Control configuration to the Route Control server and the Route Control clients.

Additional information

- You can find information about downloading the Route Control server in the manual Process Control System PCS 7; SIMATIC Route Control.
- You can find information about downloading the configuration to the Route Control client in the manual Process Control System PCS 7; SIMATIC Route Control.
5.1 Failure and replacement of bus components

5.1.1 Replacement of SIMATIC components in runtime

Continuous operation

A crucial factor for continuous operation of fault-tolerant process control systems is the replacement of faulty or failed components in runtime. Replacement of defective components is only possible if fault-tolerant components are used. The redundant components continue to operate and supply the function until the replacement is made. The system is no longer fault-tolerant in this condition.

Which components can be replaced in central controllers?

The following components in a redundantly configured automation system can be replaced in runtime:

- Central processing units (e.g., CPU 417-4H)
- Power supply modules (e.g., PS 405, PS 407)
- Communication modules
- Synchronization modules and fiber-optic cables
- Interface modules (e.g., IM 460, IM 461)

Which components of the distributed I/O can be replaced?

The following components in a redundantly configured distributed I/O system can be replaced in runtime:

- DP master (CPU or CP in the AS)
- DP slaves (for example, ET 200M, ET 200iSP)
- Redundant interface modules (for example, IM 153-2 and IM 152-1)
- Input/output modules
- PROFIBUS DP cables

Additional information

You can find detailed, step-by-step instructions on the procedure for replacing components in runtime in the manual Automation System S7-400H; Fault-tolerant Systems.

The following table is an overview of the descriptions:
Component Replacement and Plant Changes

5.1 Failure and replacement of bus components

<table>
<thead>
<tr>
<th>For the procedure used to replace components ...</th>
<th>... refer to the manual Automation System S7-400H; Fault-tolerant Systems in section ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central racks</td>
<td>Failure and replacement of a CPU (redundant CPU)</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of a power supply module</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of a communication processor</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of a synchronization module or FO cable</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of an IM 460 and IM 461 interface module</td>
</tr>
<tr>
<td>Distributed I/O</td>
<td>Failure and replacement of distributed I/O components</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of an input/output or function module</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of a PROFIBUS DP master</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of a redundant PROFIBUS DP interface module</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of a PROFIBUS DP slave</td>
</tr>
<tr>
<td></td>
<td>Failure and replacement of PROFIBUS DP cables</td>
</tr>
</tbody>
</table>

**Note**

After every component replacement

Make sure that all systems are free from faults and that the H-system is operating redundantly and without errors.

5.1.2 Replacement of bus components in runtime

**Introduction**

The information in this section relates to the following bus components

- Bus cable
- Switches, hubs, bridges

**Failure and replacement of bus components**

Components of a bus system (plant bus, terminal bus, PROFIBUS) can be replaced when there is no risk of accidentally affecting other components as a result of the replacement.

Before making a replacement, the following aspects must be taken into consideration:
Bus topology (for example ring structure, spur lines, redundancy connections, disrupted bus cable)

Connection of the bus system to "master systems“:
  – The assignment of clients to servers
  – The connection to time master systems
  – The connection to domain controllers
  – For PCS 7 OS: The setting of preferred servers

Other disrupted components

**Recommended procedure**

If a bus component is partially functional, we recommend the following procedure:

- If repairs are necessary, first replace the defective bus cable.
- Insert a new bus component into the existing system before you remove the old bus component completely.
- Avoid the occurrence of double faults.
- Replace the connection to the connected components in series (not at the same time).

**5.1.3 Replacement of operator stations in runtime**

**Replacement of operator stations**

When replacing operator stations, a distinction must be made between:

- Replacing an OS server
- Replacing an OS client

**Note**

Information on updating operator stations with redundant OS servers in runtime can be found in "guidelines on updating a redundant OS in runtime (Page 191)".

**Requirements**

- The new PC contains the same hardware components.
- An image of the PCs to be replaced is used for the installation.
- The name of the replaced PC is used for the new PC.
- The same IP address is used for the new PC.
- The MAC address is adapted in the project.
Replacing an OS server

Follow the steps below to replace an OS server:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Switch OS clients over to the server that will be remaining in operation.</td>
</tr>
<tr>
<td>2</td>
<td>Deactivate and replace the OS server.</td>
</tr>
<tr>
<td>3</td>
<td>Check the network addresses and download the configuration data.</td>
</tr>
<tr>
<td>4</td>
<td>On the engineering station: Download OS server data (and automatic redundancy update).</td>
</tr>
<tr>
<td>5</td>
<td>Start WinCC.</td>
</tr>
<tr>
<td>6</td>
<td>Activate process mode.</td>
</tr>
<tr>
<td>7</td>
<td>Activate or switch over assigned OS clients.</td>
</tr>
</tbody>
</table>

Replacing an OS client

Follow the steps below to replace an OS client:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Deactivate process mode.</td>
</tr>
<tr>
<td>2</td>
<td>Deactivate and replace the OS client.</td>
</tr>
<tr>
<td>3</td>
<td>Check the network addresses and download the configuration data.</td>
</tr>
<tr>
<td>4</td>
<td>On the engineering station: Download target system (OS client).</td>
</tr>
<tr>
<td>5</td>
<td>Activate process mode.</td>
</tr>
</tbody>
</table>

Changing to a new PCS 7 version

You can find information on how to convert all operator stations of a redundant system to a new PCS 7 version in the manual Process Control System PCS 7; Software Update without Utilization of New Functions

5.1.4 Replacement of BATCH stations in runtime

Replacement of BATCH stations

When replacing BATCH stations, a distinction must made between:

- Replacing a BATCH server
- Replacing a BATCH client

Requirements

- The new PC contains the same hardware components.
- An image of the PCs to be replaced is used for the installation.
- The name of the replaced PC is used for the new PC.
The same IP address is used for the new PC.
- The MAC address is adapted in the project.

### Replacing the BATCH server

Follow the steps below to replace a BATCH server:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Replace the BATCH server.</td>
</tr>
<tr>
<td>2</td>
<td>On the engineering station: Open the BATCH configuration dialog, select PCell, download BATCH server.</td>
</tr>
<tr>
<td>3</td>
<td>Start the BATCH server (BATCH server starts up as standby server).</td>
</tr>
</tbody>
</table>

### Replacing the BATCH client

Follow the steps below to replace a BATCH client:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Close the BATCH Control Center.</td>
</tr>
<tr>
<td>2</td>
<td>Replace the BATCH client.</td>
</tr>
<tr>
<td>3</td>
<td>On the engineering station: Open the BATCH configuration dialog, select PCell, download BATCH client.</td>
</tr>
<tr>
<td>4</td>
<td>Open the BATCH Control Center.</td>
</tr>
</tbody>
</table>

### 5.1.5 Replacement of Route Control stations in runtime

#### Replacement of Route Control stations

When replacing Route Control stations, a distinction must made between:

- Replacing a Route Control server
- Replacing a Route Control client

#### Requirements

- The new PC contains the same hardware components.
- An image of the PCs to be replaced is used for the installation.
- The name of the replaced PC is used for the new PC.
- The same IP address is used for the new PC.
- The MAC address is adapted in the project.
Replace the Route Control server.

Follow the steps below to replace a Route Control server:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Replace the Route Control server.</td>
</tr>
<tr>
<td>2</td>
<td>On the engineering station: Open Route Control Engineering and download the Route Control server</td>
</tr>
<tr>
<td>3</td>
<td>Start Route Control (Route Control starts as standby server).</td>
</tr>
<tr>
<td>4</td>
<td>Update the Route Control servers using the Route Control Center, so that both Route Control servers operate with the same database.</td>
</tr>
</tbody>
</table>

Replacing the Route Control client

Follow the steps below to replace a Route Control client:

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Close the Route Control Center.</td>
</tr>
<tr>
<td>2</td>
<td>Replacing the Route Control client.</td>
</tr>
<tr>
<td>3</td>
<td>On the engineering station: Download Route Control client from the SIMATIC Manager or Route Control Engineering.</td>
</tr>
<tr>
<td>4</td>
<td>Open the Route Control Center.</td>
</tr>
</tbody>
</table>

5.2 Plant changes in runtime

Plant changes in runtime

In addition to the options for replacing failed components in runtime as described in the section titled "Failure and replacement of components during operation", the CPU (41x-xH) also supports a system modification without interrupting the running program.

Requirements

- The relevant hardware components are suitable for insertion and removal under voltage.
- The H system with CPU is available. Firmware versions:
  - CPU 412-3H, 414-4H or 417-4H as of firmware version V2.0.0
  - CPU xxx-5H PN/DP (xxx = 412; 414; 416; 417) as of firmware version V6.0.0
Use cases for plant changes

A plant change in which the hardware of the plant is changes occurs in the following cases:

- Hardware components of a fault-tolerant system are removed.
- Hardware components of a fault-tolerant system are added.
- Hardware components of a fault-tolerant system are replaced by non-identical components.

Plant modification always requires a software modification. Configuration changes are made in HW Config and downloaded to the CPU. The modified hardware is physically replaced, removed or added.

Similar to the events that occur when components are replaced, when the system is modified in runtime, the functions of the modified components are taken over by the corresponding redundant components. The running program is not interrupted.

Which components can be changed?

<table>
<thead>
<tr>
<th>changes</th>
<th>Possible modifications</th>
</tr>
</thead>
</table>
| Changes in the CPU | • Editing CPU Parameters  
| | • Changes to the memory components of the CPU |
| Adding for removing modules in central racks | • Communication modules  
| | • Interface modules (for example, IM 460, IM 461), in de-energized state only |
| Adding or removing modules components in distributed I/O modules | • DP slaves with redundant interface modules (for example, ET 200M, DP/PA Link, Y Link)  
| | • Non-redundant DP slaves in any DP master system  
| | • Modules in modular DP slaves  
| | • DP/PA Coupler  
| | • PA devices (process automation)  
| | • Use of a free channel or reassignment of a utilized channel on an existing module |
| Changing the parameters settings for a module | • Editing parameters |
5.2 Plant changes in runtime

Additional information

You can find detailed, step-by-step instructions on the procedure for plant changes in runtime in the manual Automation System S7-400H; Fault-tolerant Systems.

Note

Note the following information:

- The procedures described for PCS 7 can be found in the Automation System S7-400H; Fault-tolerant Systems manual, "Modifying the System During Operation" section.
- Make sure that all systems are free from faults and that the H-system is operating redundantly and without errors after any modification to the plant.
- If you violate one or more rules in this procedure, the fault-tolerant system may respond in ways that restrict its availability, up to and including failure of the entire process control system.

The following table is an overview of the descriptions. The procedures described for making changes in runtime assume that the system is designed redundantly and that your aim is to achieve this again.

| For the procedure used to replace components ... | ...refer to the manual Automation System S7-400H; Fault-tolerant Systems in section ...
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Components</td>
<td>Adding Components in PCS 7</td>
</tr>
<tr>
<td></td>
<td>Removing Components in PCS 7</td>
</tr>
<tr>
<td></td>
<td>Changes to the memory components of the CPU</td>
</tr>
<tr>
<td>Parameter</td>
<td>Editing CPU Parameters</td>
</tr>
<tr>
<td></td>
<td>Changing the parameters settings for a module</td>
</tr>
</tbody>
</table>
Failure, Switchover and Return of Fault-tolerant Components

6.1 I/O

6.1.1 Failure of redundant interface modules

Functionality

Interface modules can be configured redundantly in the distributed I/O device (ET 200M, ET 200iSP). The interface modules provide the interface to the automation system through the PROFIBUS DP. When there are two interface modules, in other words, the system has been configured with "Redundancy", if one of the two modules fails, the other interface module takes over the automation process without interruption.

Failure

If the active interface module fails, there is a bumpless failover to the redundant interface module. In the failover, the master identification changes from the failed interface module to the interface module that is now active.

If the redundant interface module fails, the master identification does not change.

Hot restart

When the failed interface module restarts, the redundant interface module keeps the master identification. The master identification changes back to the now replaced or repaired module only if the redundant interface module fails.

6.1.2 Failure of redundant I/O modules

Functionality

As soon as an error occurs in one of the redundantly configured modules, there is a bumpless failover to the second module, which then takes over the signal processing.
Failure scenarios

The following faults may occur in a module:

- Hardware or power failure in the module
- Detected signal interference (e.g. wire break, discrepancy)
- Fault on the assigned bus line to an interface module

The driver blocks detect a disturbance:

- At the input signals:
  The disturbed input module or, when channel selectivity is configured, the disturbed channel is passivated and only the signal of the redundant modules is evaluated. A module or channel is passivated when the function blocks can no longer access the respective module or channel.

- At analog output modules:
  Only analog output modules with power outputs can be operated redundantly (0 to 20 mA, 4 to 20 mA). The value to be output is halved and each module outputs one half of the value. If one module fails, the redundant module outputs the entire value.

Discrepancy with input modules

A discrepancy error at the input value occurs when there is a non-tolerated difference between the input values after the configured discrepancy time has expired. The following parameters should be set to configure the discrepancy:

- For digital input modules:
  - Discrepancy time (maximum allowed time that the redundant input signals can differ)

- For analog input modules:
  - Tolerance window (configured by the percent of the end value of the measuring range)
  - Two analog values are the same if they are within the tolerance window.
  - Discrepancy time (maximum allowed time that the redundant input signals are outside the tolerance windows)
  - Value applied
    The value applied is one of the two analog input values that is transferred in the user program.

With discrepancy, information is entered in the diagnostics buffer and a corresponding message is generated.

Depassivation

Passivated modules or, when channel selectivity is configured, passivated channels are depassivated with the following events:

- When the H system starts up
- When operating state of the H system changes to "Redundant"
- Following a system modification in runtime
- Following depassivation via the maintenance station
6.2 Automation system

6.2.1 Failure of the master CPU

Functionality

The initial situation is that the S7-400H is in "Redundant" system mode. The processing of the user program is synchronized on both CPUs of the H system and, for example, CPU0 is the master CPU and CPU1 is the backup CPU. Event-driven synchronization ensures that the backup CPU will always continue processing without interruption if the master CPU fails.

Example: Failure of the master CPU

If CPU0 fails, for example, the following LEDs light up on CPU1:

- REDF = Redundancy loss
- IFM1F = Interface fault interface module 1
  This indicates the first fiber-optic cable of the synchronization line.
- IFM2F = Interface fault interface module 2
  This indicates the second fiber-optic cable of the synchronization line.

The H system switches to "Solo" system mode. CPU1 ensures uninterrupted processing of the user program. CPU1 is now the master CPU. The H system is no longer in "Redundant" system mode.

Example: Reintegration of the failed master CPU

When the failed CPU0 is reintegrated, it does not become the master CPU. The master CPU automatically performs the link-up and update of the reintegrated CPU0. Both processes are necessary in order to check and synchronize the data in the memory of the master CPU and the backup CPU. CPU0 then goes to RUN mode. Now the system is once again in "Redundant" mode.
6.2.2 Failure of a fiber-optic cable

Requirements for the example

- The S7-400H is in "Redundant" system mode in the starting scenario.
- The CPU in Rack 0 is the Master CPU and the CPU in Rack 1 is the backup CPU.
- The mode selectors of both CPUs are set to RUN.

Example: Failure of a fiber-optic cable

If a fiber-optic cable fails, the REDF LED and the IFM1F or IFM2F LED light up on the two CPUs depending on the location of the fiber-optic cable failure. The H system goes to "Solo" system mode and the user program continues to be processed by the master CPU used up to this point (CPU0).

Example: Reintegration of the CPU in rack 1

Once the defective fiber-optic cable has been replaced and connected to both CPUs, you must restart the backup CPU that is in STOP mode, i.e., CPU in Rack 1.

There are several options available to you:
You have access to the automation system:
Turn the key switch on the failed CPU from its current position to STOP back to the setting (RUN).

You have an Ethernet connection to the H system:
In the “Operating Mode” dialog box, restart the CPU in Rack 1, which is in STOP mode.
- Open the PCS 7 project on an ES, click the “Online” icon in the task bar of SIMATIC Manager and select a CPU in the right window pane.
- Open the shortcut menu with a right click and open the “Operating Mode” dialog box with the menu command PLC > Operating Mode.
- Select the CPU in Rack 1 and click “Warm restart”. The CPU in Rack 1 links up again and performs an update. The system is then in “Redundant” mode again.
6.3 Communication

6.3.1 Failure of redundant bus components

Functionality
As soon as a fault occurs on a transmission path, the second transmission path takes over and forwards the signals.

Failure scenarios
The following problems can occur on a bus component:
- Defective bus component (e.g., CP, coupler, AFD, AFS, cable)
- Problem on a bus line (e.g., overload, wire break)

Additional information
- Manual SIMATIC Net Twisted Pair and Fiber-Optic Networks
- Manual SIMATIC NET; Industrial Ethernet OSM/ESM
- Manual SIMATIC Net PROFIBUS Networks

Result
When the CPU in Rack 1 is back online, the "Operating mode" dialog box appears as follows:
6.4  OS server

6.4.1 Failure, failover and restarting of redundant OS servers

Introduction
This section describes the criteria by which the master/standby identification of an OS server changes. Examples are given to illustrate how the system reacts to failures.

Note
Information on updating operator stations with redundant OS servers in runtime can be found in "guidelines on updating a redundant OS in runtime (Page 191)".

Fault scenarios

- The project is not activated on the redundant OS partner server.
- The network connection from the OS server to the redundant OS partner is disrupted.
- The network connection to the OS clients is disrupted.
- The process connection to the AS is disrupted.
- The PC station is not operating correctly.

Reaction of WinCC redundancy to possible faults
WinCC redundancy can react to faults, errors or error messages in the following ways:

- By saving events and the time they occurred
- By synchronizing the archives of the process data (Tag Logging), the message data (Alarm Logging) and the user data (User Archives) with the archive data of the active OS server when the failed server comes back online.
- By changing the system tags "@RM_MASTER" and "@RM_MASTER_NAME" according to the situation.
6.4 OS server

- By automatically interconnecting the OS clients to the preferred server or to the available OS server with master identification. The "@RM_SERVER_NAME" tag on an OS client indicates the OS server to which this OS client is currently connected.

- By generating process control messages in the message list.

The fault scenarios listed above and the resulting reactions by WinCC Redundancy are described in the following.

Example configuration

![Diagram of OS server pair configuration]

Startup of an OS server pair

The following applies, in general: An OS server pair consists of the OS server and its OS partner server. The two PCs are configured with WinCC Redundancy in a redundant grouping.

When the OS server pair starts up, WinCC Redundancy first checks which of the two OS servers is to be assigned the master identification. This depends on which OS server starts up first.

- If one OS partner server is active already when the other comes online, the second OS server receives the standby identification.

- If no other OS server is active when an OS server starts up, it is assigned the master identification.

The internal WinCC tag @RM_MASTER is set to identify the master OS server. The internal WinCC tag @RM_MASTER is reset to identify the standby OS server.
The "@RM_MASTER_NAME" tag contains the name of the OS server, for example, "Server 1". You can display this tag, for example, in an I/O field of a Graphics Designer picture. Other applications or scripts can also evaluate these tags. The "@RM_MASTER" tag can also be changed.

WinCC project is deactivated

A functionally equivalent WinCC project is activated on both OS servers. If the WinCC project is deactivated on OS Server 1 (master identification), WinCC Redundancy triggers the following reactions:

- OS Server 2 (standby identification) saves the time of the failure (date and time of day) of OS Server 1 (master identification).
- OS Server 2 reports the failure of OS Server 1 with a process control message in the process control list.
- OS Server 2 now takes over the role of the master by setting the @RM_MASTER tag. The @RM_MASTER_NAME tag is changed accordingly.
- If the WinCC project is activated again on OS Server 1, OS Server 1 is set as the standby and the @RM_MASTER tag is reset. The @RM_MASTER_NAME tags are changed accordingly.

Gaps in the archive data occur on OS Server 1 during the time it is inactive. As soon as OS Server 1 returns, the gaps in the data are remedied by the following measures:

- OS Server 2 saves the date and the time of day, marking the return of OS Server 1.
- OS Server 2 reports the return of OS Server 1 with a process control message in the message list.
- The data gaps in the message, process data and user archives of OS Server 1 are filled by the data from the OS Server 2 memory. Conditions: The options "Synchronization of Tag Logging after the partner server comes back online" and "Synchronization of Alarm Logging after the partner server comes back online" must be enabled in the "Redundancy" dialog box for this.
- The @RM_MASTER tags remain unchanged in both servers;
  - OS Server 2 keeps the master identification.
  - The @RM_MASTER tag remains set.
  - The @RM_MASTER tag for OS Server 1 is reset.
Disrupted network connection to the OS partner server

A disrupted network connection is only detected in the redundancy scheme when:

- There is a fault in the spur line.
- There is a defective connector or network adapter.
- A PC station is identified as faulty.

The terminal bus as a whole and the communication between the AS and OS servers remains unaffected.

Both OS servers are started and begin processing an activated WinCC project. If a disruption in the network connection to the OS partner server occurs in this situation, WinCC Redundancy reacts as follows:

- Both OS servers save the date and time of day of the failure.
- Both OS servers report the failure with a process control message in the message list.
- If the disrupted OS server is a master, the master/standby identification changes.

During the connection failure no online synchronization for alarm logging, operation messages and user archives can be performed between the two OS servers. As soon as the connection is restored, this is remedied by following actions:

- Both OS servers save the date and time of day of the restored connection.
- Both OS servers report the return with a process control message in the message list.
- Data from the alarm logging, tag logging and the user archives accumulated during the connection failure are transmitted to the returning OS server.
- The @RM_MASTER and @RM_MASTER_NAME tags remain unchanged in both servers.

Disrupted network connection between the OS client the OS server

An OS server and the OS client connected to it are processing an activated WinCC project. A redundant OS partner server has been configured for the OS server in WinCC Redundancy. The OS server is defined as the preferred server for the OS client. A disrupted network connection to the OS server may result from a cable break in the spur line from the network to the OS server. The terminal bus as a whole remains unaffected.

If a connection failure occurs between the OS client and the OS server, WinCC Redundancy triggers the following reactions:
- The OS client is not switched over from the failed OS server to its redundant OS partner server because the OS server is not available.
- When the failed OS server is available once again to the OS client, the OS client automatically switches back to its preferred server.

**Disrupted network connection to the AS**

If a fault occurs on the plant bus connection between the OS server and the AS, WinCC Redundancy reacts as follows:

- The disruption of the plant bus connection is reported to the OS partner server.
- The OS partner server receives the message that the OS server has failed.
- The OS partner server saves the date and the time of day of the OS server failure.
- An OS client is automatically switched over from the failed OS server to its redundant OS partner server. Condition: The "WinCC client switch in case of a process connection error" option must be selected in the "Redundancy" dialog box for this.

When the process connection to the OS server is restored, the missing data in the archive of the OS server is updated by the procedure described below. Condition: The "Synchronization after process connection error" option must be selected in the "General" tab of the "Redundancy" dialog box for this.

- The OS partner server saves the date and the time of day marking the return of the OS server.
- The data gaps in the archives of the failed OS server are updated by the data from the memory of the OS partner server. The process data of all automation systems (even those that have not failed) are synchronized.
- When the process connection is restored, this is announced by a process control message in the message list.

**PC station identified as faulty**

In PCS 7, the PC stations are preset in such a way that the network adapters are automatically deactivated when a PC station is identified as faulty. Depending on the Autostart settings, a manual reboot is required or an automatic reboot of the server is triggered.

---

**Note**

**Terminate process mode on redundant systems**

If the process mode of the PC station is to be terminated manually and the redundancy partner of the PC station is not available, a corresponding message points out this situation. In this case, you can cancel the process for terminating process mode. These actions are logged.
6.5 BATCH Server

6.5.1 Reaction of BATCH servers to failure

Functionality

BATCH applications and any configured WinCC applications are active on BATCH servers. A BATCH client visualizes the batch data of the BATCH server to which it is connected.

Failure of the master BATCH server

If the master BATCH server fails, for example, due to an operating system failure or an application error, the standby BATCH server detects that the master is no longer available based on redundancy mechanisms and takes over the master role. The BATCH clients are then automatically switched over from the master BATCH server to the standby BATCH server.

The running BATCH program is automatically resumed after the failover to the redundant BATCH server. The BATCH program status is synchronized between the active BATCH server and the AS. You have to manually trigger the BATCH program to continue if communication errors have occurred.

In a replication solution, the databases on the master BATCH server and the standby BATCH server are continually synchronized. If the BATCH servers switch over, the new active BATCH server always has access to the latest BATCH data.

NOTICE

Data reliability

During the failover from the failed BATCH server to its redundant BATCH server, no automation process data are visualized on a BATCH client. Operator inputs are also lost during this brief period.

PC station identified as faulty

Additional information on this is available in the section "Failure, failover and restarting of redundant OS servers (Page 181)".
6.6 Route Control server

6.6.1 Reaction of Route Control servers to failure

Functionality
Route Control applications and any configured WinCC applications are active on Route Control servers. A Route Control client visualizes the route list of the Route Control server to which it is interconnected.

Failure of the master Route Control server
If the master Route Control server fails, for example, due to failure of the operating system or failure in an application, the standby Route Control server recognizes that the master is no longer available based on redundancy mechanisms and takes over the role of master. The new master automatically assumes all control functions of the running route control program, even of routes already requested. The visualization continues, since the Route Control clients automatically switch to the new master.

The status is synchronized between the active Route Control server and the AS. If communication errors occurred, the Route Control program can only be continued manually.

NOTICE

Data reliability
During the failover from the failed Route Control server to its redundant Route Control server, no data from the automation process is visualized on a Route Control client. Operator inputs during this failover time are neither accepted nor executed.

Operation of a route via a Route Control faceplate from a PCS 7 OS is possible during redundancy failover of a Route Control server, if there is a communications connection between PCS 7 OS and the automation system.

Activating process mode of Route Control servers

Note
Please note that you need to activate process mode for redundant Route control servers one after the other. One of the two Route Control servers will take on the property of Master server, depending on the configuration.
PC station identified as faulty
Additional information on this is available in the section "Failure, failover and restarting of redundant OS servers (Page 181)".

Additional information
- Manual Process Control System PCS 7; SIMATIC Route Control

6.7 OS clients

6.7.1 Failover reactions of OS clients with permanent operability

Functionality
If the network for the configured OS server is interrupted, the process values on the OS clients are no longer updated and process control is no longer possible. Other OS clients connected to the redundant OS partner server are not affected by this. The plant operator can therefore switch to these OS clients, if needed.

Example configuration
Permanent operability

If OS Server 1 fails, OS Client 1 is connected to redundant OS Server 2. The identity of the redundant partner server of OS Server 1 comes from the downloaded server data on the OS client. OS Client 1 is not available during the failover to redundant OS Server 2. However, if redundant OS Server 2 is specified as the preferred server for OS Client 2, you can continue to operate the plant during the failover from the failed OS Server 1 to redundant OS Server 2.

Once OS Server 1 becomes available again, OS Client 1 is connected to the returning OS Server 1 because it is the configured preferred server.

Permanent operability is restored after the failover is complete. OS Client 1 is not available for the duration of the failover to OS Server 1. OS Client 2 remains operable.

The status of the "@RM_Master" redundancy tag does not apply to the OS client with preferred server configuration. The @RM_SERVER_NAME tag indicates the OS server to which this OS client is currently connected.

Note

Information on updating operator stations with redundant OS servers in runtime can be found in "guidelines on updating a redundant OS in runtime (Page 191)".

Reaction of an OS client without a preferred server

If no "preferred server" is configured for the OS client in the "Configure Server Data" dialog box, the OS client connects to the OS server of a redundancy configuration for which the "@RM_Master" redundancy tag is set.

If the active OS server fails, its redundant OS partner server becomes the master server. You can recognize which of the two redundant OS servers is currently acting as the master server by the status of "@RM_Master" redundancy tag. You can trigger a manual switchover by setting or resetting this tag. All OS clients then connect to the "new" master server.

Failover criteria of the OS client

The following faults trigger an OS client failover. It is not relevant here whether or not a preferred server has been configured.

- The network connection to the redundant OS server is disrupted.
- The redundant OS server fails, e.g., due to power loss.
- The WinCC project of the redundant OS server is deactivated.
- A disruption of the network connection between OS server and AS, when the option "WinCC client switch in case of a process connection error" is selected in the "Redundancy" dialog box.
Additional information

- Online help for WinCC

6.8 BATCH clients

6.8.1 Failover reactions of BATCH clients

Functionality

If the master BATCH server fails, the BATCH clients automatically switch to the redundant BATCH server.

Reactions during failover

During a failover, a message window is displayed on the screen of the BATCH client indicating the failover. The BATCH client cannot be operated during this time. The message window closes and the BATCH client can be operated only when the failover from the failed BATCH server to the redundant BATCH server is complete.

Additional information

- Manual Process Control System PCS 7; SIMATIC BATCH

6.9 Route Control clients

6.9.1 Failover reaction of Route Control clients

Functionality

If the master Route Control server fails, the Route Control clients are automatically switched over to the redundant Route Control server.

Reactions during failover

During a failover, a message window is displayed on the screen of the Route Control client indicating the failover. The Route Control client cannot be operated during this time. The
message window closes and the Route Control client can be operated again only when the failover from the failed Route Control server to the redundant Route Control server is complete.

Note
The route can be controlled from a Route Control faceplate during the switchover of a Route Control server.

Additional information
- Manual Process Control System PCS 7; SIMATIC Route Control

6.10 Guidelines for updating a redundant OS in runtime

6.10.1 Introduction

Introduction
Below, you will find guidelines for updating a redundant OS in runtime. This means that the operation of the PCS 7 system is not disrupted, the AS does not change to STOP mode and the automation process can continue to be operated and monitored.

Requirements
- The redundant OS is made up of the following components:
  - Redundant OS server
  - OS clients
- The PCS 7 version is at least PCS 7 V7.1.3.

Information on updating the PC stations and project data
You can find information on updating the PC stations and project data in the Process Control System PCS 7; Software Update without Utilization of the New Functions documentation.

Rules

⚠️ CAUTION
Make sure that you keep to the described order to avoid disrupting operation of the PCS 7 system.
Checking time synchronization

To avoid any jumps in time (UTC/local standard time) when "updating redundant systems in runtime", check the time synchronization of the OS in the updated PCS 7 project on the ES:

1. Open SIMATIC Manager.
2. Select the OS in the component view.
3. Select the menu command Edit > Open Object.
   WinCC Explorer opens.
4. Click the "Computer" object in the tree view.
5. Select the menu command Edit > Properties.
   The "Computer Properties" dialog box opens.
6. Select the "Parameters" tab.
7. In the "PLC Clock Setting" group, activate the "PLC is set to coordinated universal time (UTC)" check box.

Objectives of the update

- The automation system remains uninterrupted in RUN mode.
- The process remains controllable at all times.

Sequence of the Update

Updating involves five phases:

<table>
<thead>
<tr>
<th>Phase</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase 1</td>
<td>Updating Server_2 (Page 196)</td>
</tr>
<tr>
<td>Phase 2</td>
<td>Updating the OS clients interconnected with Server_2 (Page 199)</td>
</tr>
<tr>
<td>Phase 3</td>
<td>Downloading the connections, gateways and changes to the AS (Page 201)</td>
</tr>
<tr>
<td>Phase 4</td>
<td>Updating the OS clients interconnected with Server_1 (Page 202)</td>
</tr>
<tr>
<td>Phase 5</td>
<td>Updating Server_1 (Page 204)</td>
</tr>
</tbody>
</table>
The procedure described below must be repeated for all client-server relationships in the system, as appropriate.

- If you have several redundant servers, first update only the clients interconnected with the standby server that has already been updated or that has been defined as the preferred server for these clients.
- Then update the clients that are interconnected with the master server or that have defined it as their preferred server.

Figure 6-1 The numbering shows the sequence for the update.

### 6.10.2 Overview of the required tasks

**Introduction**

You update the redundant OS in runtime in five phases. Each phase is broken down into individual steps.

The section shows you an overview of the steps required in the five phases. You will find more detailed instructions for each phase in the following sections.
### Initial situation

- Server_1 is master server.
- Server_2 is standby server.
- Client_1 is connected to Server_1 because this server is configured as its preferred server. Client_1 represents all OS clients connected to Server_1.
- Client_2 is connected to Server_2 because this server is configured as its preferred server. Client_2 represents all OS clients connected to Server_2.

### Requirements

- Process Mode of the Maintenance Client was ended before the ES was updated.
- The update of the PCS 7 project for the ES is complete.
- If the Maintenance Station is used, SIMATIC PDM is installed on the ES.
- All the settings for the configured mode have been made. The configuration data has been loaded onto the ES from NetPro.
- All OS servers and all OS clients are running with PCS 7 V7.1.3. or higher.

### Overview of the required tasks

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform the steps described from Phase 1 to Phase 5 without extended interruptions because the redundancy is not available during the update.</td>
</tr>
<tr>
<td>Phase</td>
</tr>
<tr>
<td>-------------------------------</td>
</tr>
<tr>
<td>Phase 1: Updating Server_2</td>
</tr>
<tr>
<td>Phase 2: Updating the OS clients which are interconnected with Server_2</td>
</tr>
<tr>
<td>Phase 3: Downloading the connections, gateways and changes to the AS</td>
</tr>
</tbody>
</table>
Phase 4: Updating the OS clients which are interconnected with Server_1

1. Client_1: Deactivate and exit WinCC
2. Client_1: Backup of the PCS 7 project
   backup of the operating system and of the PCS 7 software installation
3. Client_1: Installation or update of the operating system, PCS 7 Installation “OS client”
4. ES: Download of OS target system
5. Client_1: Selecting the operability of the clients

Phase 5: Updating Server_1

1. Server_1: Deactivate and exit WinCC
2. Client_1: Activate
3. Server_1: Backup of the PCS 7 project
   backup of the operating system and of the PCS 7 software installation
4. Server_1: Installation or update of the operating system, PCS 7 Installation “OS server”
5. ES: Download OS connection data and OS target system
6. Server_1: Start WinCC
7. Server_1: Check and save the “Redundancy” dialog box
8. Server_1: Check and save the “Time Synchronization” dialog box
9. Server_1: Activate WinCC Runtime
10. Other redundant OS server pairs:
    Carry out Phase 5: Steps 1 to 9
11. ES: Starting SIMATIC PDM.

Result

When you have completed all the steps, your system has the following status:

- Updated Server_1 is standby server.
- Updated Server_2 is master server.
- Updated Client_1 is connected to its preferred server Server_1.
- Updated Client_2 is connected to its preferred server Server_2.

The updating of your redundant operator stations is complete.

6.10.3 Phase 1: Updating Server_2

Introduction

In the first phase, you update redundant Server_2. In this way, you avoid an unnecessary failover for OS clients that have no preferred server configured.

You can find additional information about redundancy synchronization in *WinCC Information System > Configurations > Redundant Systems.*
During the steps involved in Phase 1, your system continues to work with only one server. The system remains controllable from the OS clients that have not yet been updated. If this server fails, the automation system can no longer be controlled.

**CAUTION**
Perform the steps without extended interruptions because the redundancy is not available during the update.

### Initial situation before phase 1
- Server_1 is master server.
- Server_2 is standby server.
- Client_1 is connected to Server_1.
- Client_2 is connected to Server_2 because this server is configured as its preferred server.

### Requirements
- The PCS 7 project you are updating has already been updated on the ES.
- When using an archive server:
  - If you are using "StoragePlus", ensure that the archive server is closed. We recommend that you switch to an external archive server.
  - Synchronization of the archive must be complete to ensure that the process data (RT data) are consistent.

### Procedure - Phase 1
Note that you will need to work alternately on Server_1 and Server_2.

**Phase 1 / 1. Server_2: Deactivate and exit WinCC**
- Deactivate WinCC Runtime and exit WinCC on the standby Server_2. The system reacts as follows:
  - Client_1 remains interconnected with Server_1.
  - Client_2, which has Server_2 configured as the preferred server, changes over to Server_1.
  - Server_1 detects a failure due to Server_2 being deactivated. If you have configured system messages, Server_1 generates a process control message to this effect.

**Phase 1 / 2. Server_2: Backup of the PCS 7 project; backup of the operating system and of the PCS 7 software installation**
- Back up your previous operating system, the previous PCS 7 software installation and your current PCS 7 project as a fallback strategy.

**Phase 1 / 3. Server_2: Installation or update of the operating system, PCS 7 Installation "OS server"**
• Install or update the operating system (information is available in the manual *Process Control System PCS 7; PC Configuration and Authorization*). An OS server can only run on a server operating system which has been released for PCS 7. You can find additional information on this in the *Process control system PCS 7; PCS 7 Readme* documentation.

• Install the necessary PCS 7 components. In the PCS 7 Setup, select the "OS Server" check box in the "Program Packages" dialog box.

• Make the necessary settings.

Note that Windows administration of PCs should be performed by a Windows administrator. You can find a detailed description of the PCS 7 installation and the required PCS 7-specific settings for PC stations in the manual *Process Control System PCS 7; PC Configuration and Authorization*.

Phase 1 / 4. ES: Download OS connection data and OS target system

• Open *NetPro* and download the connection data from the ES to Server_2.

• Right-click on the OS to be transferred in the open PCS 7 project below the WinCC application. Select the menu command *PLC > Download to Current Project > Selected Station* in the shortcut menu. This starts the transfer from the ES to Server_2.

Phase 1 / 5. Server_2: Start WinCC

• Start WinCC on Server_2.

Phase 1 / 6. Server_2: Check and save the "Redundancy" dialog box

• Open the "Redundancy" editor and check the settings in the dialog box. Click "OK" to exit the dialog box even if you have made no changes.

Phase 1 / 7. Server_2: Check and save the "Time Synchronization" dialog box

• Open the "Time Synchronization" editor and check the settings in the dialog box. Click "OK" to exit the dialog box even if you have made no changes.

Phase 1 / 8. Client_2: Deactivate process mode and exit WinCC

• Deactivate the process mode on all clients where Server_2 is set up as preferred server.

**Note**

In WinCC Explorer (Server data), you can activate Server_1 for operation as preferred server for Client_2 within the phases 1 and 2. This setting retains operability of the clients.

Phase 1 / 9. Server_2: Activate WinCC Runtime

• Activate WinCC Runtime on Server_2. The system reacts as follows:
  – There is no server failover. Depending on the configuration, the activated Server_2 becomes the standby or master server.
  – All OS clients still receive their visualization data from OS server Server_1, which has not yet been updated.

Phase 1 / 10. Other redundant OS server pairs: Repeat steps 1 to 9
If you are using more than one redundant OS server pair, you must first update standby server Server_2 for each.

- Carry out the Phase 1 steps, 1 through 9 for each Server_2.

**Result after Phase 1**

- Server_2 is updated and not connected to any OS clients.
- Server_1 is the master server in the PCS 7 project being updated.
- Server_2 can be either master or standby, depending on the configuration.
- The archives will be synchronized between Server_1 and Server_2.
- Client_1 is connected to Server_1.
- Client_2 is either deactivated or interconnected with Server_1 after you have changed the preferred server setting. Client_2 cannot access the upgraded Server_2 as the preferred server.

### 6.10.4 Phase 2: Updating OS clients interconnected with Server_2

**Introduction**

In Phase 2, you update the OS clients that were interconnected with Server_2.

The system can be controlled at all times using Client_1, which is interconnected with the not-yet-updated Server_1.

The same PCS 7 version is running on the active OS server Server_1 and on Client_1. Mixed operation between OS clients and OS servers of different PCS 7 versions is not possible.

Archive data and messages that have accrued on OS server Server_1 during the update process are available on both OS servers. Synchronization of the archives is complete with the following message: "REDRT: <Name of the OS server> complete."

**CAUTION**

Perform the steps without extended interruptions because the redundancy is not available during the update.

**Initial situation before phase 2**

- Server_1 is master server in the PCS 7 project.
- The updated Server_2 is standby server in the updated PCS 7 project.
- Client_1 is connected to Server_1.
- Client_2 is either deactivated or interconnected with Server_1 after you have changed the preferred server setting. Client_2 cannot access the upgraded Server_2 as the preferred server.
Requirement

The PCS 7 project you are updating has already been updated on the ES.

Procedure - Phase 2

Phase 2 / step 1. Client_2: Backup of the PCS 7 project, of the operating system and of the PCS 7 software installation

- Back up your previous operating system, the previous PCS 7 software installation and your current PCS 7 project as a fallback strategy.

Phase 2 / 2. Client_2: Installation of the operating system, PCS 7 Installation "OS client"

- Install or update the operating system (information is available in the manual Process Control System PCS 7; PC Configuration and Authorization). An OS client can only run on an operating system which has been released for PCS 7. You can find additional information on this in the Process Control System PCS 7; PCS 7 Readme documentation.
- Install the necessary PCS 7 components. In the PCS 7 Setup, select the "OS Client" check box in the "Program Packages" dialog box.
- Make the necessary settings.

Note that Windows administration of PC stations should be performed by a Windows administrator. You can find a detailed description of the PCS 7 installation and the required PCS 7-specific settings for PC stations in the manual Process Control System PCS 7; PC Configuration and Authorization.

Phase 2 / 3. ES: Download to OS target system

- Right-click on the OS to be transferred in the open PCS 7 project below the WinCC application. Select the menu command PLC > Download in the shortcut menu. This downloads the project for Client_2 from the ES to the relevant OS.

Phase 2 / 4: Client_2: Activate

- Start WinCC on Client_2.
- Activate WinCC Runtime.

The system reacts as follows:

- Client_2 connects with the upgraded Server_2.

Result after Phase 2

- Server_1 is master server in the PCS 7 project.
- The updated Server_2 is standby server in the updated PCS 7 project.
- Client_1 is connected to Server_1.
• Updated Client_2 is connected to its preferred server Server_2.
• The system can be controlled from all OS clients.

Note
Maintenance client
If Server_2 is the maintenance server (last OS server pair to be updated in the project), then the maintenance client (Client_2) can be started.
Maintenance client accesses to intelligent field devices are only possible after completion of the software update.

6.10.5 Phase 3: Downloading the connections, gateways and changes to the AS

Introduction
In Phase 3, connections, gateways and CFC charts are downloaded to the AS from NetPro by downloading changes only.

Initial situation before phase 3
• Server_1 is master server in the PCS 7 project.
• The updated Server_2 is standby server in the updated PCS 7 project.
• Client_1 is connected to Server_1.
• Updated Client_2 is connected to its preferred server Server_2.
• The system can be controlled from all OS clients.

Requirements
• The PCS 7 project you are updating has already been updated on the ES.
• Configuration of the automation systems ready for download. All AS are compiled.

Procedure - Phase 3

Phase 3 / 1. ES: Transfer NetPro connection data and gateways to the AS
• Open NetPro and select your AS. Select the menu command PLC > Download to Current Project > Connections and Gateways.
• Select the CPU you want to download to in the "Select Target Module" dialog box and exit the dialog box by clicking "OK".

Phase 3 / 2. ES: Download CFC charts to the AS
If there was no download to the AS during the project update, you will now need to download to the AS.
Select an AS in SIMATIC Manager.
Select the menu command CPU > Download.
Select the "Changes only" check box.

Note
If you select the "Include user data blocks" check box, the user data blocks on the AS are overwritten. You can find additional information in the online help for the "S7 Download" dialog box.

Close the dialog box by clicking "OK".
Repeat the steps for downloading to the AS for each AS in the project.

The system reacts as follows:
- The system can be controlled and monitored from all clients.

Result after Phase 3
- Server_1 is master server in the PCS 7 project.
- The updated Server_2 is standby server in the updated PCS 7 project.
- Client_1 is connected to Server_1.
- Updated Client_2 is connected to its preferred server Server_2.
- The system can be controlled from all OS clients.

6.10.6 Phase 4: Updating the OS clients interconnected with Server_1

Introduction
In Phase 4, you update the OS clients that are interconnected with Server_1.
The system can be controlled at all times using Client_2, which is interconnected with Server_2.

CAUTION
Perform the steps without extended interruptions because the redundancy is not available during the update.

Initial situation before phase 4
- Server_1 is master server in the PCS 7 project.
- The updated Server_2 is standby server in the updated PCS 7 project.
- Client_1 is connected to Server_1.
• Updated Client_2 is connected to its preferred server Server_2.
• The system can be controlled from all OS clients.

Requirement

The PCS 7 project you are updating has already been updated on the ES.

Procedure - Phase 4

Phase 4 / 1. Client_1: Deactivate and exit WinCC
• Deactivate WinCC Runtime and exit WinCC on OS Client_1.

Phase 4 / 2. Client_1: Backup of the PCS 7 project, of the operating system and of the PCS 7 software installation
• Back up your previous operating system, the previous PCS 7 software installation and your current PCS 7 project as a fallback strategy.

Phase 4 / 3. Client_1: Installation or update of the operating system, PCS 7 Installation "OS client"
• Install or update the operating system (information is available in the manual Process Control System PCS 7; PC Configuration and Authorization).
  An OS client can only run on an operating system which has been released for PCS 7. You can find additional information on this in the Process Control System PCS 7; PCS 7 Readme documentation.
• Install the necessary PCS 7 components.
  In the PCS 7 Setup, select the "OS Client" check box in the "Program Packages" dialog box.
• Make the necessary settings.

Note that Windows administration of PCs should be performed by a Windows administrator. You can find a detailed description of the PCS 7 installation and the required PCS 7-specific settings for PC stations in the manual Process Control System PCS 7; PC Configuration and Authorization.

Phase 4 / 4. ES: Download to OS target system
• Right-click on the OS to be transferred in the open PCS 7 project below the WinCC application.
• Select the menu command PLC > Download in the shortcut menu. This downloads the project for OS Client_1 from the ES to the relevant OS.

Phase 4 / 5. Client_1: Selecting the operability of the clients
Options:
• If all clients should remain operable, set the preferred server for Client_1 to Server_2. Client_1 is operable after you have completed Phase 4. After having updated Server_1 in Phase 5, change the server setting for Client_1 to preferred server = Server_1.
• If you do not need Client _1 to be operable during the software update, the preferred server for Client _1 does not have to be changed.
The system reacts as follows:

- Client_1 is connected to Server_2 or deactivated.

Result after Phase 4

- Server_1 is master server in the PCS 7 project.
- The updated Server_2 is standby server in the updated PCS 7 project.
- Client_1 is updated (deactivated or connected to Server_2).
- OS Client_2 is interconnected with its preferred Server_2.

6.10.7 Phase 5: Updating Server_2

Introduction

While you perform the steps in phase 5, your system runs only with Server_2. The system remains controllable from the OS clients that were updated in phases 2 and 4.

CAUTION

- Perform the steps without extended interruptions because the redundancy is not available during the update.

Initial situation before phase 5

- Server_1 is master server in the PCS 7 project.
- The updated Server_2 is standby server in the updated PCS 7 project.
- Client_1 is updated (deactivated or connected to Server_2).
- OS Client_2 is interconnected with its preferred Server_2.

Requirements

- The PCS 7 project you are updating has already been updated on the ES.
- Archive synchronization is complete. Message: "REDRT: <Name of the OS server> complete".
- If you are using storage (StoragePlus), make sure that storage is complete.
- Make sure that at least one updated OS client is interconnected with Server_2. If no OS client is interconnected with Server_2, your system is not controllable while you are updating Server_1.
Procedure - Phase 5

Phase 5 / 1. Server_1: Deactivate and exit WinCC
- Deactivate WinCC Runtime on Server_1.
- Exit WinCC on Server_1.
- Updated Server_2 is master server.

Phase 5 / 2. Client_1: Setting the preferred server
- If the preferred server for Client_1 is set to Server_2, carry out the following steps:
  - Close WinCC Runtime on Client_1.
  - Set the preferred server for Client_1 to Server_1.
  - Start WinCC on OS Client_1.
- Activate WinCC Runtime.

Phase 5 / 3. Server_1: Backup of the PCS 7 project, of the operating system and of the PCS 7 software installation
- Back up your previous operating system, the previous PCS 7 software installation and your current PCS 7 project as a fallback strategy.

Phase 5 / 4. Server_1: Installation or update of the operating system, PCS 7 Installation "OS server"
- Install or update the operating system (information is available in the manual Process Control System PCS 7; PC Configuration and Authorization).
  An OS server can only run on a server operating system which has been released for PCS 7. You can find additional information on this in the Process control system PCS 7; PCS 7 Readme documentation.
- Install the necessary PCS 7 components.
  In the PCS 7 Setup, select the "OS Server" check box in the "Program Packages" dialog box.
- Make the necessary settings.
  Note that Windows administration of PCs should be performed by a Windows administrator. You can find a detailed description of the PCS 7 installation and the required PCS 7-specific settings for PC stations in the manual Process Control System PCS 7; PC Configuration and Authorization.

Phase 5 / 5. ES: Download OS connection data and OS target system
- Open NetPro and download the connection data from the ES to Server_1.
- Right-click on the OS to be transferred in the open PCS 7 project below the WinCC application. Select the menu command PLC > Download in the shortcut menu. This starts the transfer from the ES to Server_1.

Phase 5 / 6. Server_1: Start WinCC
- Start WinCC on Server_1.

Phase 5 / 7. Server_1: Check and save the "Redundancy" dialog box
Phase 5 / 8. Server_1: Check and save the "Time Synchronization" dialog box

- Open the "Time Synchronization" editor and check the settings in the dialog box. Click "OK" to exit the dialog box even if you have made no changes.

Phase 5 / 9. Server_1: Activate WinCC Runtime

- Activate WinCC Runtime on Server_1.

Phase 5 / 10. Carry out Phase 5: Steps 1 to 9

If you are using more than one redundant OS server pair, repeat steps of Phase 5 / step 1 through 19 for each Server_1.

Phase 5 / 11. ES: Starting SIMATIC PDM

Start the SIMATIC PDM on the ES, if installed.

The system reacts as follows:

- Server_1 becomes standby server.

Result after Phase 5

- Updated Server_1 is standby server.
- Updated Server_2 is master server.
- Updated Client_1 is connected to its preferred server Server_1.
- Updated Client_2 is connected to its preferred server Server_2.

The updating of your redundant operator stations is complete.

Maintenance client accesses to intelligent field devices are possible when the PDM server has been started on the engineering station.
6.11 Guide to updating a redundant BATCH server in runtime

6.11.1 Software update (migration)

Information is available in the SIMATIC BATCH product documentation:

- Operating Manual SIMATIC Process Control System PCS 7; SIMATIC BATCH; section "Software update (Migration)."

6.12 Guide to updating a redundant Route Control server in runtime

6.12.1 Updating a redundant Route Control server in runtime

For servers and single-station systems which are used for OS and Route Control, please observe the following information.

**Requirement**

- The Route Control project on the engineering station has been updated.
- Note the phases in section "Guidelines for updating a redundant OS in runtime (Page 191)."

**NOTICE**

**Backing up the log files**

Back up the log files before replacing or reinstalling a computer, at the latest. You can find the configured storage path via the Route Control Engineering (list for route log in the path: Project Settings > Runtime Parameters > Routes Log > Values for Server and Standby).

**Procedure**

Execute the following steps on the servers, note the sequence and the states on each PC station.

<table>
<thead>
<tr>
<th>Default Master (1)</th>
<th>Default Standby (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. V7.x SPx (2) – Runtime</td>
<td>V7.x SPx (2) – Runtime</td>
</tr>
<tr>
<td>2. V7.x SPx (2) – Runtime</td>
<td>Exit Runtime</td>
</tr>
<tr>
<td>3. V7.x SPx (2) – Runtime</td>
<td>Update the database to the new version and download it (you may have to update and download the WinCC project)</td>
</tr>
</tbody>
</table>
### 6.12 Guide to updating a redundant Route Control server in runtime

<table>
<thead>
<tr>
<th>Default Master (1)</th>
<th>Default Standby (1)</th>
</tr>
</thead>
</table>
| 4. V7.x SPx (2) – Runtime  
Do not update the current server (default master)! | Start the RC server (and also WinCC Runtime, if needed)  
and perform the update (the default standby server must be selected on a client with a new version in the RC Center using the menu command Program > Server Selection) |
| 5. The default master continues to operate as standby server | Activate the default standby  
This RC server becomes the master (new version – Runtime)  
- RC clients with V7.x SPx (2) report errors because connection to an RC server of another version is not possible.  
- RC clients with the new version connect to the RC server  
- All running routes will be processed with the new RC server. |
| 7. Execute an update installation on the default master. | New version – Runtime |

**The next step involves changing the master role.**

| 8. Start RC server (or WinCC Runtime) – starts as standby (you may have to update the project) | New version – Runtime  
The database is read. |

(1) : Default master or standby refers to the current state of the server pair before the software update in runtime. Any redundancy switching is not necessary.

(2) : V7.x. SPx means Route Control V7.0 or V7.1, possibly with Service Pack.

### Additional information

- Programming and Operating Manual *SIMATIC Process Control System PCS 7; SIMATIC Route Control*, section "Software update."
**Diagnostics**

Information is available in the manual *Process Control System PCS 7; Service Support and Diagnostics*.

PCS 7 features advanced self-diagnostics for redundant software systems (servers). If this diagnostics routine detects an internal fault, and in the event that the redundant partner server is fully functioning, all communication connections on the server affected by the fault are disconnected (terminal and system bus).

The affected server is then restarted automatically.

**Requirements**

- Use of a PCS 7 OS (multi-station) redundant system, SIMATIC BATCH and SIMATIC Route Control.
- The following settings have been made on the server systems:
  - Automatic Windows logon (not relevant for servers in WinCC service mode)
  - Automatic start of the PCS 7 server applications

**Procedure**

1. Go to the Windows Start menu and open the "Run" dialog box.
2. Enter the following in the input field:
   
   gedit.msc
   
   The "Local Group Policy Editor" dialog window opens.
3. In the tree view, select the folder **Local Computer Policy > Computer Configuration > Administrative Templates > System**.
5. Select the "Deactivated" option button.
6. Click "OK".

---

**Note**

Before a PCS 7 server application is exited, an availability check is carried out on the relevant redundant partner server. If the partner server is not fully functional, the user is informed of this status and can proceed accordingly.

The availability check is only carried out in service mode if a user is logged on.
Additional information

You can find more information in the corresponding documentation and readme files on:

- PCS 7 OS
- SIMATIC BATCH
- SIMATIC Route Control
- SIMATIC NET
Index

Single-Channel Switched Distributed I/O, 30

A
Actuators, 34
Adding, 172
- Components of the distributed I/O, 172
- Modules in central and expansion racks, 172
Advantages of fault-tolerant components, 89
- Note, 89
- Requirements, 89
Area of validity, 7
Assigning, 142
- S7 program to OS, 142
Automation system, 35, 39
- Components, 36
- Hardware components, 36
- How the S7-400H Operates, 39
- Operating principle, 39
Availability, 23, 62, 64, 77
- Field bus, 62
- Fieldbus, 64
- OS server, 77

B
Basic knowledge, 7
- Required, 7
BATCH, 153
- Monitoring, 153
- Network adapter, 153
- Redundancy, 153
BATCH client, 190
- Failover characteristics, 190
Batch process, 82
Batch server, 186
- Response to failure, 186
BATCH server, 82
Bumpless continuation, 15
Bus coupler, 66, 72
- DP/PA Link, 66
- FF link, 72
Bus interface IM 153-2, 110
- Configuring, 110
- Requirement, 110

C
Central processing units, 36
Changes in the CPU, 172
Channel-based, 95
Client, 81, 144
- Configuring, 144
Communication connections, 96
- Configuring, 96
Communication lines, 39
Communication modules, 36
Communication solutions, 39, 47, 49, 59, 62, 64
- Fault-tolerant terminal bus, 47
- Redundant field bus, 62
- Redundant fieldbus, 64
- Redundant terminal bus, 49
- Redundant, fault-tolerant plant bus, 59
Compile/download program, 148
Components, 49, 59, 62, 64
- Fault-tolerant terminal bus, 47
- Fieldbus, 62, 64
- Redundant terminal bus, 49
- Redundant, fault-tolerant plant bus, 59
Components of S7-400H, 36
Configuration, 100, 127
- Batch client, 152
- Bus interface IM 153-2, 110
- Cross-project, 87
- Download to target system, 148
- DP/FF coupler, 124
- DP/PA Coupler, 122
- Engineering station, 87
- Fault-tolerant fieldbus, 105
- Interconnected signal, 34
- OS clients, 144
- OS clients for permanent operability, 145
- Plant bus, 100
- PROFINET, 106
- Redundant BATCH servers, 150
- Redundant fieldbus, 102
- Redundant OS servers, 127
- Redundantly acquired signal, 34
- Terminal bus, 97, 100
- Topology, 106
- WinCC Redundancy, 138
- Y Link, 119
Configuration notes, 89
Configuring redundant BATCH servers, 150
Fault-tolerant Process Control Systems (V8.0)
Function Manual, 03/2012, A5E02779471-02

Index

Configuring the Batch client, 152
Connecting
  Plant bus, 46
  Terminal bus, 46
Continuation, 15
  Bumpless, 15
CP 1613, 46
CP 1623, 46
CPU settings, 95
Creating, 127, 135
  OS, 127
  Redundant connection between AS and OS, 135

D
Deactivating, 181
  WinCC project, 181
Definition, 23
  Availability, 23
Definition of the standby modes, 23
Depassivation, 175
  Redundant I/O modules, 175
Discrepancy time, 175
Download target systems, 148
DP/PA Coupler, 122
DP/PA Link, 66, 122
  Configuring, 122

E
Electrical ring, 39
Engineering station, 87
  Configuring, 87
  Textual reference, 87
ES, 87
ESM, 39
ET 200M, 110
  Configuring bus interface, 110

F
Failover characteristics, 188, 190
  BATCH client, 190
  OS clients, 188
Failover criteria, 188
  OS client, 188
Failover reaction of Route Control clients, 190
Failure of redundant bus components, 180
Fault, 181
  Network connection from the OS client to the OS server, 181
  Network connection to the AS, 181
  Network connection to the OS partner server, 181
Fault tolerance with redundancy nodes, 16
  Display, 16
Fault-tolerant automation system, 35
Fault-tolerant process control systems, 13
Fault-tolerant terminal bus, 47
  Availability, 47
  Components, 47
  Setup, 47
FDC 157-0
  Couplers, 124
  Features for commissioning, 20
  Features for servicing, 22
  Features for system extension, 22
  Features for the configuration phase, 20
  Features for the operation phase, 20
FF link, 72, 124
  Configuring, 124
Fiber-optic cable, 36, 178
  Response to failure, 178
Fieldbus, 62, 64, 102, 105
  Availability, 62, 64
  Components, 62, 64
  Configuring, 102, 105
  Setup, 64
  Structure, 62
FOUNDATION Fieldbus, 74
  Redundant, 74

H
H station
  Requirement, 90
H station, 90
  Inserting, 90
Hardware components
  S7-400, 36
Hot restart, 175
  Redundant interfacing, 175
How to configure a PC station for a redundant Route Control server, 157
How to configure a PC station for a Route Control client, 160
How to configure a redundant connection between a Route Control server and AS, 162
How to configure an archive server and its redundant archive partner server, 130

212
How to configure the redundant PROFIBUS PA, 107
How to download a SIMATIC Batch project to the target systems, 156
How to set the redundancy of the BATCH servers, 154
How to set the redundancy of the Route Control servers, 166
HW Config, 117
    Starting, 117

I
I/O, 27, 28, 30, 34
    Central, 27
    Distributed, 27
    DP/PA Link, 66
    FF link, 72
    redundant, 28
    Redundant Actuators and Sensors, 34
    Redundant I/O modules, 33
    Redundant interfacing, 32
    Single-channel switched distributed I/O, 30
    Y Link, 65
IM 153-2, 110
Increasing availability, 35
    Automation system, 35
Input/output module, 112
    Configuring, 112
    Operating principle, 112
    Setup, 112
Inserting, 90
    H station, 90
Inserting a SIMATIC H station, 90
Inserting sync modules, 38
Interfacing, 32

M
Master CPU, 177
    Reintegration, 177
    Response to failure, 177
Module-based, 95
Modules, 172
    Adding, 172
    Removing, 172
Mounting racks
    S7-400H, 36
Multiproject engineering, 87

N
Network components, 41

O
Open, 117
    Existing STEP 7 project, 117
Operating principle, 39, 77, 81, 112
OS server, 77
    Permanent operability, 81
Redundant I/O modules, 112
    S7-400H, 39
Optical PROFIBUS, 62, 64
Optical ring, 39
Optical/electrical ring, 39
OS client, 81, 144
    Additional, 81
    Configuring, 144
    Permanent operability, 81
OS clients, 188
    Failover characteristics, 188
OS server, 127
    Availability, 77
    Configuring, 127
    Creating, 127
    Failure, failover and restart, 181
    Operating principle, 77
    Setup, 77
    Time synchronization, 88
OS terminal, 81
OSM, 39
Overview of configuration tasks, 109, 127, 149, 157
Overview of features, 19
    PCS 7, 19

P
Passivation reaction, 95
PC station, 87
PCS 7 overview of features, 19
    Features for commissioning, 20
    Features for servicing, 22
    Features for the configuration phase, 20
    Features for the operation phase, 20
Permanent operability, 81
    Operating principle, 81
Plant bus, 100
    Configuring, 100
    Connecting, 46
Index

Plant bus, redundant fault-tolerant, 59
Availability, 59
Components, 59
Setup, 59
Plant changes in runtime, 172
Power supply
S7-400H, 36
Preface, 7
Preferred server, 81
Process control system PCS 7, 13
PROFIBUS PA, 68
Redundant, 68
PROFINET
Topology, 106
Topology Editor, 106
Project path, 134
Setting, 134

Q
Quick guide, 193, 196, 201, 204
- Updating redundant systems, 193, 196, 201, 204

R
Reaction of Route Control servers to failure, 187
Redundancy, 39
- With electrical ring, 39
- With optical ring, 39
Redundancy Concept, 16
Redundancy monitoring, 153
- BATCH, 153
- Network adapter, 153
Redundancy nodes, 24
- Availability without fault, 24
- Total failure, 24
- without fault, 24
Redundant BATCH servers, 82
Redundant communication connections, 96, 97, 100, 102, 105
- Configuring the fieldbus, 102, 105
- Configuring the plant bus, 100
- Configuring the terminal bus, 97, 100
Redundant connection between OS and AS, 135
- Creating, 135
Redundant double ring, 59
Redundant I/O, 28
Redundant interfacing, 175
- Hot restart, 175
- Response to failure, 175
Redundant OS servers, 77, 127
- Configuring, 127
- Creating, 127
Redundant Route Control servers, 85
Redundant systems, 191
- Updating, 191
Redundant, fault-tolerant terminal bus, 49
Reintegration, 177
- Master CPU, 177
Removing, 172
- Components of the distributed I/O, 172
- Modules in central and expansion racks, 172
Repair time, 15
Replacement of BATCH stations in runtime, 170
Replacement of bus components in runtime, 168
Replacement of operator stations in runtime, 169
Replacement of Route Control stations in runtime, 171
Replacement of SIMATIC components, 167
Replication, 82
Requirement, 102, 105, 112, 122, 124
- Configure the fault-tolerant fieldbus, 105
- Configuring FDC 157-0, 124
- Configuring redundant I/O modules, 112
- Configuring the DP/PA coupler, 122
- Configuring the the redundant fieldbus, 102
Requirements, 100, 127, 172
Advantages of fault-tolerant components, 89
- Configuring OS clients for permanent operability, 145
- Configuring redundant BATCH servers, 150
- Configuring the Batch client, 152
- Configuring the OS client, 144
- Configuring the redundant plant bus, 100
- Configuring the Y Link, 119
- Configuring WinCC redundancy, 138
- Creating OS servers, 127
- Inserting synchronization modules, 38
- Plant changes in runtime, 172
- Redundant connection between AS and OS, 135
- Setting the project path for OS servers, 134
Response to failure, 175, 177, 178, 181, 186
- Batch server, 186
- Fiber-optic cable, 178
- Master CPU, 177
- Redundant I/O modules, 175
- Redundant interfacing, 175
- Redundant OS server, 181
Ring, 41
- Ring structure, 41
Route Control, 166
- Target systems, 166

Fault-tolerant Process Control Systems (V8.0)
Function Manual, 03/2012, A5E02779471-02
S

S7 programs, 142
Assigning, 142
S7 network components, 39
For redundant ring structure, 39
S7-400H, 39
Hardware components, 36
Mounting racks, 36
Operating principle, 39
Power supply, 36
Synchronization module, 36
Sensors, 34
Server, 77
Setting, 134
Project path, 134
Setup, 59, 64, 77, 112, 119, 122, 124
FDC 157-0 coupler, 124
Fieldbus, 64
OS server, 77
Redundant I/O modules, 112
Redundant plant bus, 59
With DP/PA coupler, 122
With Y Link, 119
Short designations of components, 13
Signal
Interconnected redundant, 34
Signal module, 112
SIMATIC PC station, 127, 134, 135, 138, 142, 144, 145, 148, 150, 152
Configuring OS clients for permanent operability, 145
Configuring redundant BATCH servers, 150
Configuring the Batch client, 152
Configuring WinCC redundancy, 138
Creating redundant OS servers, 127
OS compilation, 142
Redundant connection between AS and OS, 135
Setting the project path, 134
SIMATIC PCS 7 overview of features, 19
For commissioning, 20
For servicing and system expansion, 22
For the configuration phase, 20
For the operation phase, 20
SIMATIC PCS 7 redundancy concept, 16
Solutions for the I/O, 27
Starting HW Config, 117
STEP 7 project, 117
Opening, 117
Structure, 62
Fieldbus, 62

Synchronization module, 36, 38
Inserting, 38
Requirements, 38
S7-400H, 36

T
Target system, 148
Target systems, 166
Downloading Route Control, 166
Terminal bus, 47, 49
Configuring, 97, 100
Connecting, 46
Fault-tolerant, 47
Redundant, fault-tolerant, 49
Textual reference, 87
Time synchronization, 88
3rd party, 88
Use cases, 88
Via external receiver, 88
Via LAN with connected WinCC server, 88
Via LAN with specified computer, 88
Via plant bus, 88
Topology Editor, 106
Total failure, 24
Redundancy nodes, 24

U
Updating, 191
Redundant system, 191
Updating a redundant system in runtime, 191
Updating redundant systems, 193, 196, 201, 204
Phase 2, 199
Phase 4, 202
Quick guide, 193, 196, 201, 204

W
WinCC client, 81
WinCC project, 181
Deactivating, 181
WinCC Redundancy, 138
Configuring, 138
WinCC Server, 77
Windows domain synchronization, 88
Index

Y

Y Link, 65, 119
  Configuring, 119
  Requirements, 119
  Setup, 119